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• Welcome •
Welcome to Sage DacEasy Order Entry. Sage DacEasy Order Entry helps you 
track a customer’s order from entry to shipment. The program is very easy to 
use. As a matter of fact, you can accomplish almost every daily order entry task 
from just one screen, the Order Entry dialog box.

This User’s Guide assists you with setting up your company and details basic 
order entry processes. You are directed to the Sage DacEasy Order Entry Help 
system for more detailed instruction. In addition, “Related Help Topics” 
sections throughout this User’s Guide list Help topics on related subjects. Use 
the Contents tab or the Index tab in the Help to locate the topic.

Refer to the Getting Started Guide for assistance with using Help, 
documentation conventions and other methods of obtaining assistance with 
your software. The Getting Started Guide includes information on installing 
Sage DacEasy and adding or converting company files with the Sage DacEasy 
Business Center. In addition, global Sage DacEasy features such as printing and 
using the LookUp are explained. The Getting Started Guide also covers new 
features added to Sage Sage DacEasy Version 16 or any changes to existing 
features.

Note: If you choose to use the Sage DacEasy Business Center, and select a 
scheme with multiple Sage DacEasy programs, please note the following change 
regarding menu selections. When this User’s Guide instructs you to select a 
command from a menu in Sage DacEasy Order Entry, select the Order Entry 
menu from the menu bar in the Sage DacEasy Business Center, and then 
proceed with the steps. For example, if the User’s Guide instructs you to select 
Copy from the File menu, you have to select File from the Order Entry menu in 
the Sage DacEasy Business Center, and then select Copy. 

Key Features
This section highlights some of the many powerful features in Sage DacEasy 
Order Entry. 

Tip: Use the New Features Tour included in the Sage DacEasy Business Center 
to familiarize yourself with the features new to this version.

Note: For a list of key features specific to the Sage DacEasy Business Center or 
common to all Sage DacEasy programs, refer to Chapter 1, “Welcome” in the 
Getting Started Guide.
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Stand Alone Module or Interfaced With Sage DacEasy Accounting

Sage DacEasy Order Entry can be run as a stand alone program or as an add-on 
module to Sage DacEasy Accounting. If you currently use Sage DacEasy 
Accounting, you can set up a direct interface to the Sage DacEasy Accounting 
General Ledger module. When you ship an order in Sage DacEasy Order Entry, 
an invoice for the order is automatically created for you in Sage DacEasy 
Accounting. Then, when you post an Sage DacEasy Order Entry shipment, the 
invoices in Sage DacEasy Accounting are posted and the appropriate accounts 
are updated in the Sage DacEasy Accounting General Ledger. 

Intuitive Entry

One screen accommodates all sales order transactions: the Order Entry dialog 
box. You can use this dialog box to enter quotes, orders, blanket orders as well 
as returns (RMAs, Returned Merchandise Authorizations). 

The Order Entry dialog box consists of three tabs, the Customer, General and 
Detail tabs. The Customer tab includes the customer’s name, billing and 
shipping address and special shipping instructions. The General tab includes 
payment terms for the order. The Detail tab includes the products and services 
ordered by the customer.

Update the General Ledger Online

If you are interfacing Sage DacEasy Order Entry with Sage DacEasy Accounting, 
you can get accurate, up-to-the-minute view of your books at any time, 
including activity from Sage DacEasy Order Entry. Sage DacEasy Accounting 
now creates and maintains associated unposted General Ledger transactions 
online when you enter transactions in the Receivables Ledger, Payables Ledger, 
Cash, Purchasing, Billing, Sage DacEasy Order Entry and Sage DacEasy Point of 
Sale modules. 

This provides immediate access to unposted activity using DacAccess and 
Crystal Reports. And, Sage DacEasy Order Entry updates the General Ledger in 
detail when using this feature. For information on setting up the Online General 
Ledger feature, refer to the Help topic titled “Setting System Preferences”  in the 
Sage DacEasy Accounting Help.

Update the Check Register Online

If you are interfacing Sage DacEasy Order Entry with Sage DacEasy Accounting, 
the new Update Check Register Online feature allows you to create and 
maintain associated unposted Check Register transactions at the time of entry 
from the source module, including Sage DacEasy Order Entry and Sage DacEasy 
Point of Sale. This feature provides you with a real-time snapshot of all bank 
activity, including an accurate online balance. You can reconcile your bank 
accounts at any time so you no longer need to wait until the next posting cycle. 
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When using this feature, the method of payment details from Sage DacEasy 
Order Entry are recorded in detail in the Sage DacEasy Accounting Check 
Register to make it even easier to reconcile your bank account. You also now 
have access to unposted bank activity in DacAccess and Crystal Reports. For 
information on setting up the Update Check Register Online feature, refer to the 
Help topic titled “Setting System Preferences” in the Sage DacEasy Accounting 
Help.

Easily Locate Cursor in Grids 

A border now appears around the field when entering information. This allows 
you to easily locate your cursor and identify where fields are located.

Credit Check

Avoid entering orders for customers that have reached their credit limit or have 
a past due balance. You can choose to display a warning or prevent the invoice 
from being created when the credit check criteria is met by selecting the 
appropriate options when setting your system preferences. For information on 
setting system preferences, refer to Chapter 4, “Setting Up."

Track Product Weights

This feature allows you to define your own units of measurement, assign weights 
to products on the Sales tab of the product record, and then view the total 
weight of an order, quote or blanket order from the footer (via the Options 
menu) during entry. For information on setting up weight units and editing 
products, refer to Chapter 4, “Setting Up."

AutoReorder and AutoReturn

Save time when entering orders and RMAs by generating these transactions off 
of existing invoices. To use AutoReorder, click Options from the Detail tab of 
the order or blanket order, and then select AutoReorder. To use AutoReturn, 
click Options from the Detail tab of the RMA, and then select AutoReturn. 
Refer to the Help for more information.

Print the Customer Transaction History LookUp

You can print the Customer Transaction History LookUp. This LookUp 
contains invaluable information that helps you monitor your customer activity. 
For more information, refer to the Help topic titled “Viewing Customer 
Transaction History.”
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Adjust Inventory Values and Quantities

You can adjust the quantity and value of your inventory with the Inventory 
Adjustments feature. All you have to do is enter the amount by which the value 
or quantity needs to be adjusted and select the account to offset. For 
information on recording inventory adjustments, refer to Chapter 5, 
“Processing Orders."

Protect Customer Credit Card Numbers

Your customers will be grateful that you take steps to protect their credit card 
numbers from getting into the wrong hands. You can add special credit card 
variables to the form template header or footer that prevent the entire number 
from printing on the order. For more information on adding these variables to 
your form template, refer to the Help topic titled “Editing Templates.”

Advanced Security

Sage DacEasy’s Security feature brings you peace of mind. You can create an 
unlimited number of user profiles that indicate the areas of the program the user 
can access. You can also limit the warehouses into which users can purchase, or 
from which users can sell. For more information, refer to Chapter 4, “Setting 
Up."

Print Bar Codes

You can print bar codes for your products and services. A number of bar code formats are 
supported and you can define the layout to print to practically any label, including multi-column 
labels. In addition, you can generate bar codes using your vendor’s part number. This is extremely 
helpful if you use your vendor’s part number when scanning bar codes. For more 
information on bar code printing, refer to Chapter 7, “Management Reporting."

Fill Backorders Quickly

The Fill Backorder feature allows you to quickly tag all orders you want 
completed, and fill all the backorders in the entire batch at one time. The orders 
are then ready to be shipped using the Ship Orders routine. This process saves 
you hours of data entry time. You do not need to pull up each order one by one 
and move items from the Backorder field to the This Shipment field; the Fill 
Backorder routine does this for you. For more information, refer to Chapter 5, 
“Processing Orders." 
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Multiple Warehouse Tracking

You can easily track inventory costs and units at multiple warehouses. All you 
have to do is set up each warehouse, a master item record for each item stored 
at multiple locations, and assign each inventory item to a warehouse and master 
item. You can print reports that include the master items’ quantities and costs, 
and view breakdowns per location. In addition, items can be transferred 
between warehouse locations. For information on setting up this feature, refer 
to Chapter 4, “Setting Up."

Spot Customers’ Buying Trends

When it comes to keeping on top of your customers’ buying trends, intuition is 
great but facts are even better. If you sell products, you can choose to keep a 
detailed history of all product movements by selecting the Track Product 
Transaction History option on the System Preferences dialog box. This feature 
allows you to determine how well your products are selling and what products 
your customers are buying. With this type of information in one central 
location, the trend is easy to see. To view this information for a single product, 
view the product on the Edit Product dialog box, click Options from the 
Description field, and then select Detail History. To view this information for a 
range of products, print the Product Activity Detail Report. For more 
information on this report, refer to Chapter 7, “Management Reporting."

Record Detail Customer History

Sage DacEasy Order Entry builds a file containing specific information about 
your customer such as their address, current balance and yearly historical 
balances. Every time you ship an order, the sales history is updated. At any time 
you can view this information by accessing the Customer Inquiry feature. To do 
this from the Order Entry dialog box, click Options, and then choose Customer 
Inquiry. You can also choose Customer Inquiry from the Customer Service 
menu to view the same information. Click Purchase History from the Customer 
Inquiry dialog box to print the customer’s purchase history.

Forms Available From Sage DacEasy

When you print orders, invoices or any other form in Sage DacEasy Order 
Entry, you can print on preprinted forms supplied by Sage DacEasy. You can use 
preprinted forms right out of the box or have custom forms made with your 
company name, address and logo. Call our Sage DacEasy Forms division at 
(800) 222-0505 for more information on the wide range of forms available.
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Incorporate bitmaps to Reports and Forms

Strengthen your company’s image and branding with more professional looking 
forms and reports. Now you may include your company logo on reports and 
forms. In addition, this feature may reduce your company’s expense of 
purchasing forms with your company logo pre-preinted. Simply setup a bitmap 
image of your company Logo on the Company Information Dialog of each Sage 
DacEasy Module and indicate that you want this image to be printed in the 
header of all reports. You can also print the logo in your forms by adding the 
variable {LOGO} to your form templates. Sage DacEasy supports .bmp, .jpg, and 
.gif bitmap extensions

Product Illustration

This feature allows you to incorporate illustrations of products in the Products 
Maintenance dialog in order to easily identify items when needed. Now you can 
view an image of each product which can reduce mistakes when ordering or 
selling products that have similar descriptions and price. With this powerful 
improvement your employees can visually identify a product when they are 
making changes to that product’s attributes

Change Tax Rate on Order Detail Lines 

This feature allows you to modify the tax rate for each detail line on an Order. 
This is useful selling items that are subject to special surtax rates or for states that 
are implementing different tax rates for different goods or services. 

Increased Item Code Size 

The Item code for products and services was increased from 14 characters to a 
20 characters maximum. This feature not only allows users to accomodate 
Inventory coding schemes for specific industries, but it also increases flexiblility 
when using the Multiple Warehouse Tracking

Save Quotes History

Gain greater control and better manage opportunities during the sales process 
using Quote History and Opportunity Management.  Quote History allows you 
to easily generate quotes based on a previous quote and to retain each version of 
the quote you supply to your customers. Using Quote History, you can quickly 
recall information previously conveyed to customers and to gain better insight 
into your sales opportunities.

Customer Purchase Lookup

Simplify the product reorder process and make servicing your customers even 
easier with the new Customer Purchase Lookup feature. This feature allows you 
to quickly view your customers past purchases so that you can service them 
intelligently and easily reorder products from the Edit Customer screen.
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Credit Card Processing

Using Sage DacEasy Order Entry, you can make the order process even more 
convenient for your customers with credit card and debit card processing. Sage 
DacEasy integrates with Sage Payment Solutions (SPS) , allowing you to easily 
process credit card and debit card payments from your customers.

Global Changes

Sage has added Services as a selection in the File field on the Global Changes 
dialog box (Periodic > Global Changes) and provides several selections in the 
Change field for this area; Commissionable, Taxable, Serial Numbers, Measure, 
Price, Custom Text Label 1-6, Custom Amount Label 1-4, and Customer Date 
Label 1-2. Additionally, Sage has added several new selections in the following 
areas:

• Customer - Price Group, Billing Group, Zone Code, Ship Via, Custom 
Text Label 1-6, Custom Amount Label 1-4, and Customer Date Label 
1-2.

• Vendor - Tax Table, Terms Table, Memo, Territory, Ship Via, Type, 
Credit Limit, Custom Text Label 1-6, Custom Amount Label 1-4, and 
Customer Date Label 1-2.

• Product - BIN, Minimum, Lead Time, Reorder, Purchase Measure, 
Purchase Vendor, Purchase Number, Purchase Alternative Vendor 1-2, 
Sales Measure, Sales Price, Sales Quantity Price Break A-F, Sales 
Alternative Product 1-2, Taxable, Custom Text Label 1-6, Custom 
Amount Label 1-4, and Customer Date Label 1-2.

• Salesperson - Territory.

BIN Variable

Sage DacEasy Order Entry allows you to add BIN numbers in the Detail section 
of invoices and merchandise received forms, which makes it easier to track your 
products. Select the BIN variable on the Invoice Detail Variable dialog box to 
add the field to the selected form.

Note To ensure accurate printing, add the BIN variable only to the Detail 
section of forms.
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Additional Features

• Attach messages to products and services with the Sales Assistant.

• Print labels for orders before shipping them.

• Adjust inventory quantities or values and transfer items between 
warehouses.

• Select multiple sort and rank options when printing invoices.

• Exclude non-inventory items when printing the Product Activity and 
Product Activity Detail reports.

• Include the customer fax number on forms such as orders or invoices. 

• Track up to six additional text fields, four amount fields and two date 
fields for your customer, product and service records.

• Track shipping methods to quickly update orders.

• Make global changes to customers, products and salespeople. 

• Quickly view a product’s sales price before adding it to an order.

• Create multiple price breaks for products based on the quantity 
purchased or a flat percentage or adjusted price.

• Create custom reports with DacAccess.

• Track date, time, order entry person, as well as ship date.

• Print transaction listing reports for specific ranges and sorts.

• Assemble items on-the-fly.

• Record line item or total order price discounts.

• Set up promotional pricing.

• Verify payments online.

• Assign your own order number and invoice number or let the system 
assign the number.

• Customize invoices, orders, quotes, sales returns, RMAs (Returned 
Merchandise Authorization), packing lists and picking tickets.

• Export orders from remote locations and import them into the 
headquarter location.

• List components of finished goods on orders.

• Retrieve and edit quotes to submit to customers.

• Change an existing customer, product or service code and the system 
replaces the new code in all transactions and files.
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• Generate daily production schedule by line item for each sale.

• Maintain serial numbers on inventory items.

• Track commission and quota by salesperson and order entry person.
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• Getting Started •
This chapter gets you started using the program if you choose to run Sage 
DacEasy Order Entry independent of the Sage DacEasy Business Center. It 
includes information on starting and exiting Sage DacEasy Order Entry, adding 
and opening companies, backing up and restoring your data and other 
commands found on the File menu.

Starting Sage DacEasy Order Entry
If you are using the Sage DacEasy Business Center, you do not have to start Sage 
DacEasy Order Entry separately. When you are using a scheme with multiple 
Sage DacEasy programs, access the Order Entry menu located on the menu bar, 
the same menus and commands that appear in Sage DacEasy Order Entry are 
available. When you select a command from the Order Entry menu in the Sage 
DacEasy Business Center, the appropriate dialog box appears. Refer to Chapter 
1, “Installing Sage DacEasy” in the Getting Started Guide for information on 
starting the Sage DacEasy Business Center.

To start Sage DacEasy Order Entry independent of the Sage DacEasy Business 
Center, complete the following steps.

Note: If you are upgrading your data from a previous version, refer to Chapter 
1, “Installing Sage DacEasy” in the Getting Started Guide before completing the 
following steps. 

To Start Sage DacEasy Order Entry

1 Click the Start button, point to Programs, then to Sage DacEasy, then to 
Modules, and then click Order Entry. 

If you have not registered the program, you are asked to register. If you want 
to register at a later time, choose No. To register the program, choose Yes. 
The Serial Number dialog box appears. Type your serial number and 
activation key using all capital letters, and then click OK. 

If you have already set up a company, the default company opens and you 
can disregard the following steps.

If you are a new user, the Welcome to Sage DacEasy dialog box appears. 
You can add the sample company or add your company. Select the Open the 
Sample Company Data option to add the sample company or continue with 
the following steps to add your company.
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2 Select the Add New Company Data option. The Add Company dialog box 
appears. Use this dialog box to create a new company.

3 Complete each field on the Add Company dialog box. Click Help for more 
information about each option on the dialog box.

4 Click OK to create the new company data files. The Open Company dialog 
box appears.

5 Double-click the company you want.

To Start Sage DacEasy Order Entry From Sage DacEasy Accounting

If you are not using the Sage DacEasy Business Center, there are two ways to 
start Sage DacEasy Order Entry while in the Sage DacEasy Accounting program; 
you can use the Modules menu found on the menu bar or you can customize 
the Sage DacEasy Accounting system toolbar to include an Order Entry button. 

To use the Modules menu, you need to make sure the external modules path is 
set up properly in Sage DacEasy Accounting. To set up the external path, start 
the Sage DacEasy Accounting program. Point to Defaults on the Edit menu, and 
then select System Preferences. The System Preferences dialog box appears. 
Click the Paths tab and type the path to the Sage DacEasy Order Entry program 
files in the Order Entry field. Click OK to save the change. Then, to start Sage 
DacEasy Order Entry from Sage DacEasy Accounting, choose Order Entry on 
the Modules menu. The Sage DacEasy Order Entry program appears with the 
Sage DacEasy Accounting program still open. 

To customize the Sage DacEasy Accounting system toolbar to include an Order 
Entry button, refer to the Sage DacEasy Accounting Help topic titled 
“Customizing the toolbar” for more information. 

The Welcome to Sage
DacEasy dialog box appears

when you launch Sage
DacEasy for the first time.
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Exiting Sage DacEasy Order Entry

If you are not using the Sage DacEasy Business Center, choose Exit from the File 
menu to exit Sage DacEasy Order Entry. You can also exit Sage DacEasy Order 
Entry by clicking the Close button located on the Order Entry title bar. A 
message appears confirming you want to exit the program. Choose Yes to 
continue.

Note: A tip may appear recommending that you back up your data. Click Cancel 
to return to the program and make a backup or click Exit to close the program.

Working With Sage DacEasy Order Entry
This section outlines the various company routines available to you on the File 
menu. These commands allow you to open and copy companies, create and 
restore a backup, perform utilities on company data files without exiting the 
program and export and import order entry information.

Tip: Refer to the Getting Started Guide for additional information on working 
with Sage DacEasy. This includes working with the Sage DacEasy Business 
Center, changing report layouts, using AutoComplete, sending e-mails, using 
the calculator, using the LookUp, using the Date Selection button, working with 
Sage DacEasy toolbars and more. 

Opening and Adding Companies

If you are not using the Sage DacEasy Business Center to access Sage DacEasy 
Order Entry, you are prompted for information about your company when you 
start the program the first time. Sage DacEasy uses this information to create 
your company’s data files. This company becomes the default company and is 
opened automatically when you start the program. 

The Open command on the File menu displays the Open Company dialog box. 
From the Open Company dialog box you can open a company, delete the path 
to a company, add a company and set a default company. The following steps 
explain how to add new companies and open existing companies directly in Sage 
DacEasy Order Entry. 

To Open a Company

You can add an unlimited number of companies; however, you can only open 
one company at a time if you choose not to use the Sage DacEasy Business 
Center. The following steps explain how to open a different company if you 
choose not to use the Sage DacEasy Business Center. When you select a different 
set of data files, Sage DacEasy closes the current company data files before 
opening the next company.
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Tip: You can include your Sage DacEasy Order Entry data files in a company 
profile in the Sage DacEasy Business Center, and then open the company from 
the Sage DacEasy Business Center. This gives you all the advantages of the Sage 
DacEasy Business Center, including the ability to have multiple windows open 
at once. In addition, you don’t have to close one company before opening a 
different company. Refer to “Installing Sage DacEasy” in Chapter 1 of the 
Getting Started Guide for more information.

1 Choose Open on the File menu. The Open Company dialog box appears.

Tip: You can sort on any column to help you quickly locate a company. Refer 
to the “Using the LookUp” section in Chapter 4, “Working With Sage 
DacEasy” in the Getting Started Guide for more information.

2 Double-click a company from the list. Sage DacEasy Order Entry opens the 
company. 

Note: The company name appears in the title bar and the period dates 
appear in the status bar at the bottom of the application window. 

To Add a Company

Use the Add button to create a new set of company data files in Sage DacEasy 
Order Entry or to reestablish a path between Sage DacEasy Order Entry and an 
existing set of company data files. 

1 Choose Open on the File menu. The Open Company dialog box appears.

2 Click Add. The Add Company dialog box appears.

3 Type a short description of the company in the Identification Name field. 

Tip  Click Help for a detailed description of each field on the Add Company 
dialog box.

4 Type the path for the new data files in the Path field if creating a new 
company. Type the path to an existing set of data files if reestablishing the 
path between the data files and Sage DacEasy Order Entry.

Use the Open Company
dialog box to select the

company you want to view.
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5 Select whether or not this company will interface with Sage DacEasy 

Accounting.

6 Type the path to your Sage DacEasy Accounting data files if you selected the 
Interface to Sage DacEasy Accounting check box.

7 Click OK. 

If you are creating a new company, the new company data files are created. 
After creating the data files, the Open Company dialog box appears and you 
can select the company you want to open.

If you are reestablishing a path between Sage DacEasy Order Entry and an 
existing set of company data files, a message appears stating files exist in the 
path specified. Choose Yes to continue to reestablish the path. The Open 
Company dialog box appears and you can select the company you want to 
open.

Related Help Topic

• Deleting companies

Setting the Default Company

If you have set up only one company, it is the default company. If you have 
multiple companies, select one company as the default company. Sage DacEasy 
opens the default company automatically each time you access the program. 
Sage DacEasy designates the first company you create as the default company. 
You can change the default to any one of the companies on the Open Company 
dialog box. Notice that a Y appears in the Default column for one of the 
companies listed on the Open Company dialog box. This designates the 
company as the default company. This company is opened automatically each 
time you access the program.

To Set the Default Company

1 Choose Open from the File menu. The Open Company dialog box appears.

2 Select the company you want to set as the default from the list.

3 Click Default. A Y appears in the Default column next to the company. The 
next time you access the program, the new default company data files 
automatically open.
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Copying Companies

Sage DacEasy Order Entry has a Copy routine that makes a copy of an existing 
set of files in a different folder. The copied files are treated as a new company 
and appear on the Open Company dialog box. This is useful when establishing 
multiple companies that share similar file structures. 

To Copy a Company’s Data Files

1 Choose Copy from the File menu. The File Copy dialog box appears.

2 Double-click the company you want to copy from the list. The Copy 
Company dialog box appears.

3 Type a short description of the company in the Identification Name field. 

4 Type the path for the new data files in the Path field. 

5 Select the Zero Balances in Files check box to create a copy of the company 
with zero balances and no transactions or clear this check box to make an 
exact copy of the company.

6 Click OK. A message appears confirming you have enough hard disk space to 
copy the company. Click Continue to copy the company. A message appears 
when the Copy routine is successfully complete. 

7 Click Continue to exit the dialog box.

Creating and Restoring a Backup

With the Backup routine you can back up your data to a disk, to your hard drive 
or to a network drive. We recommend you keep a backup copy of your data files 
on disk so you do not lose your data in the event of a hard disk drive failure.

It is recommended that you make frequent backups of your data. It is especially 
important to make a backup before performing certain irreversible functions 
such as posting or purging. You can make a backup at any time by selecting 
Backup/Restore from the File menu. In addition, you can make backups 
directly from certain irreversible functions such as the Posting routine. 

Tip: You can back up or restore all data files in a company profile at one time 
using the Sage DacEasy Business Center. Refer to Chapter 5, “Working With the 
Sage DacEasy Business Center” in the Sage DacEasy Business Center Guide for 
more information.
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To Create a Backup of Your Data Files

1 Choose Backup/Restore from the File menu. The File Backup/Restore 
dialog box appears.

2 Select Backup in the Operation field.

3 Select Order Entry to back up only order entry data files. Select Accounting 
to back up only accounting data files. 

4 Type the path to the data files you want to back up in the Source field. Sage 
DacEasy displays the path to the files currently open, but you can change the 
path if you want to back up files located elsewhere on your hard disk.

5 Type the path to where you want to store the backup files in the Target field.

6 Click OK. A message appears confirming you want to make a backup. Click 
Yes to continue. During the routine, Sage DacEasy prompts you to insert disks 
in the appropriate drive if necessary.

Note: If you are interfaced with Sage DacEasy Accounting, a message 
appears requesting you to make a backup of your accounting data files also. It 
is essential you make backups of your accounting and order entry data at the 
same time to keep the data on the backups synchronized.

Related Help Topics

• Creating a backup from the Post Order Entry dialog box

• Resetting file attributes

• Setting up backup and restore defaults

Use the File Backup/Restore
dialog box to make a

backup of your data files.
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To Restore a Backup of Your Data Files

1 Choose Backup/Restore from the File menu. The File Backup/Restore 
dialog box appears.

2 Select Restore in the Operation field.

3 Select Order Entry to restore only order entry data files. Select Accounting 
to restore only accounting data files. 

4 Type the path to the backup you want to restore in the Source field.

5 Type the path to the company receiving the backup in the Target field.

6 Click OK. A message appears confirming you want to restore data. Click Yes 
to continue. During the routine, Sage DacEasy prompts you to insert disks in 
the appropriate drive if necessary.

Note: If you are interfaced with Sage DacEasy Accounting, a message 
appears requesting you to restore a backup of your accounting data files also. 
It is essential you restore backups of your accounting and order entry data at 
the same time to keep the data synchronized.

Related Help Topic

• Setting up backup and restore defaults

Using the Utilities Feature

The File Utilities feature lets you periodically check the integrity of your data 
files, and if necessary, repair any damaged files. There are four routines available 
from within the Utilities command, Drop Indexes, Recover, Verify and 
Transaction Viewing. You can perform these routines at any time. You should 
run recover on all your data files at least once a month. Make a backup of your 
data files before running any of the Utility routines.

Important: You can click the Close button on the Operation Status dialog box 
to interrupt the Drop Indexes, Recover and Verify routines. If you interrupt a 
routine, a confirmation screen appears. Choose Yes to stop the utility routine. 
Sage DacEasy completes the utility on the current file and displays a cancellation 
message. It is very important you return later and run the utility routine again.
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To Run the Utility Routines

1 Choose Utilities from the File menu. The File Utilities dialog box appears. 
Click Help for a detailed description of each field on the File Utilities dialog 
box.

2 Type the number of the file you want to run utilities on in the File Selection 
field. If you are not sure of the file number, click LookUp to select a file from 
a list. 

Note: If you select A-All Data Files when you run the Verify routine, Sage 
DacEasy runs the utility on the appropriate Header files.

3 Select the routine you want to run in the File Operation field. 

4 Click OK. Sage DacEasy displays a message when the operation is complete. 
Click Continue to return to the File Utilities dialog box.

5 Click Close to exit the dialog box.

Related Help Topic

• Order entry file utility numbers

Using the Order Link Feature

Sage DacEasy Order Entry includes a unique feature that allows you to import 
orders entered into another copy of Sage DacEasy Order Entry from a remote 
location. This process is called Order Linking. Order Linking is especially 
helpful if your sales staff enters orders on laptop computers at their customers’ 
office. The salesperson can enter and print an order using the remote computer, 
and then import the data into your company’s data files at the home office.

Note: You must have multiple copies of Sage DacEasy Order Entry to use the 
Order Link feature. For example, one copy of Sage DacEasy Order Entry is 
installed on the laptop computer (remote computer) the sales staff uses and one 
copy of Sage DacEasy Order Entry is installed on the computer at the home 
office (main computer).

Use the File Utilities dialog
box to select the routine

and file.
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The link between the two sets of data is accomplished using a special order link 
file created by the program. The Order Link dialog box in Sage DacEasy Order 
Entry serves two functions: (1) creating the link file containing the orders to 
import to the main computer; and (2) importing the order link file into the 
main computer.

To Create an Order Link File

1 Enter orders into Sage DacEasy Order Entry on a remote computer.

2 Choose Order Link on the File menu. The Order Link dialog box appears.

3 Select the Create Transfer File option. The Create Order Link dialog box 
appears.

4 Type the path and file name for the order link file. For example, to create a file 
called ORDERS.TXT on a disk in drive A, type A:\ORDERS.TXT.

5 Select Encrypted to create a file that cannot be viewed or printed or select 
ASCII to create a file that can be viewed using a text editor. 

Tip: If you want to import the order data into another program, select ASCII.

6 Type the range of order numbers you want included in the order link file in 
the From Order Number and To Order Number fields.

7 Insert a disk in the appropriate drive and click OK. A message appears when 
the order link file is successfully created. Click Continue to complete the 
routine and exit the dialog box.

To Import an Order Link File

1 Choose Order Link on the File menu. The Order Link dialog box appears.

2 Select the Import Transactions option. The Import Orders dialog box 
appears.

Use the Create Order Link
dialog box to type a path,

file name and range of
orders for the order link file.
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3 Type the path and file name to the order link file or click the Browse button 
to locate the file.

4 Select the Delete Link File check box if you want to delete the order link file 
after it is imported.

5 Insert the disk with the order link file into the drive and click OK. An Import 
Orders-Audit Report appears on the screen. The Audit report lists the orders 
imported from the remote system and the new order number assigned to the 
order in the main system. Press the Esc key to exit the report.

How Sage DacEasy Order Entry Imports Orders When Using the 
Order Link Feature

Sage DacEasy Order Entry generates order numbers using a sequential counter; 
however, since your sales staff is operating separate copies of the program, 
duplicate order numbers can exist when importing. To prevent importing 
orders with duplicate numbers, Sage DacEasy Order Entry places the original 
order number from the remote location in the Customer Reference field on the 
order and assigns the order a new number. This eliminates the possibility of 
duplicate order numbers. 

Since Sage DacEasy Order Entry uses the Customer Reference field during the 
Import Orders routine, your salespeople should not use this field when entering 
orders that will be imported. Once the orders are imported in to the main 
location, you can reference the order either by the new order number or the 
order number the customer received at the remote location.

For example, say one of your salespeople enters order number 0000000321 on a 
laptop and provides the customer a printed copy of the order. When you import 
the order into your main computer at the home office, Sage DacEasy Order 
Entry assigns the order the next available number and inserts 0000000321 in the 
Customer Reference field. Now, you can reference the order either by the new 
order number or by the order number provided to the customer.

Note: During the Import Orders routine, Sage DacEasy Order Entry 
automatically adds any new customers on the orders you are importing, but 
Sage DacEasy Order Entry does not add any new products. If an error occurs 
while importing orders, the entire process is terminated and no orders are 
imported.

Use the Import Orders
dialog box to type a path

and file name to the order
link file.
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Audit Report

After the Import Orders routine is complete an Audit report appears. The Audit 
report for a successful import shows you the total number of orders imported, 
the remote order number and the new order number on the main computer. If 
the Import Orders routine was unsuccessful, the Audit report shows you the 
problems that occurred during the import routine. Correct the errors and 
repeat the Import Orders routine. If you assign your own order numbers, the 
Import Orders routine overrides this feature when importing the transactions. 
Sage DacEasy Order Entry assigns the next available order number determined 
by the number entered on the Edit Forms Setup dialog box. To check this 
number, select Defaults on the Edit menu, and then select Forms Setup. Select 
Orders and check the number in the Last Used Number field.

Successful Audit Report

Importing Information

Sage DacEasy Order Entry includes an Import routine that you can use to 
import customers, products, services and promotional price data from an ASCII 
file. Sage DacEasy does not require the data in the ASCII file to be in any specific 
order. However, you must create an import layout file, which specifies the order 
of the data you are importing. You can have as many layout files as necessary. 
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To Import Data

1 Choose Import from the File menu. The File Import dialog box appears.

2 Select the type of information you want to import.

3 Type the file name for your layout file. 

4 Type the path and file name of the file you are importing. 

5 Type the character that separates each field in your import file. The most 
common separator is the comma, which is the default.

6 Type the character that encloses a field. For example, if you have a customer 
named Kathy Eaton, it is probably enclosed by quotation marks, (“Kathy 
Eaton”) to indicate that the first and last name belong in the same field. 
Quotation marks are the most common string markers.

7 Click OK. The information is imported.

Related Help Topic

• Importing data

Exporting Billing Transactions 

Use this routine to export your billing transactions, which are invoices and sales 
returns. 

Use the File Import dialog
box to select the type of

information you are
importing, the file name of
the layout file you are using
and the path and file name

of the file you are
importing.
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To Export Billing Transactions 

1 Choose Export Billing on the File menu. The Export Billing Transactions 
dialog box appears.

2 Select the Re-export check box if you have already exported a file with the 
same transactions once before.

3 Type the path to where you want to export the file. The three-digit extension 
should be .TXT.

4 Type the numerical reference link for the billing transactions. The default 
Export Reference # uses the YYYY/MM/DD date format. 

5 Type the character you want to use to separate each field.

6 Type the character that encloses a field.

7 Type the range of dates for the transactions you want included in the file. 

8 Click OK. A message appears when the file is successfully created. Click 
Continue to exit the message.

Related Help Topic

• Purging the re-export reference file

Use the Export Billing
Transactions dialog box to
enter a path and file name

for the exported
information.
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• Quick Tour •
Use this chapter as a road map to effectively track your order entry information. 
The checklists in this chapter identify each step in the order entry process, direct 
you to the chapter or Help topic that explains each step and tell you why this step 
is important.

Getting Started Checklist
Sage DacEasy requires certain information prior to entering transactions. Use 
the following checklist to properly set up Sage DacEasy Order Entry.

 Add your company

Sage DacEasy Order Entry lets you track order entry information for 
multiple companies. You are prompted to add a company the first time 
you access the program. Add additional companies to Sage DacEasy Order 
Entry by choosing Open on the File menu. When the Open Company 
dialog box appears, click Add. 

For more info on adding a company to Sage DacEasy Order Entry, refer to 
“Opening and Adding Companies” on page 14.

Tip: You can also add your new company using the Sage DacEasy Business 
Center, and then use the Setup Workflow Guide to assist you with the 
setup process. 

 Enter the controller password and assign user access rights

The Sage DacEasy Order Entry controller has full access to all areas of the 
Sage DacEasy Order Entry program. After the controller password has 
been entered, each user can be added and assigned limited access to the 
program. Add the controller password by pointing to Defaults on the Edit 
menu, and then selecting Passwords. Add User IDs and assign access rights 
by pointing to Defaults on the Edit menu, and then selecting User Access 
Rights. After setting up the access rights for each user, be sure to activate 
the User Access Rights feature on the System Preferences dialog box. 

For more info on passwords and user access rights, refer to “Setting Up 
Security” on page 52.

 Enter company information

Type your company’s name and address information. This information 
prints at the top of each report. You will also enter your federal and state 
tax identification numbers here. Enter your company information by 
choosing Defaults on the Edit menu, and then selecting Company 
Information. 
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For more info, refer to “Setting Up the Company Information” on page 38.

Note: If you add your company using the Sage DacEasy Business Center, 
you have the option to automatically update the company information in 
each Sage DacEasy module when you save the new company profile. This 
keeps you from entering your address information more than once.

 Set system preferences

Use the System Preferences dialog box to customize the program to meet 
your needs. Select your system preferences by pointing to Defaults on the 
Edit menu, and then selecting System Preferences. 

For more info on system preferences, refer to “Setting Up System 
Preferences” on page 39.

 Add labels for custom fields

You can customize up to six text fields, four numeric fields and two date 
fields for your customer, product and service records. After setting up the 
custom field labels, the labels appear on the Custom tab when editing 
customer, product and service records. You can then include these fields on 
custom reports generated with DacAccess. 

For more info on setting up custom field labels, refer to “Editing Custom 
Field Labels” on page 47.

 Enter customer and product defaults

If you find yourself entering the same information on each record when 
you add your customers and products, enter the information as a default. 
The default information automatically appears when you add a new 
record. Enter customer defaults by pointing to Defaults on the Edit menu, 
and then selecting Customer Defaults. Enter product defaults by pointing 
to Defaults on the Edit menu, and then selecting Product Defaults. 

For more info on customer and product defaults, refer “Setting Up 
Product and Customer Defaults” on page 50.

 Set up your default printer

Use the Edit Default Printer dialog box to set your default printer settings. 
These settings are used when you print your reports and forms in Sage 
DacEasy Order Entry. To access the Edit Default Printer dialog box, point 
to Defaults on the Edit menu, and then select Printer. 

For more info on setting up the application printer, refer to the section 
titled “Setting Up the Printer” on page 51.
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 Enter your form preferences

You can print forms on plain paper, a preprinted Sage DacEasy form or a 
custom form. Prior to printing your first form, select which form template 
you are using or design your own template. Select your form preferences 
by pointing to Defaults on the Edit menu, and then selecting Forms Setup. 

For more info on forms, refer to “Selecting Form Templates” on page 62.

 Enter your methods of payment, messages, price breaks, salespeople, 

shipping methods, terms, tax and weight unit tables

Sage DacEasy uses tables to store information. Assign information to a 
code, and then use this code instead of reentering the information 
throughout the program. If the information changes (for example, the tax 
rate changes), you only need to change the table instead of changing each 
customer or product record affected by the change. 

For more information on tables, refer to “Setting Up Table Information” 
on page 67.

 Add your customers and setup balances

To track information about each customer, add customers on the Edit 
Customer dialog box. Balance information for the customer is updated 
automatically each time you use this customer on a transaction. When you 
enter beginning balances, you can enter each outstanding invoice 
individually or a lump sum. The Accounts Receivable account is updated 
as you enter each customer’s beginning balance. To add customers, select 
Customers from the Edit menu. 

For more info on customers, refer to “Setting Up Customer Information” 
on page 78.

 Add your products and setup balances

To track inventory, add products you sell on the Edit Products dialog box. 
You can enter each item on orders and invoices. You can enter finished 
goods with component lists and use the assembly-on-the-fly feature to 
build the products. The Inventory account balance is automatically 
updated as you enter each product’s beginning balance. To add products, 
select Products from the Edit menu. 

For more info on products, refer to “Setting Up Product and Customer 
Defaults” on page 50.

Tip: If you are tracking inventory for multiple warehouses, you can 
automatically generate product codes for each warehouse when you create 
the master item. 
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 Enter your warehouses and master items

If you want to track inventory located in multiple warehouses, add a record 
for each warehouse and master item. When you set up the master item, 
include each product that makes up the master item and the warehouse in 
which the item is stored. This allows you to track your inventory by the 
master item or by each warehouse. 

For more info on setting up warehouses, refer to “Setting Up Warehouses” 
on page 77. 

 Add your services

If you want to include services on your orders and invoices, add services 
your company offers on the Edit Service dialog box. To add services, select 
Services from the Edit menu. 

 Add your billing codes

Use codes to include items on orders and invoices that are not products or 
services (for example, freight). To add billing codes, select Billing Codes 
from the Edit menu. 

For more information on billing codes, refer to Chapter 4, “Setting Up.".

 Add your serial numbers

If you track serial numbers for your products and services, enter each serial 
number. Then, you can track the product by its serial number when you 
sell the product. To view serial numbers, select Serial Numbers from the 
Edit menu. 

For more info on serial numbers, refer to Chapter 4, “Setting Up.".

 Add your promotional prices

Use the Promotional Price feature to enter special sales prices that are valid 
for a certain range of dates. If you are offering a sale on specific items for 
one week, enter the special sales price you want for that week on the 
promotional price transaction. To add promotional prices, select 
Promotional Price from the Edit menu. 

For more info on promotional prices, refer to Chapter 4, “Setting Up.".
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Understanding the Sage DacEasy Order Entry Process 
Checklist

The following checklist details the tasks you should perform on a daily basis 
when entering and shipping orders.

 Log in to the Order Entry dialog box

Use the Log In dialog box to track the Sage DacEasy Order Entry person 
entering the orders. Print the detail Order Status report to identify the Sage 
DacEasy Order Entry person who entered a particular order or you can 
create a custom report. Log in to the Order Entry dialog box by choosing 
Order Entry on the Process menu.

 Enter your quotes, orders and returns as necessary

Use the Order Entry dialog box to enter your quotes, orders, blanket 
orders and returns (referred to as RMAs, Returned Merchandise 
Authorizations). You can also pull up an old order and fill the backordered 
items, check the customer inquiry and convert a quote to an order all from 
the Order Entry dialog box. 

Depending on the settings selected on the System Preferences dialog box, 
you can record the serial numbers as you enter the products or services and 
print the order, RMA and picking ticket as you enter each transaction. 
Access the Order Entry dialog box by choosing Order Entry from the 
Process menu. 

For more info on entering transactions, refer to “Entering Orders, Blanket 
Orders and RMAs” on page 96.

 Print the orders, RMAs and picking tickets

After you have entered your quotes, orders and RMAs, you can batch print 
the orders, picking tickets, RMAs, quotes and order labels. To batch print 
means print a range of forms or labels at one time. Send the picking ticket 
to the warehouse or fulfillment center to prepare the order. To print this 
information, point to Print Orders from the Process menu, and then select 
the option you want to print. 

For more info on printing these forms, refer to Chapter 5, “Processing 
Orders."
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 Ship orders and RMAs using the Ship Orders routine

Use the Ship Orders routine when you are ready to deliver an order to the 
customer or when you receive returned items from a customer. This 
process creates billing invoices for orders and sales returns for RMAs. You 
can also fill backorders from the Ship Orders routine. This means you can 
tag all the orders you want to ship and fill the backorders all at once. 
Depending on the settings on the System Preferences dialog box, you can 
record the serial numbers for the products and services as you select the 
orders to ship. Access the Ship Orders routine by choosing Ship Orders 
from the Process menu. 

For more info on shipping transactions, refer to “Shipping Orders” on 
page 111.

Note: Depending on the number of orders you are shipping, you may want 
to make a backup of your order entry and accounting data files before 
performing the Ship Orders routine.

 Print your invoices, sales returns and packing lists

When you ship the order, Sage DacEasy Order Entry creates an invoice or 
sales return. Print the invoice or sales return to send to the customer. Print 
the shipping label and packing list and send them to the warehouse or 
fulfillment center to include in the order. To print this information, point 
to Print Invoices from the Process menu, and then select the option you 
want to print. 

For more info on printing these forms, refer to Chapter 5, “Processing 
Orders."

 Print the Sales Journal to verify correct shipping entries

After you have shipped all the orders for the day, you are now ready for 
final verification of the invoices and returns. Print the Sales Journal to 
check that the invoices shipped and goods returned are correct. To print 
the Sales Journal, choose Sales Journal from the Process menu. Select 
Journal and check the date. Click OK to print the journal. 

For more info on printing the Sales Journal, refer to “Printing the Sales 
Journal or Sales Listing” on page 120.

 If you detect a shipment error on the Sales Journal, use the Cancel 

Shipment routine to reverse the shipment

After you ship an order, but before you post the shipment, you can reverse 
the Ship Orders routine should you find any errors. Use the Cancel 
Shipment routine if you incorrectly tagged and shipped an order. To access 
the Cancel Shipment routine, choose Cancel Shipment from the Process 
menu. 
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For more info on canceling a shipment, refer to “Cancelling Shipments” on 
page 124.

Note: Make a backup of your order entry and accounting data files before 
performing the Cancel Shipment routine. 

 Back up your data files

It is important you back up your order entry data files prior to posting. If 
you are interfacing with Sage DacEasy Accounting, you also want to make 
a separate backup of your accounting data files. If you encounter an error 
during the Posting routine, the first step in fixing the problem is restoring 
the backup. Make a backup of your data files by choosing Backup/Restore 
from the File menu. 

For more info on making a backup of your data files, refer to Chapter 2, 
“Getting Started.".

Tip: You can back up all Sage DacEasy data files for a single company from 
the Sage DacEasy Business Center. Refer to Chapter 5, “Working With the 
Sage DacEasy Business Center” in the Getting Started Guide for more 
information.

 Post shipments

The last step in the order entry process is posting shipments. The Post 
Shipments routine updates the customers, products, services, tax tables, 
salesperson, sales analysis and chart of accounts. To post shipments, 
choose Post Shipments from the Process menu. Check the date on the Post 
Order Entry dialog box and click OK. 

For more info on posting shipments, refer to “Posting Shipments” on page 
126.

Periodic Routines Checklist
The following checklist details the tasks performed on a periodic basis.

 Back up your order entry and accounting data files

Although you rarely need to restore a backup, it is important to make 
frequent backups in case you accidentally perform a procedure that cannot 
be reversed or you have corruption in your files. If you are running Sage 
DacEasy Order Entry interfaced with Sage DacEasy Accounting, be sure to 
make a separate backup of your accounting data files each time you make a 
backup of your order entry data files. To make a backup, choose Backup/
Restore on the File menu. 

For more info on making a backup of your data files, refer to “Getting 
Started” on page 11.
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 Run the File Utilities routine

Your data files, like your cars, need periodic maintenance. The Recover and 
Verify routines work together to keep your software running smoothly. To 
run the File Utilities routine, choose Utilities on the File menu. 

For more info on running the utilities, refer to “Using the Utilities Feature” 
on page 19.

 Print any custom reports pulling information you want to track on a 

periodic basis

If you have created any custom reports in DacAccess pulling any historical 
information from customers, products, services or tax tables, print the 
reports before running the Year End routine. 

For more info on custom reports, refer to Chapter 8, “Custom Reporting.".

 Run the Year End routine in Sage DacEasy Order Entry

The Year End routine updates the historical information in your customer, 
product, service and tax table records. The Year to Date (YTD) balances 
transfer to Last Year (LY) and Last Years balances transfer to Year Before 
Last (YBL). This routine also changes the period dates to the new year. To 
run the Year End routine, choose Year End on the Periodic menu. 

For more info on running the Year End routine, refer to “Running Year 
End” on page 191.

 Run the Year End routine in Sage DacEasy Accounting

If you are running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, run the Year End routine in Sage DacEasy Accounting after 
you have run the Year End routine in Sage DacEasy Order Entry. Run the 
Year End routine in Sage DacEasy Accounting as specified by the Sage 
DacEasy Accounting User Guide or Sage DacEasy Accounting Help system.

 Perform periodic procedures like purging data files

If you are running low on disk space, you can purge information in your 
data files. It is recommended that you purge at the end of the year if you 
must purge data. To purge information, choose Purge from the Periodic 
menu. 

For more info on purging data, refer to “Purging Data Files” on page 188.

Note: After you purge information, you should run the Recover routine to 
retrieve the recovered hard disk drive space. Choose Utilities from the File 
menu to run the Recover routine.



Quick Tour
Sage DacEasy Order Entry User’s Guide

36

3



4Setting Up

Setting Up Default Information 38
Setting Up the Company Information 38

Setting Up System Preferences 39

Interfacing Sage DacEasy Order Entry With Sage DacEasy 
Accounting 41

Editing Custom Field Labels 47

Entering Custom E-mail Subjects 48

Setting Up Product and Customer Defaults 50

Setting Up the Printer 51

Setting Up Security 52
Adding the Controller Password 52

Adding New Users and Assigning Access Rights 52

Audit Trail 54

Creating the Audit Trail Log 55

Active/Inactive Status 57

Field Level Security 60

Add, Edit, Delete User Access Rights 61

Selecting Form Templates 62

Incorporate Images to Reports and Forms 63

Printing Forms with Company Logo 65

Setting Up Table Information 67
Setting Up Methods of Payment 67

Setting Up Messages 68

Setting Up Price Break Tables 69

Setting Up Shipping Methods 71

Setting Up Terms Tables 72

Setting Up Tax Tables 73

Setting Up Warehouses 77

Setting Up Weight Units 77

Setting Up Other Information 78



Setting Up
Sage DacEasy Order Entry User’s Guide

38

4

• Setting Up •
This chapter helps you get started using the program by setting up all the 
necessary information. The first section explains what default information you 
need to set up and the steps on how to do it. The next sections explain items you 
can set up ahead of time to speed up the order entry process. These items include 
your customers, master items, products, services, promotional prices, billing 
codes, salespeople, warehouses, weight units, serial numbers, method of 
payments, shipping methods, tax tables, terms and other areas of the program.

Setting Up Default Information
Like all of Sage DacEasy’s products, you can set up defaults in Sage DacEasy 
Order Entry. When you take the time to set up your defaults, you will find 
entering transactions becomes a fast efficient process. The information in this 
section explains the procedures you follow to set up defaults.

Setting Up the Company Information

Enter your company name and address on the Company Information dialog 
box. This name is different from the identification name entered on the Add 
Company dialog box when adding a new company. Information on the Add 
Company dialog box acts as a short description of your company and only 
appears on the Open Company dialog box. This is useful if you operate more 
than one company, because you can easily identify each company. The company 
information, however, appears on the Sage DacEasy desktop and prints at the 
top of all reports.
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To Set Up the Company Information

1 Point to Defaults on the Edit menu, and then select Company 
Identification. The Company Information dialog box appears. Click Help 
for more information on each field.

Note: If you add your company using the Sage DacEasy Business Center, you 
have the option to automatically update the company information in each 
Sage DacEasy module when you save the new company profile. This keeps 
you from having to enter your address information more than once.

2 Type your company name in the Name field.

3 Type your company address, e-mail address, phone numbers, fax number and 
federal and state tax identification numbers in the appropriate fields.

4 Click OK to save the company information and exit the dialog box.

Setting Up System Preferences

Use the System Preferences dialog box to interface Sage DacEasy Order Entry 
with Sage DacEasy Accounting. The information you enter on this dialog box 
also controls many different routines throughout Sage DacEasy Order Entry.

.The company name and 
address entered here 
prints at the top of all 
predefined reports.
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To Set the System Preferences

1 Point to Defaults on the Edit menu, and then select System Preferences. 
The System Preferences dialog box appears. Click Help for more 
information on each field.

2 Select your preferences for each option on the General tab.

3 Click the Transactions tab and make your selections for each option.

4 Click the Online Processing tab. Make any necessary changes if using the 
online payment verification feature. To take advantage of this funtionality in 
Sage DacEasy, please contact Sage Payment  Solutions.  They can be reached 
for further information from the Sales department  at 800 DACEASY.

5 Click the Last Numbers tab. Make any necessary changes.

6 Click the Credit tab and make your selections for each option. You can 
choose to display a warning or prevent invoices from being created if a 
customer has reached their credit limit or has a past due balance. If you are 
interfaced with Sage DacEasy Accounting, select these preferences on the 
System Preferences dialog box in Sage DacEasy Accounting. 

7 Click OK to save the system preferences.

Use the System
Preferences dialog box

to customize the
program to meet your

needs.
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Interfacing Sage DacEasy Order Entry With Sage DacEasy Accounting

Because you can interface Sage DacEasy Order Entry with Sage DacEasy 
Accounting, a special section is dedicated to explaining how to set up the 
interface between the two programs and what files are affected when interfacing 
with Sage DacEasy Accounting. 

If you use Sage DacEasy Accounting, you can easily set up an interface between 
the two programs. After you install Sage DacEasy Accounting on your hard disk 
drive and set up your accounting company data files, type and store the path to 
the accounting data files in the System Preferences dialog box in Sage DacEasy 
Order Entry. If you have been using Sage DacEasy Order Entry as a stand-alone 
program and you want to begin interfacing Sage DacEasy Order Entry with Sage 
DacEasy Accounting, contact Sage DacEasy Customer Support Services.

Tip: If you are using the Sage DacEasy Business Center, you can set up the 
interface automatically when you add both the Sage DacEasy Accounting and 
Sage DacEasy Order Entry module to the company profile.

When you interface Sage DacEasy Order Entry with Sage DacEasy Accounting, 
your billing transactions are recorded in Sage DacEasy Accounting when you 
ship orders and post your order entry shipments. This means you do not need 
to make a separate entry in Sage DacEasy Accounting to record these 
transactions. 

Tip: Sage DacEasy Order Entry only interfaces with the current version of Sage 
DacEasy Accounting.

To Set Up the Interface Between Sage DacEasy Accounting and 
Sage DacEasy Order Entry

1 Open Sage DacEasy Accounting and select Open from the File menu. The 
Open Company dialog box appears. Each company set up in Sage DacEasy 
Accounting appears with the corresponding path to the data files. Select the 
company you want to interface with Sage DacEasy Order Entry and write 
down the path to the accounting data files.

2 Access Sage DacEasy Order Entry and open the company you want to 
interface with Sage DacEasy Accounting. Point to Defaults on the Edit 
menu, and then select System Preferences. The System Preferences dialog 
box appears.

3 Select the Interface with Sage DacEasy Accounting check box and type 
the path to the accounting data files in the Sage DacEasy Accounting Path 
field.

4 Click OK to save the change and exit the dialog box.
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Files Shared when You Interface with Sage DacEasy Accounting

Several files are shared when Sage DacEasy Order Entry is interfaced with Sage 
DacEasy Accounting. These files are the link between the two programs and 
automatically update Sage DacEasy Accounting with sales transactions from 
Sage DacEasy Order Entry.

• Accounts - Sage DacEasy Order Entry uses this file when you specify 
default account numbers. The accounts used for sales, taxes, etc. must 
match the accounts used in Sage DacEasy Accounting. When you post 
an invoice transaction, the dollar amounts are distributed to the 
specified accounts in Sage DacEasy Accounting and increase or 
decrease the account balance accordingly.

• General Ledger files - Sage DacEasy Order Entry updates the General 
Ledger module in Sage DacEasy Accounting with a summary 
transaction each time you post shipments. The transaction created by 
Sage DacEasy Order Entry affects the specified accounts. The entry is 
recorded in the General Ledger module in Sage DacEasy Accounting 
showing how each account was affected. If you are using the Update 
General Ledger Online feature, Sage DacEasy Order Entry updates the 
General Ledger module in Sage DacEasy Accounting with an unposted 
detail transaction each time you ship an order. The General Ledger 
module is also updated with an unposted transaction when you save an 
advance payment on an order if Entering is selected as your Process 
Payment When option on the Transactions tab of the System 
Preferences dialog box in Sage DacEasy Order Entry.

• Customers - Customers set up in Sage DacEasy Accounting are 
accessed when you view customers in Sage DacEasy Order Entry. This 
means you do not have to reenter customer information in Sage 
DacEasy Order Entry after you set up the interface to Sage DacEasy 
Accounting. When you look up customer information or view it on the 
Edit Customer dialog box, Sage DacEasy accesses the customers in Sage 
DacEasy Accounting. Customer notes and alternative addresses are also 
shared in this way. When you add a customer in Sage DacEasy Order 
Entry, Sage DacEasy adds this record to the Customer file in Sage 
DacEasy Accounting.

• Customer Transaction History files - The Customer Transaction 
History Detail and Summary files are updated when you ship orders. 
To ensure these files are updated in Sage DacEasy Order Entry and Sage 
DacEasy Accounting, point to Defaults on the Edit menu in Sage 
DacEasy Accounting, and then select System Preferences. Select the 
Track Customer Transaction History check box. 
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• Master Items - Master items set up in Sage DacEasy Accounting are 

accessed when you view master items in Sage DacEasy Order Entry. 
This means you do not need to reenter the master items in Sage 
DacEasy Order Entry after you set up the interface to Sage DacEasy 
Accounting. When you interface Sage DacEasy Order Entry with Sage 
DacEasy Accounting, you are able to keep track of the inventory on 
hand because on hand units and dollars are affected by transactions 
entered in Sage DacEasy Order Entry and Sage DacEasy Accounting.

• Warehouses - Warehouses set up in Sage DacEasy Accounting are 
accessed when you view warehouses in Sage DacEasy Order Entry. This 
means you do not need to reenter the warehouses in Sage DacEasy 
Order Entry after you set up the interface to Sage DacEasy Accounting. 
Warehouse permits are also shared in this way.

• Products - Products set up in Sage DacEasy Accounting are accessed 
when you view products in Sage DacEasy Order Entry. This means you 
do not need to reenter products in Sage DacEasy Order Entry after you 
set up the interface to Sage DacEasy Accounting. When you interface 
Sage DacEasy Order Entry with Sage DacEasy Accounting, you are able 
to keep track of the inventory on hand because on hand units and 
dollars are affected by transactions entered in Sage DacEasy Order 
Entry and Sage DacEasy Accounting. When you look up product 
information or view it on the Edit Product dialog box, Sage DacEasy 
accesses the products in Sage DacEasy Accounting. Product notes and 
component lists are also shared in this way. When you add a product in 
Sage DacEasy Order Entry, Sage DacEasy adds this record to the 
Product file in Sage DacEasy Accounting.

• Product Transaction History - The Product Transaction History file is 
updated when you post shipments and enter Inventory Adjustment 
transactions. To ensure this file is updated, select the Track Product 
Transaction History check box on the System Preferences dialog box 
in Sage DacEasy Accounting.

• Services - Services set up in Sage DacEasy Accounting are accessed 
when you view services in Sage DacEasy Order Entry. This means you 
do not need to reenter services in Sage DacEasy Order Entry after you 
set up the interface to Sage DacEasy Accounting. When you look up 
service information or view it on the Edit Service dialog box, Sage 
DacEasy accesses the services in Sage DacEasy Accounting. Service 
notes are also shared in this way. When you add a service in Sage 
DacEasy Order Entry, Sage DacEasy adds this record to the Service file 
in Sage DacEasy Accounting.
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• Accounts Receivable Open Invoice Header and Detail - When you 

enter a receivable sale in Sage DacEasy Order Entry, an entry is made to 
the AR Open Invoice files in Sage DacEasy Accounting. This lets you 
view receivable transactions created in Sage DacEasy Order Entry on 
the Receivables Aging report and on customer statements. Sage 
DacEasy Order Entry updates the AR Open Invoice files for advance 
payments depending on whether you choose to process payments 
when shipping or upon entry in the System Preferences dialog box.

• Billing Codes - Billing codes set up in Sage DacEasy Accounting can be 
accessed in Sage DacEasy Order Entry. This means you do not need to 
reenter billing codes in Sage DacEasy Order Entry after you set up the 
interface to Sage DacEasy Accounting. When you look up billing code 
information or view it on the Edit Billing Code dialog box, Sage 
DacEasy accesses the billing codes in Sage DacEasy Accounting. When 
you add a billing code in Sage DacEasy Order Entry, Sage DacEasy adds 
this code to the Billing Code file in Sage DacEasy Accounting.

• Messages - Message codes set up in Sage DacEasy Accounting can be 
accessed in Sage DacEasy Order Entry. This means you do not need to 
reenter message codes in Sage DacEasy Order Entry after you set up the 
interface to Sage DacEasy Accounting. When you look up message code 
information or view it on the Edit Message dialog box, Sage DacEasy 
accesses the message codes in Sage DacEasy Accounting. When you add 
a message in Sage DacEasy Order Entry, Sage DacEasy adds this record 
to the Message file in Sage DacEasy Accounting.

• Terms Tables - Terms codes set up in Sage DacEasy Accounting can be 
accessed in Sage DacEasy Order Entry. This means you do not need to 
reenter terms codes in Sage DacEasy Order Entry after you set up the 
interface to Sage DacEasy Accounting. When you look up terms code 
information or view it on the Edit Terms Code dialog box, Sage 
DacEasy accesses the terms codes in Sage DacEasy Accounting. When 
you add a term code in Sage DacEasy Order Entry, Sage DacEasy adds 
this code to the Terms file in Sage DacEasy Accounting.

• Tax Tables - Tax codes set up in Sage DacEasy Accounting can be 
accessed in Sage DacEasy Order Entry. This means you do not need to 
reenter tax codes in Sage DacEasy Order Entry after you set up the 
interface with Sage DacEasy Accounting. When you look up tax code 
information or view it on the Edit Tax Table dialog box, Sage DacEasy 
accesses the tax codes in Sage DacEasy Accounting. When you add a tax 
in Sage DacEasy Order Entry, Sage DacEasy adds this record to the Tax 
file in Sage DacEasy Accounting.
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• Price Breaks - Price breaks set up in Sage DacEasy Accounting can be 

accessed in Sage DacEasy Order Entry. This means you do not need to 
reenter price breaks in Sage DacEasy Order Entry after you set up the 
interface with Sage DacEasy Accounting. When you edit or view price 
breaks, Sage DacEasy accesses the price breaks in Sage DacEasy 
Accounting. When you add a price break in Sage DacEasy Order Entry, 
Sage DacEasy adds this record to the Price Break file in Sage DacEasy 
Accounting.

• Promotional Prices - Promotional prices set up in Sage DacEasy 
Accounting can be accessed in Sage DacEasy Order Entry. This means 
you do not need to reenter promotional prices. When you edit or view 
Promotional Prices, Sage DacEasy Order Entry accesses The 
Promotional Prices table in Sage DacEasy Accounting. When you add a 
record to this table in Sage DacEasy Order Entry, it is immediately 
reflected in Sage DacEasy Accounting.

• Salespeople - Salesperson codes set up in Sage DacEasy Accounting can 
also be accessed in Sage DacEasy Order Entry. This means you do not 
need to reenter the salespersons codes in Sage DacEasy Order Entry 
after you set up the interface to Sage DacEasy Accounting. When you 
edit or view a salesperson, Sage DacEasy accesses the salespeople in 
Sage DacEasy Accounting. When you add a salesperson code in Sage 
DacEasy Order Entry, Sage DacEasy adds this code to the Salesperson 
file in Sage DacEasy Accounting.

• Invoices Header and Detail - These files are updated when you ship 
orders and RMAs and when you post your shipments in Sage DacEasy 
Order Entry. When an order is shipped, Sage DacEasy Order Entry 
creates a billing transaction (an invoice or sales return) in Sage DacEasy 
Accounting using the next available invoice number, or an invoice 
number you select. To assign your own invoice numbers, point to 
Defaults on the Edit menu, and then select Forms Setup in Sage 
DacEasy Order Entry. Select Invoices, and then select the Assign Own 
Number check box.

• Serial Numbers - The serial number files are updated depending on the 
selection made on the System Preferences dialog box in Sage DacEasy 
Order Entry. If you selected Orders for the Serial Number Point of 
Entry option, the Serial Number file is updated when you enter your 
serial numbers as you enter your order. If you selected Shipments for 
the Serial Number Point of Entry option, the Serial Number file is not 
updated until you enter the serial number while shipping your orders. 
When you add a serial number in Sage DacEasy Order Entry, Sage 
DacEasy adds this serial number to the Serial Number file in Sage 
DacEasy Accounting.
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• Assembly files - These files are updated when you use the Assembly 

routine in the Order Entry dialog box.

• Check Register - If you have invoices with advance payments, your 
Sage DacEasy Accounting Check Register file is updated when you post 
the shipments in Sage DacEasy Order Entry. If you are using the 
Update Check Register Online feature, Sage DacEasy Order Entry 
updates the Sage DacEasy Accounting Check Register file when you 
save or ship an advance payment on an order. When the Sage DacEasy 
Accounting Check Register is updated depends on whether you 
selected Entering or Shipping as the Process Payment When option on 
the Transactions tab of the System Preference dialog box in Sage 
DacEasy Order Entry.

• Sales Analysis - The Sage DacEasy Accounting Sales Analysis file is 
updated when you post shipments in Sage DacEasy Order Entry. This 
file is also updated when posting the Billing module in Sage DacEasy 
Accounting. To ensure the Sales Analysis file is updated when you post, 
be sure to select the Track Sales Analysis check box on the Billing tab of 
the System Preferences dialog box in Sage DacEasy Accounting.

• Sales Assistant - This file holds the extended, hidden and pop up 
messages for your products and services on orders and invoices. To 
view the Sales Assistant for a product or service, view the item on the 
Edit Product or Edit Service dialog box. Click Options, and then select 
Sales Assistant.

• Substitute Products - Substitute product lists set up in Sage DacEasy 
Accounting can be accessed in Sage DacEasy Order Entry. This means 
you do not need to reenter substitute products in Sage DacEasy Order 
Entry after you set up the interface with Sage DacEasy Accounting. 
When you edit or view the substitute products list, Sage DacEasy 
accesses the substitute products list in Sage DacEasy Accounting. When 
you add a product to a substitute products list in Sage DacEasy Order 
Entry, Sage DacEasy adds this record to the Substitute Products file in 
Sage DacEasy Accounting.



Setting Up Default Information
Editing Custom Field Labels

47

4
• Shipping Methods - Shipping methods set up in Sage DacEasy 

Accounting can be accessed in Sage DacEasy Order Entry. This means 
you do not need to reenter shipping methods in Sage DacEasy Order 
Entry after you set up the interface to Sage DacEasy Accounting. When 
you edit or view a shipping method, Sage DacEasy accesses the 
shipping methods in Sage DacEasy Accounting. When you add a 
shipping method in Sage DacEasy Order Entry, Sage DacEasy adds this 
record to the Shipping Methods file in  Sage DacEasy Accounting.

• Weight Units - Weight unit codes set up in Sage DacEasy Accounting 
can be accessed in Sage DacEasy Order Entry. This means you do not 
need to reenter weight unit codes in Sage DacEasy Order Entry after 
you set up the interface to Sage DacEasy Accounting. When you edit or 
view a weight unit, Sage DacEasy accesses the weight unit codes in Sage 
DacEasy Accounting. When you add a weight unit code in Sage 
DacEasy Order Entry, Sage DacEasy adds this record to the Weight 
Unit file in Sage DacEasy Accounting.

• Custom Fields - Custom field labels set up in Sage DacEasy Accounting 
can be accessed in Sage DacEasy Order Entry. This means you do not 
need to reenter the custom field labels in Sage DacEasy Order Entry 
after you set up the interface to Sage DacEasy Accounting. When 
viewing the custom fields on the Edit Customer, Edit Product and Edit 
Service dialog boxes, Sage DacEasy displays the custom field labels set 
up in Sage DacEasy Accounting. When you change a custom field label 
in Sage DacEasy Order Entry, Sage DacEasy updates the custom field 
labels in Sage DacEasy Accounting.

Editing Custom Field Labels

You can customize up to six text fields, four numeric fields and two date fields 
for your customer, product and service records. You can then include these 
fields on custom reports generated with DacAccess. 

Note: Custom field labels appear only when editing records. The default field 
labels appear when using custom fields in DacAccess. 
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To Edit Custom Field Labels

1 Select Defaults from the Edit menu, and then select Custom Field Labels. 
The Edit Custom Field Labels dialog box appears.

2 Type the name of each custom field you use. You can customize the following 
types of fields:

Text—You can include letters, numbers or symbols in text fields. Although 
you can enter numbers in text fields, you cannot perform calculations on text 
fields in DacAccess. 

Amount—You can only include numbers in amount fields. Use these custom 
fields to perform calculations or edit the format of these fields in DacAccess.

Date—Date fields appear in a MM/DD/YYYY format. You can modify the 
format when printing custom reports with DacAccess. 

3 Repeat the previous step for each tab.

4 Click OK to save your field labels. The new field labels appear on the Custom 
tab when editing customer, product and service records.

Entering Custom E-mail Subjects

Sage DacEasy Order Entry allows you to enter custom text to populate the 
subject line of e-mail messages you send to customers for transactions and 
packing lists. Optionally, you can also include the document number and 
customer name in the subject line.

Enter the custom field
labels you want to use

for customers,
products and services
on each appropriate

tab of the Edit Custom
Field Labels dialog box.
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To enter Custom E-mail Subjects

1 Select Defaults from the Edit menu, then select Custom E-mail Subjects to 
open the Transactions page of the Custom E-mail Subjects dialog box.

2 Enter the text you want to include on the subject line of e-mails for 
transactions in the text field for:

• Orders - Mark Order number and Customer if you want to include the 
order number and customer name in the e-mail subject line.

• Quotes -Mark Quote number and Customer if you want to include the 
quote number and customer name in the e-mail subject line.

• Picking Tickets - Mark Order number and Customer if you want to 
include the merchandise received number and customer name in the e-
mail subject line.

• Invoices - Mark Invoice number and Customer if you want to include 
the invoice number and customer name in the e-mail subject line.

• Sales Returns - Mark Invoice number and Customer if you want to 
include the invoice number and customer name in the e-mail subject line.

• RMA’s - Mark RMA number and Customer if you want to include the 
RMA number and vendor name in the e-mail subject line.
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3 Click the Packing List tab to open the Packing List page.

4 Enter the text you want to include on the subject line of e-mails for packing 
lists in the text field for:

• Invoices Packing List - Mark Invoice number and Customer if you 
want to include invoice numbers and customer names in the e-mail 
subject lines.

• Sales Returns Packing List - Mark Invoice number and Customer if 
you want to include the invoice number and customer name in the e-mail 
subject line.

5 Click OK to save your changes and to close the Custom E-mail Subjects 
dialog box.

Setting Up Product and Customer Defaults

Use the Product and Customer Defaults feature to help you set up your products 
and customers quickly. You can enter global information that appears 
automatically as you enter new products or customers. As you add new products 
or customers, the fields entered on the defaults dialog box appear on the Edit 
Product or Edit Customer dialog box. If some products or customers do not use 
the same information, you can make any necessary changes while entering the 
product or customer. Please note you do not have to complete every field on the 
defaults dialog box. Fill in only those fields that help speed the process of setting 
up products and customers.

To Set Your Product or Customer Defaults

1 Point to Defaults on the Edit menu, and then select Product Defaults or 
Customer Defaults. The appropriate dialog box appears. Click Help for 
more information on each field on the defaults dialog box.

2 Complete only the fields on the defaults dialog box that will help speed up 
the process of entering products or customers.

3 Click OK to save the product or customer defaults.
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Setting Up the Printer

Set up your default application printer in Sage DacEasy Order Entry before you 
print any reports or forms. It is important that you indicate the type of printer 
you are using so the program can correctly print information. 

To Set Up the Printer

Sage DacEasy uses the default printer settings unless you edit the report layout. 
For more information on customizing the report layout, refer to the section 
titled “Viewing Your Data” in Chapter 4, “Working With Sage DacEasy” in the 
Getting Started Guide.

1 Select Defaults from the Edit menu, and then select Printers. The Edit 
Default Printer dialog box appears. Click Help for a detailed description of 
each option. 

You can click Restore Default to restore the default printer settings.

2 Select the printer in the Name box on the Printer tab. 

The printers that appear in the Name list are based on the printers you have 
installed on your local Windows system. For more information on installing a 
printer on your system, refer to your Microsoft® Windows® operating system 
documentation.

3 Click the Fonts tab. Select your font preferences for each section of the 
report. Select a section, and then select your preferences for the section. 
Repeat this process for each section of the report.

4 Click the Page tab. Select your preferences for the page setup. 

Note  The Width and Height boxes only apply when you select a custom 
paper size. 

5 Click OK to save your printer settings. 

Tip: You can click Apply to All to update the report layouts for each report 
with the printer settings set on this dialog box.
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Setting Up Security

One of the most important issues when using a computerized system is the 
safety and security of your data. If you have one or more operators entering data 
or printing reports, you may want to restrict access to certain routines. 
Implementing Sage DacEasy’s security system is a three-step process. The first 
step is to set up a controller password. The second step is to add each user and 
assign their access rights. The third step is to select the Activate User Access 
Rights check box on the System Preferences dialog box.

The following information explains how to enter the controller password and 
add each user.

Adding the Controller Password

Sage DacEasy gives you a default user that has access to the entire program. This 
default user is assigned the User ID “Controller.” Use the Edit Password dialog 
box to enter the controller password. The next time you start the program, type 
Controller in the User ID field and type the password you assigned to the 
controller User ID. 

To Add the Controller Password

1 Select Defaults from the Edit menu, and then select Passwords. The Edit 
Password dialog box appears.

2 Type the password to be used each time you log in as the controller.

It is important that you remember your password or write it down and store it 
in a secure place.

3 Type the password again in the Confirm Password field.

4 Click OK to save your controller password.

Adding New Users and Assigning Access Rights

After entering the controller password, the controller can set up access rights for 
each additional user with the Access Rights feature. From the Edit User Access 
dialog box you can restrict the areas in the program that each user can access and 
assign individual passwords for each user. You can also limit the warehouses 
into which users can purchase inventory and from which inventory can be sold.
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To Add or Edit User Access

1 Select Defaults from the Edit menu, and then select User Access Rights. 
The Edit User Access dialog box appears. Click Help from the Edit User 
Access dialog box for a detailed description of each field. 

2 Type a User ID and password, and then confirm the password.

3 Select the Limit Warehouses check box if you have multiple warehouses and 
want to limit the warehouses into which the user can purchase inventory (if 
interfaced with Sage DacEasy Accounting) and from which inventory can be 
sold.

If you have already set up your warehouses and you selected this check box, 
click Options, and then select Edit Warehouse Permits. A list of your 
warehouses appears. Select a warehouse and click Tag/Untag to give the 
user access or remove access. Click Tag/Untag All to give or remove the user 
access to all warehouses. Click OK to save the warehouse rights and return to 
the Edit User Access dialog box.

If you have not set up your warehouses, return to this feature after setting up 
your warehouses to edit the user’s warehouse permits .

4 You can assign rights to each function or copy rights from another user.

To select rights, click Edit User Permits. Select a function and click Tag/
Untag to give the user access or remove access. Click Tag/Untag All to give 
the user access to all functions or remove access to all functions. Click OK to 
save the user and their access rights. The Edit User Access dialog box 
appears ready for you to set up additional users.

To copy an existing user’s rights, type the user ID in the Copy From User field 
or click LookUp and select the user from the list that appears. Click OK to 
save the user and their access rights and clear the Edit User Access dialog 
box.

Assign specific access
rights for each user
from the Edit User
Access dialog box.
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Audit Trail

Improve auditing and defend against potential fraud. With this feature, you 
have a register of user activity in the system. Audit Trail records insertions, 
deletions, and modifications of the most relevant master and transaction tables 
in Sage DacEasy. This important enhancement to the security system maintains 
a record of who modified the information in your system, as well as what 
information was modified and when.  The log is available to print as you desire. 

Note: To activate the Audit Trail Log in the Sage DacEasy Accounting, Sage 
DacEasy Order Entry and Sage DacEasy Point of Sale modules, enable the 
Activate User Access Rights option in System Preferences. To activate the Audit 
Trail Log in the Sage DacEasy Payroll module enable the Generate Audit Trail 
check box in Preferences.

The Audit Trail Log Report gives a detailed listing of the Audit Trail records that 
exist for any of the Sage DacEasy modules where this feature is activated. You 
can filter this report by any of the Sort and Rank options available, which 
include Date, User ID, and Entity ID. This allows you to print a report showing 
for any entity all the activity in Sage DacEasy for a range of Dates and User ID’s. 
You may also choose the specific functions for which you want to monitor this 
activity.

Turning ON User Access Rights 

1 Select Defaults from the Edit menu, and then select Passwords. The Edit 
Password dialog box appears.

2 Type the password to be used each time you log in as the Controller.

Tip: This is a Master password that allows access to every function in the 
system. It is important to remember this password or write it down and store 
it in a secure place.

3 Type the password again in the Confirm Password field. 

Tip: For more detailed information on creating users on the  refer to the 
User’s Guide for each module or to the on-line help system.

4 Select Defaults from the Edit menu, and then select User Access Rights. 
The Edit User Access dialog box appears.

5 Type a User ID and Password, and then confirm the password. If you are 
editing an existing user, Click LookUp to select the user.
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6 Select the Limit Warehouse check box if you have multiple warehouses and 

want to limit  the one for which the user can purchase or sell inventory. If you 
have set up your warehouses and you selected to Limit Warehouses, click on 
Options and then select Edit Warehouse Permits to tag the warehouses 
that are available to this user. 

7 Click on Edit User Permits and the User Access Rights dialog box appears. 
Select a function and click on Tag/Untag to give or remove access to the 
highlighted function. You may use Tag/Untag All to assign or remove access 
to all the listed functions.

8 Click OK to save the user, and exit this function when you have completed 
creating your users.

9 Select Defaults from the Edit menu, and then select System Preferences. 
The Edit System Preferences dialog box appears.

10 Select the Activate User Access Rights check box to enable the Security 
System and press OK to save the system preferences.

Turning ON the Audit Trail Log 

1 Select Defaults from the Edit menu, and then select System Preferences.

2 Click on the Generate Audit Trail Log check box to enable this option.

3 Click OK to save the new preference settings or Close to exit without saving.

Creating the Audit Trail Log 

Sage DacEasy creates an Audit Trail record every time users perform certain 
types of actions such as Inserting, Updating or Deleting information, using any 
of Sage DacEasy’s Transaction Entry or Table Maintenance functions. The 
Audit Trail record includes the date and time of the action, the ID of the User 
who performed the action, the ID and description of the entity affected by the 
action, the type of action performed (Insert, Update, Delete), and a reference to 
the source transaction.

Note: Entities refer to the Transaction Entry or Table Maintenance functions 
available in Sage DacEasy. Examples of entities are General Ledger, Accounts 
Receivable and Accounts Payable transaction entry. 

The following list describes the entities and activities that generate an Audit 
Trail:

Entity ID Description Reference
Customer Edit Customers Customer Code
Product Edit Products Item Code
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Service Edit Services Service Code
Master Item Edit Master Items Master Item Code
Fixed Asset Edit Fixed Assets Fix Asset Code
Billing Code Edit Billing Codes Billing Code
Salespeople Edit Salespeople Salespeople Code
Message Edit Messages Message Code
Price Break Edit Price Breaks Price Break Code
Shipping Method Edit Shipping Methods Shipping Method Code.
Term Edit Terms Term Code
Tax Edit Taxes Tax Code
Warehouse Edit Warehouses Warehouse Code
Weight Unit Edit Weight Units Weight Unit Code
General Ledger GL Transactions GL-<Transaction #>.
Invoice Invoices Entry <Invoice #>
Sales Return Sales Return Entry <SR Number>
Inventory Inventory Adjustments <Transaction #>
Assembly Assembly Transactions <Transaction #>
Physical Inventory Physical Inventory <Transaction #>

Printing the Audit Trail Log

1 Choose Audit Trail Log from the Reports menu for the Sage DacEasy 
Accounting, Sage DacEasy Point of Sale or Sage DacEasy Order Entry 
modules.

2 Enter the Sort by and Rank by options.

3 Click OK. The Report Layout dialog box appears.

4 Select the target disposition, edit the layout if necessary, and then click OK to 
begin printing.
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Purging the Audit Trail Log

1 Select Purge from the Periodic menu and the Purge dialog box appears.

2 Open the File dropdown and choose Audit Trail Log.

3 Enter the ‘purge to’ date. 

Note: This function purges Audit Trail records with a date equal to or earlier 
than the ‘purge to.’ 

4 Press OK to start purging. 

Note: Purging physically removes records from your company data. You must 
make sure this is what you want to do before performing this task.

Active/Inactive Status 

Reduce the time that it takes you to lookup customers, services, and more. 
When you set records as inactive, these records are omitted from reports, 
lookups, and may not be used when making transactions. Set the status of 
Accounts, Customers, Products, or Services to Inactive when you want Sage 
DacEasy to ignore these records without physically removing them from the 
company database. You may change the status of Inactive to Active when you 
are ready to start using these records again.

Changing the Status of Accounts

1 Select Customers from the Edit menu and the Edit Accounts dialog box 
appears.

2 Click on LookUp to select the customer to edit.
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3 Click on the Inactive check box field to set the status of that account to 

Inactive.  An unmarked check box means that the status is set to Active.

Note: Sage DacEasy verifies that it can change the status of an account to 
Inactive without causing integrity problems to your company’s database. If 
the account does not meet this validation criteria Sage DacEasy displays an 
error message.

4 Click OK to save the account or Click CLOSE to exit without saving.

Active/Inactive Status

Reduce the time that it takes you to lookup customers, services, and , more. 
When you set records as inactive, these records are omitted from reports, 
lookups, and may not be used when making transactions.  Set the status of 
Customers, Products, or Services to Inactive when you want Sage DacEasy to 
ignore these records without physically removing them from the Sage DacEasy 
database.  You may change the status of Inactive to Active when you are ready 
to start using these records again

Changing the Status of Customers

1 Select Customers from the Edit menu and the Edit Customers dialog box 
appears.

2 Click on LookUp to select the customer to edit.

3 Click on the Inactive check box field to set the status of that customer to 
Inactive.  An unmarked check box means that the customer is set to Active.      

Note: Sage DacEasy verifies that it can change the status of a customer to 
Inactive   without causing integrity problems to your company’s database. If 
the customer does not meet this validation criteria Sage DacEasy displays an 
error message.

4 Click OK to save the customer or click CLOSE to exit without saving.

Purging Inactive Customers

1 Select Customers from the Edit menu and the Edit Customers dialog box 
appears.

2 Click on Options in the Edit Customers toolbar and then Click on Purge 
Inactive.
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Note: The Purge Inactive function removes all Inactive customers from the 
Customers table. You must be sure that this is what you want to do before 
running the Purge Inactive option. 

3 Click on Continue to delete Inactive customers or Cancel to stop this process 
and return to the Edit Customers dialog.

Changing the Status of Products

1 Select Products from the Edit menu and the Edit Products dialog box appears.

2 Click on LookUp to select the Product to edit.

3 Click on the Inactive check box field to set the status of that Product to 
Inactive.  An unmarked check box means that the status is set to Active.

Note: Sage DacEasy verifies that it can change the status of a Product to 
Inactive without causing integrity problems to your company’s database. If the 
Product does not meet this validation criteria Sage DacEasy displays an error 
message.

4 Click OK to save the Product or click CLOSE to exit without saving.

Purging Inactive Products

1 Select Products from the Edit menu and the Edit Products dialog box appears.

2 Click on Options in the Edit Products toolbar and then Click on Purge Inactive.

Note: The Purge Inactive function removes all Inactive Products from the 
Products table. You must be sure that this is what you want to do before 
running the Purge Inactive option. 

3 Click on Continue to delete Inactive Products or Cancel to stop this process 
and return to the Edit Products dialog.

Changing the Status of Services

1 Select Services from the Edit menu and the Edit Services dialog box appears.

2 Click on LookUp to select the Service to edit.

3 Click on the Inactive check box field to set the status of that Service to 
Inactive.  An unmarked check box means that the service is set to active.
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Note: Sage DacEasy verifies that it can change the status of a Service to 
Inactive without causing integrity problems to your company’s database. If 
the Service does not meet this validation criteria Sage DacEasy displays an 
error message.

4 Click OK to save the Product or click CLOSE to exit without saving.

Purging Inactive Services

1 Select Services from the Edit menu and the Edit Services dialog box appears.

2 Click on Options in the Edit Services toolbar and then Click on Purge 
Inactive.

Note: The Purge Inactive function removes all Inactive services from the 
Services table. You must be sure that this is what you want to do before 
running the Purge Inactive option. 

3 Click on Continue to delete Inactive Services or Cancel to stop this process 
and return to the Edit Services dialog.

Field Level Security

This feature improves the security of your data and reduces employee mistakes. 
Keep unauthorized employees from modifying sensitive fields such as pricing 
and line item discounts on Billing and Purchasing WIndows. Use this feature for 
fields that are pre-filled with a logical default that users should not be modify, 
or for toolbar options that require a higher level of security. Examples of these 
are the Price field or the Delete Invoices option in the Invoice form. 

In addition, this feature closes known security violations by disallowing indirect 
unauthorized user access to certain functions. In previous versions, once a user 
entered into certain option for which the user has access, he or she may invoke 
other functions for which he or she does not have access.

Note: User rights to these fields and toolbar options default to ON when a 
company is converted from previous versions of Sage DacEasy.

Assigning Field Level Security

1 Select Defaults from the Edit menu and then select User Access Rights. The 
Edit User Access dialog appears. 

2 Click on LookUp to select the User you are assigning rights to.
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3 Click on Edit User Permits and the User Access Rights dialog box appears. 

Find the function or field level security you want and Click on Tag/Untag to 
give or remove access to the user. 

Tip: All new protected functions and fields were added to the end of the list 
in the Edit User Permits dialog. 

Sage DacEasy Order Entry V16 adds field level security to the following fields  
and toolbar options:

Form Type Description
Edit Customers Field Customer Status
Edit Products Field Product Status
Edit Services Field Service Status

Add, Edit, Delete User Access Rights

Increase the level of control for current user access rights by assigning add, edit, 
or delete rights for defined functions of the application. This feature allows you 
to determine which users can perform certain tasks within Account, Customer, 
Product, and Services functions. The following table describes these rights and 
the permits they include:

User Rights Permissions
Edit <Table> View, Insert
Modify <Table> View, Change
Delete <Table> View, Delete

Note: <Table> refers to the supported edit functions. These the following: 
Accounts, Customers, Master Items, Products, Services, Fixed Assets, Terms, 
Taxes, Billing Codes and Purchase Codes. The Edit User Permits LookUp 
includes new entries to modify and delete each of these tables.  The right to edit 
a table, found also in previous versions of Sage DacEasy, allows users to insert 
new records or view existing records only. 

Assigning Access Rights to Edit, Modify or Delete Tables

1 Select Defaults from the Edit menu and then select User Access Rights. The 
Edit User Access dialog appears. 

2 Click on LookUp to select the User you are assigning rights to.

3 Click on Edit User Permits and the User Access Rights dialog box appears. 
Find the Edit, Modify or Delete entry for the table you want and Click on Tag/
Untag to give or remove access to the user. 
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Tip: Rights to modify and delete were added to the end of the list in the Edit 
User Permits dialog. Rights to Edit retained their original position from 
previous versions of Sage DacEasy.

Selecting Form Templates

Sage DacEasy allows you to customize your forms using form templates. Sage 
DacEasy stores each form template as a separate file in the data file folder. Each 
template has an extension of .FMT. When you install Sage DacEasy, a template 
is assigned to each form.

You can change the format file, if necessary. You can create as many different 
templates for each form as you need to satisfy different printing situations. The 
following steps explain how to select an existing form template. For information 
on editing form templates, refer to the Help topic “Editing templates.”

Related Help Topics

• Editing templates

• Copying existing form templates

• Template variables

• Default form templates

• Modifying templates for 7-inch forms

• Modifying form templates for laser printers

To Select a Form Template

1 Select Defaults from the Edit menu, and then select Forms Setup. The Edit 
Forms Setup dialog box appears. Click Help from the Edit Forms Setup 
dialog box for a detailed description of each field.

Enter form preferences on
the Edit Forms Setup dialog

box.
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2 Select any form.

3 Click Names. The Format File Names dialog box appears.

4 Select the format file you want to change.

5 To create a new template, type a new name. To select an existing template, 
type the template name or click LookUp and select the template.

Tip: Click Options and select Copy Format to make a copy of an existing 
template.

6 Click OK to save the selection and return to the Edit Forms Setup dialog 
box.

7 Complete each field on the Edit Forms Setup dialog box.

8 Click OK to save the form settings.

Note: If you entered a new form name, you must create the form template. 
Refer to the “Editing templates” topic in the Help for more information.

Incorporate Images to Reports and Forms

Strengthen your company’s image and branding with more professional looking 
forms and reports. Now you may include your company logo on reports and 
forms. In addition, this feature may reduce your company’s expense of 
purchasing forms with your company logo pre-preinted. Simply setup a bitmap 
image of your company Logo on the Company Information Dialog of each Sage 
DacEasy Module and indicate that you want this image to be printed in the 
header of all reports. You can also print the logo in your forms by adding the 
variable {LOGO} to your form templates. Sage DacEasy supports .bmp, .jpg, 
and .gif bitmap extensions. 

Select a template for each
form on the Format File

Names dialog box.
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Setting the Company Logo

1 Select Defaults from the Edit menu and then select Company Information. 
The Company Information dialog box appears.

Note: The blank placeholder for the Company logo bitmap displays the 
message “Click here to select an image.”

2 Click on the bitmap placeholder and the bitmap selection dialog box appears.

Note: Sage DacEasy copies Bitmaps into an Images folder located inside the 
company’s data folder when doing a company backup, this folder is included. 
This folder is the default when the bitmap selection dialog box appears. You 
may locate the bitmap in other folders in your desktop or network or click OK 
to copy it to the Images folder.

3 Enter the path of the folder where the bitmap is located. If necessary, click on 
the button to the right of the folder field to find the bitmap in your desktop 
or network. The bitmap appears in the dialog box image placeholder. 

4 Click OK to associate the bitmap to the Company Information. The bitmap 
appears as a thumbnail in the Company Information dialog box.

5 Click Remove Image to disassociate an exiting bitmap from the Company 
Information, or Cancel to stop this operation and exit the bitmap selection 
dialog.  (in the Figure 3-6 screen reads Without Image, not Remove Image)

6 Click on the Print bitmap on reports check box if you want the company 
logo to appear in all report headers. 

Note: The Print bitmap on reports check box must be marked to have the 
logo print on report headers.

7 Click OK to save the Company Information.
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Adding LOGO variable to form templates

In addition to the report header, Sage DacEasy allows you to print your 
company logo on the header of your customized forms. You can position the 
company logo horizontally across the form header. 

Note: The LOGO will always print at the top of the form positioned horizontally 
on the same column where the variable is placed in the template.

1 Select Defaults from the Edit menu and then select Forms Setup. The 
Forms Setup dialog box appears.

2 Select the form that you want to place the logo on from the form dropdown 
box. 

3 Click on Edit and the template editor will appear with the default template 
for the form you selected.

4 Position the cursor on the first row of your form template and Click on 
LookUp and then click on Control.  A LookUp of the Control variables 
appears. 

5 Select the variable LOGO from the LookUp and press ENTER to paste it unto 
the form template. 

6 Click OK to save the template and Close to return to the menu.

Printing Forms with Company Logo

Printing any form containing the LOGO variable in its template will print the 
Company Logo image setup in the Company Information dialog. 

Note: It is not necessary to enable the Print bitmap on reports check box in 
Company Information to have the LOGO display in your forms. 
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Invoice with Company Logo

Related Help Topics

• Editing templates

• Copying existing form templates

• Template variables

• Default form templates

• Modifying templates for 7-inch forms

• Modifying form templates for laser printers

• How do I set up a 40 column receipt printer?
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Setting Up Table Information

Setting up table information includes methods of payment, messages, price 
breaks, shipping methods, terms, tax, salespeople, warehouses and weight units. 
If Sage DacEasy Order Entry is interfaced with Sage DacEasy Accounting, Sage 
DacEasy Order Entry pulls this information from the accounting data files. If 
you are running Sage DacEasy Order Entry as a stand alone program (Order 
Entry is not interfaced with Sage DacEasy Accounting), set up the table 
information to help speed up entering customers and orders.

Setting Up Methods of Payment

For your convenience, Sage DacEasy Order Entry stores all the methods of 
payment you accept on orders. This is helpful, since the method of payment 
typically varies from order to order and customer to customer. Use this table to 
enter all of your acceptable methods of payment, and then use the LookUp on 
the Order Entry dialog box to select the method of payment for the order.

You can enter a default method of payment on the System Preferences dialog 
box. The default method of payment appears automatically on the Order Entry 
dialog box. If you select a default method of payment, it helps decrease the 
amount of data entry time, since you do not have to select a method of payment 
for every order. You can edit the default method of payment on each order entry 
transaction if necessary. If you did not select a default method of payment on 
the System Preferences dialog box, then you must enter a method of payment 
manually for every transaction. 

Related Help Topic

• Deleting methods of payment
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To Add or Edit a Method of Payment

1 Point to Tables on the Edit menu, and then select Method of Payment. The 
Edit Method of Payment dialog box appears. Click Help for more 
information on each field.

2 Type a code to identify the method of payment. If you are editing an existing 
method of payment, type the code or click LookUp and select a code from 
the list that appears.

3 Type the description and account number updated when this method of 
payment is used and select whether or not you want to verify this method of 
payment online.Services for check verification type is not supported at this 
time.

4 Type the Merchant ID and Merchant Key assigned to you by Sage Payment 
Solutions.

5 Click OK to save the method of payment. Click Close to exit the dialog box.

Setting Up Messages

Sage DacEasy Order Entry includes messages that display text you commonly 
use in your everyday order entry tasks. You can use message codes in the 
following ways:

• Enter a message code in the body or footer of an order or quote and the 
message appears on the printed form.

• Enter a message code on a customer record and the message appears 
when a transaction is entered for the customer.

• Add a message code to a product or service record using the Sales 
Assistant. The message appears when the product is added to a 
transaction.

Use the Edit Method of
Payment dialog box to add

or edit a method of
payment.
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Related Help Topics

• Using the sales assistant

• Deleting messages

To Add or Edit a Message

1 Point to Tables on the Edit menu, and then select Messages. The Edit 
Message Code dialog box appears.

2 Type a code to identify the message. If you are editing an existing message, 
type the code or click LookUp and select a code from the list that appears.

3 Type up to three lines of text for the message.

4 Select whether or not you want the message to be the default footer message 
for invoices. This indicates the selected message prints at the bottom of all 
invoices. You can only select one message as the default footer.

5 Click OK to save the information. Click Close to exit the dialog box.

Setting Up Price Break Tables

You can establish several different levels of pricing at which you sell your 
products. Many businesses sell to different types of customers such as 
wholesalers, retailers and dealers.

Each of these types of customers can fall into a different level of pricing, 
depending on the quantity purchased for each product. You can assign each 
product up to six groups of quantity price breaks that represents separate 
pricing to different customer groups. There are six different customer groups 
available on the Edit Customer dialog box.

Use the Edit Message Code
dialog box to add or edit a

message.
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You can offer a price break discount depending on the quantity of items a 
customer purchases, or give a fixed percentage or dollar amount off the sales 
price of the item or reassign a new sales price to the item for a certain customer. 
Each quantity price break table allows five price break levels listing the quantity 
the customer must purchase in order to receive a particular percentage 
discount. On the Edit Product dialog box, you can assign a price break table 
code to six customer groups. 

Related Help Topic

• Deleting price break tables

To Add or Edit a Price Break Table

1 Point to Tables on the Edit menu, and then select Price Breaks. The Edit 
Price Break dialog box appears. Click Help for more info on each field.

2 Type a code to identify the price break. If you are editing an existing price 
break, type the code or click LookUp and select a code from the list that 
appears.

3 Type a description for the price break. 

4 Choose one of the following types of price break tables for this discount.

Quantity—A percentage discount is given based on quantity sold.

Percentage—A percentage discount is given regardless of the quantity sold.

Dollar—A specified dollar amount is taken off of the regular sales price 
regardless of the quantity sold.

Use the Edit Price Break
dialog box to add or edit

price breaks.
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Flat Price—The product is sold at the specified discounted price.

5 Select the rounding method used if the new sales price is a calculated 
amount.

6 If you selected Quantity in the Type field, type the appropriate discount(s) in 
the Quantity Table. If you selected Percentage, Dollar or Flat Price in the 
Type field, type the appropriate discount in the Amount field in the 
Percentage/Dollar/Price area.

7 Click OK to save the price break table. Click Close to exit the dialog box.

Note: After adding the price break, be sure to set up the price groups for your 
customers on the Edit Customer dialog box and the price break groups for 
the products on the Edit Product dialog box.

Setting Up Shipping Methods

You can add a shipping method for each method you want to use on orders and 
invoices. You can also add this shipping method to alternative addresses.

Related Help Topic

• Entering a shipping method on a transaction

• Deleting shipping methods

To Add or Edit a Shipping Method

1 Select Tables on the Edit menu, and then select Shipping Method. The Edit 
Shipping Method dialog box appears. Click Help for a detailed description 
of each field. 

Note: You can also add shipping methods on-the-fly in many areas of the 
program. When this feature is available, the Add button is active from the 
Ship Via field. Click Add and the Edit Shipping Method dialog box appears.

2 Type a code to identify the shipping method you are adding. If you are editing 
an existing shipping method, type the code or click LookUp to select the 
code from a list.

3 Complete each field.

4 Click OK to save the shipping method.

Note: fter adding the code to the shipping methods table you can click 
LookUp from the Ship Via field on the General tab of the Order Entry 
dialog box to record the method of shipping used for the order.
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Setting Up Terms Tables

Sage DacEasy Order Entry uses the terms table to determine due dates and 
discount dates for orders and invoices. You define the parameters for each term, 
and then assign the term to a customer or order.

Related Help Topic

• Deleting terms tables

To Add or Edit a Terms Table

1 Point to Tables on the Edit menu, and then select Terms. The Edit Terms 
Code dialog box appears. Click Help for a detailed description of each field. 

2 Type the code and description for the term. If you are editing an existing terms 
table, you can click LookUp to select an existing terms table.

3 Select the Type.

Select Number of Days to add a specific number of days to the transaction 
date in order to calculate the discount and due date.

Select Day of Month to specify a day of the month on which the discount 
and due date always fall.

4 Type the percentage amount in the Discount % field if a discount for early 
payment is offered.

5 If you selected Number of Days in the Type field, type the number of days in 
the Discount Day(s) field.

If you selected Day of Month, type the day of the month in this field or L to 
make the discount day the last day of the month.

6 If you selected Number of Days in the Type field, type the number of days in 
the Due Day(s) field.

Use the Edit Terms Code
dialog box to add and edit

terms codes.



Setting Up Table Information
Setting Up Tax Tables

73

4
If you selected Day of Month, type the day of the month or L to make the due 
day the last day of the month. 

7 If Day of Month is selected in the Type field, type the last day of your billing 
cycle in the Closing Day field. For example, if you end your billing cycle on the 
fifth of each month, type 5 as the closing day. Type L to assign the last day of 
the month as the closing day.

8 If Day of Month is selected in the Type field, the due and discount day are a 
certain day every month. Select the Next Month check box if you want that 
day to be in the following month.

For example, assume your system date is June 9, your due day is 10 and your 
closing day is 15. If you clear this check box and enter an order, the due date 
is July 10 (the first 10th day of the month after the closing date). If you select 
this check box and enter an order, the due date is August 10 (the second 
occurrence of the 10th day of the month after the closing date).

9 Click OK to save the terms table.

Setting Up Tax Tables

When you enter orders, Sage DacEasy Order Entry calculates a sales tax amount 
for each transaction. Sage DacEasy determines the sales tax amount by 
multiplying the sales tax percentage by the total amount of all taxable items on 
the transaction.

The Sales Tax field at the bottom of the Order Entry dialog box displays the sales 
tax amount for each transaction. Sage DacEasy updates this amount online as 
you add items to the transaction.

To correctly calculate sales tax in Sage DacEasy Order Entry, you must perform 
these three tasks before entering transactions:

• Set up a tax rate table that identifies the tax rate structure. If you are 
interfaced with Sage DacEasy Accounting, you will also assign the 
general ledger account(s) to update when you post transactions. The 
number of tax tables you can set up is unlimited. Most businesses only 
need one tax table; however, if you do business in many different tax 
jurisdictions, you will need to set up a separate table for each tax rate.

• Assign a tax table to each new customer you set up by entering the tax 
table code in the Tax Table field on the Edit Customer dialog box.

• On the Edit Product, Edit Service and Edit Billing Code dialog boxes, 
indicate whether or not each item is taxable. Do this by selecting the 
Taxable check box if the item is subject to tax.
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Related Help Topic

• Deleting tax tables

To Add or Edit a Tax Table

1 Point to Tables on the Edit menu, and then choose Tax. The Edit Tax Table 
dialog box appears. Click Help for more info on each field.

2 Type a code to identify the tax. If you are editing an existing tax, type the code 
or click LookUp to select the tax from the list that appears.

3 Type a description and sales tax rate for the tax table.

Note: If your tax dialog box does not look like the one shown in Figure 4-11, 
you are running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting and using the tax tables from the accounting data files. For more 
information on the Sage DacEasy Accounting tax tables, refer to your Sage 
DacEasy Accounting User Guide or click Help.

4 Select the Tax Freight check box if this tax applies to the total freight charge 
in the footer of the Order Entry dialog box. If tax does not apply, clear this 
check box.

5 Click OK to save the table. Click Close to exit the dialog box.

To View a Tax Table’s History

Sage DacEasy Order Entry tracks period-by-period sales tax history for each tax 
table. Sage DacEasy maintains up to two years of balance history for total taxable 
sales and sales tax billed. 

1 Point to Tables on the Edit menu, and then select Tax. The Edit Tax Table 
dialog box appears. 

2 Type the code of the tax table you want. If you do not know the code, click 
LookUp to select the table from a list. The selected tax table appears.

Use the Edit Tax Table
dialog box to add and edit

tax tables. If you are
interfaced with Sage

DacEasy Accounting, the
Accounting Edit Tax Table

dialog box appears.
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3 Click Options, and then select Sales History. The Sales Tax History dialog 

box appears. Click Help for more info on this dialog box.

4 Click OK to save the Sale Tax History dialog box. Click Close to exit the 
dialog box.

Setting Up Salespeople

With Sage DacEasy Order Entry, you can build a file containing the codes and 
names of your sales staff. To track sales for each salesperson, select the Track 
Salesperson Information check box on the System Preferences dialog box and 
the order entry clerk must assign a salesperson code to each order if one is not 
already assigned to the customer. When printing the Sales Order report, you can 
sort the information by salesperson. This helps identify your sales leaders.

Sage DacEasy includes a Sales Analysis report that stores historical sales 
information (subtotaled by product, customer or salesperson). Use the Sales 
Analysis by Salesperson report at the end of the period or year to determine your 
top salespeople.

Related Help Topic

• Deleting salespeople

• Sending an e-mail

Use the Sales Tax History
dialog box to view the

history for the tax table.
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To Add or Edit a Salesperson

1 Point to Tables on the Edit menu, and then select Salesperson. The Edit 
Salesperson dialog box appears. Click Help for more info on each field. 

2 Type a code to identify the salesperson. If you are editing an existing 
salesperson, type the salesperson code or click LookUp to select the 
salesperson from the list that appears.

3 Type the employee’s name, e-mail address, number, territory, commission rate 
and amount.

4 Click OK to save the salesperson. Click Close to exit the dialog box.

To View a Salesperson’s History

To track sales for each salesperson, select the Track Salesperson Information 
check box on the System Preferences dialog box and the order entry clerk must 
assign a salesperson code to each order if one is not already assigned to the 
customer. 

1 Point to Tables on the Edit menu, and then select Salesperson. The Edit 
Salesperson dialog box appears.

2 Type the code of the salesperson you want. If you do not know the code, click 
LookUp to select the code from a list. The selected salesperson appears.

3 Click Options, and then select Sales History. The Salesperson History 
dialog box appears. Click Help for more info.

4 Click OK to save the Salesperson History dialog box. Click Close to exit the 
dialog box.

Use the Edit Salesperson
dialog box to add and edit a

salesperson code.
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Setting Up Warehouses

With Sage DacEasy Order Entry, you can use multiple warehouses. You can 
track inventory stored in different warehouses by assigning each item to a 
product code, and then including these items and their warehouses on the Edit 
Master Items dialog box. For more information on the master items, refer to 
“Setting Up Master Item Information” on page 81.

Related Help Topic

• Deleting warehouses

To Add or Edit a Warehouse

1 Select Tables from the Edit menu, and then select Warehouses. The Edit 
Warehouse dialog box appears. Click Help for a description of each field.

2 Type a code to identify the warehouse. If you are editing an existing 
warehouse, enter the warehouse code or click LookUp to select the 
warehouse from the list that appears.

3 Complete all applicable fields.

4 Click OK to save the warehouse.

Setting Up Weight Units

You can assign codes to weight units, and then specify product weights based on 
these units. You can also view the total weight of items on orders and quotes 
based on any weight unit. 

Related Help Topic

• Deleting weight units

To Add or Edit a Weight Unit

1 Select Tables from the Edit menu, and then select Weight Units. The Edit 
Weight Unit dialog box appears. Click Help for a description of each field. 

2 Type a code to identify the weight unit. If you are editing an existing weight, 
enter the code or click LookUp and select the weight unit from the list that 
appears.

Note: Gm is a protected code. You cannot edit the Gram equivalent. 

3 Type a description for the weight unit. 
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4 Type the number of grams it takes to equal one of the weight unit. 

5 Select the Default check box if this is the default unit of measure. 

6 Click OK to save the weight unit.

Setting Up Other Information
If you use Sage DacEasy Order Entry as a stand alone program (meaning Order 
Entry is not interfaced with Sage DacEasy Accounting), you need to set up 
certain information before you enter any transactions. The steps in this chapter 
explain how to set up your customers, master items, products, promotional 
prices, services, billing codes and serial numbers. If you are interfacing Sage 
DacEasy Order Entry with Sage DacEasy Accounting, you can set up all this 
information in Sage DacEasy Accounting also, with the exception of the 
promotional prices.

Setting Up Customer Information

The Customer module holds a variety of information about each of your 
customers. After you enter a customer, you can access that customer’s 
information when entering orders. Sage DacEasy updates current and historical 
balances for the customer when you post shipments.

You can add a new customer in one of two ways: (1) add the customer on the 
Edit Customer dialog box prior to entering a transaction or (2) add the 
customer using the on-the-fly feature while entering a transaction. 

If you are interfacing Sage DacEasy Order Entry with Sage DacEasy Accounting, 
you can add and edit your customers in either of the two programs. If you view 
your customers in Sage DacEasy Accounting, you have the option to 
automatically create an invoice for the customer directly from the Edit 
Customer dialog box.

Related Help Topics

• Deleting customers

• Using the phone dialer

• Adding and editing customer alternative addresses

• Deleting customer alternative addresses

• Changing customer codes

• Attaching notes to customer records

• Changing the note file name

• Entering global changes
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• Sending an e-mail

To Add or Edit a Customer

1 Choose Customers from the Edit menu. The Edit Customer dialog box 
appears. Click Help for more information on each field.

Required fields when adding a customer are the Code, Tax Table and Terms 
Table. The GL department is also required if you are running Sage DacEasy 
Order Entry interfaced with Sage DacEasy Accounting and you are 
departmentalizing by customer. You can complete the remaining fields in 
order to track additional customer information.

2 Type a code to identify the customer. If you are editing an existing customer, 
type the customer code or click LookUp to select the customer from the list 
that appears.

3 Complete the fields on the Address tab.

4 Click the Account tab and make your selections for each option.

5 Click the Custom tab and enter any custom information you want to track.

6 Click OK to save the customer. The customer information clears ready for you 
to enter the next customer.

7 Click Close to exit the dialog box.

Use the Edit Customer
dialog box to add and edit

customers.
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To Enter a Customer Setup Balance

When you enter a new customer, you can also enter a setup balance for the 
customer. If you are setting up an existing company, some of the customers may 
have outstanding balances. Only use this procedure to enter beginning setup 
balances for customers, not for entering daily transactions. 

If you are running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, refer to your Sage DacEasy Accounting documentation for more 
information on setup balances. 

1 Choose Customers from the Edit menu. The Edit Customer dialog box 
appears. 

2 Type a new customer code if adding a customer or click LookUp to select an 
existing customer from a list.

3 Click Options, and then select Date. The Enter Date dialog box appears. It is 
important the program date is correct when entering setup balances. This 
ensures your account balances are correct on your financial reports. Type the 
correct date and click OK to save the program date.

4 Click Options, and then select Balance. The Customer Setup Balance 
dialog box appears. Click Help for more information on each field.

5 Type the invoice number, date and amounts in the appropriate fields. Repeat 
until all necessary invoices, debits and credits are entered.

6 Click OK to save the setup balance and return to the Edit Customer dialog 
box.

Related Help Topic

• Adjusting customer setup balances

Use the Customer Setup
Balance dialog box to enter

your customers’ setup
balance.
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To View a Customer’s History

Sage DacEasy tracks up to three years of historical information for customers. 
You can view this information and edit the fields if necessary.

1 Choose Customers from the Edit menu. The Edit Customer dialog box 
appears.

2 Type the code of the customer you want. If you are not sure of the customer 
code, click LookUp to select the code from a list. The customer’s information 
appears.

3 Click Options, and then select Historical. The Customer Historical 
Information dialog box appears. Click Help for more info on each field.

4 If necessary, make any edits to the fields in the Year Before Last (YBL), Last 
Year (LY), First Year Year To Date (1st YR YTD) or Budget columns.

5 Click OK to save the information and return to the Edit Customer dialog 
box.

Related Help Topic

• Viewing customer transaction history 

Setting Up Master Item Information

If you have multiple warehouses or want to create a multilevel inventory 
structure, add a master item for each primary product you sell. Then, associate 
each detail item with the master item. You can print reports based on master 
items and warehouses. You can also use the Generate Items feature to 
automatically generate a product code for each warehouse.
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To Add or Edit a Master Item

1 Select Master Items from the Edit menu. The Edit Master Item dialog box 
appears. Click Help for a detailed description of each field.

2 Type a code to identify the master item. If you are editing an existing master 
item, type the master item code or click LookUp to select the master item 
from the list that appears.

3 Complete the applicable fields on the General tab.

The Purchase Fraction and Sales Fraction are required.

If you are interfaced with Sage DacEasy Accounting and your 
departmentalization method on Sage DacEasy Accounting’s Account 
Interface dialog box is Inventory, the GL Department field is also required.

4 Click the Billing tab, and then complete each applicable field on this tab.

5 Click the Detail Items tab, and then add each detail item using any of the 
following methods.

Generate Items—Click Generate Items and a new detail item is added to 
the Master Item file and the Product file for each warehouse. The Item 
Number defaults to the master item code, followed by a dash, and then the 
warehouse code.

Tip: Click Options and then select Item Code Defaults to change the 
default naming convention.

Select an existing item—Type an existing product code or click LookUp to 
select the product.

Add a new detail item—Type a product code that does not exist and Sage 
DacEasy adds the new detail item to the Product file when you advance to the 
next line. The detail item defaults to the same setup as the master item.

Add master items and
assign detail items from the
Edit Master Item dialog box.



Setting Up Other Information
Setting Up Product Information

83

4
If you don’t want to add the new item using the master item defaults, you 
can set up your products prior to entering your master items. For more 
information on adding products, refer to the following section titled “Setting 
Up Product Information.”

Generate an item for a warehouse—Click LookUp, and then select 
Warehouses for the file to view. Sage DacEasy adds the new detail item to 
the Master Item and the Product file for the selected warehouse. The Item 
Number defaults to the master item code, followed by a dash, and then the 
warehouse code.

The detail items and the master item must have the same Purchase and Sales 
Fractions.

6 Click OK to save the master item record.

Setting Up Product Information

With the Product module, you can keep track of the items you sell. Using Sage 
DacEasy Order Entry to track your inventory helps you maintain adequate 
inventory stock levels, and compile historical information about the sales 
activity for each product.

You can add a new product in one of two ways: (1) add the product using the 
Edit Product dialog box before you enter a transaction or (2) add the product 
using the on-the-fly feature while entering a transaction. 

If you are interfacing Sage DacEasy Order Entry with Sage DacEasy Accounting, 
you can add and edit your products in either of the two programs.

Note: For complete inventory tracking you must run Sage DacEasy Order Entry 
interfaced with Sage DacEasy Accounting. This allows you to track both the 
purchase and sale of items. Running Sage DacEasy Order Entry stand alone only 
allows you to track the sale of items.

Related Help Topics

• Deleting products

• Adding and editing component lists

• Entering substitute products

• Changing product codes

• Printing a bill of materials

• Using the sales assistant

• Attaching notes to product records

• Changing the note file name
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• Changing the serial number tracking status

• Entering global changes

To Add or Edit a Product

1 Select Products from the Edit menu. The Edit Product dialog box appears. 
Click Help for a detailed description of each field. 

2 Type a code to identify the product. If you are editing an existing product, 
type the product code or click LookUp to select the product from the list that 
appears.

3 Type a description for the product, and then complete each applicable field on 
the General tab.

If you are interfaced with Sage DacEasy Accounting and your 
departmentalization method on the Account Interface dialog box in Sage 
DacEasy Accounting is Inventory, the GL Department field is required.

4 Click the Purchasing tab, and then complete each applicable field.

The Fraction field is required.

5 Click the Sales tab, and then complete each applicable field.

The Fraction field is required.

6 Click the Billing tab, and select your preferences.

7 Click the Custom tab and enter any custom information you want to track.

8 Click OK to save the product record.

Enter new products or edit
product information from

the Edit Product dialog box.
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You cannot edit the amounts in the footer area below the tabs. This area is 
updated when you enter a setup balance for the product or post transactions 
that include the product.

Entering Product Setup Balances

When you enter a new product, you can also enter a setup balance for the 
product. If you are setting up an existing company in Sage DacEasy, you 
probably already have inventory on hand. Use the Product Setup Balance 
feature to enter the number of units and inventory cost on hand for the product. 
Only use this procedure to enter beginning set up balances for products, not for 
entering daily transactions. 

If you are running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, refer to your Sage DacEasy Accounting documentation for more 
information on setup balances. If you are not running Sage DacEasy Order Entry 
interfaced with Sage DacEasy Accounting, use the setup balance or Inventory 
Adjustments to enter inventory into Sage DacEasy Order Entry. 

To Enter a Product Setup Balance

1 Choose Products from the Edit menu. The Edit Product dialog box appears. 
Click Help for more  on each field.

2 Type a code to identify the product. If you are editing an existing product, 
type the product code or click LookUp to select the product from the list that 
appears.

3 Click Options, and then select Date. The Enter Date dialog box appears. It is 
important the program date is correct when entering setup balances. This 
ensures your account balances are correct on your financial reports. Type the 
correct date and click OK to save the program date.

4 Click Options, and then select Balance. The Setup Stock Balance dialog 
box appears.



Setting Up
Sage DacEasy Order Entry User’s Guide

86

4
5 Type a reference for the setup balance transaction, and then type the number 

of units and unit cost. The total dollar amount appears in the Dollars field.

6 Click OK to save the setup balance and return to the Edit Product dialog 
box.

Related Help Topic

• Adjusting product setup balances

To View a Product’s History

Sage DacEasy tracks up to three years of historical information for products. 
You can view this information and edit the fields if necessary.

1 Choose Products from the Edit menu. The Edit Product dialog box appears.

2 Type the code of the product you want. If you are not sure of the product 
code, click LookUp to select the code from a list. The product’s information 
appears.

3 Click Options, and then select Historical. The Product Historical 
Information dialog box appears. Click Help for more info on each field.

4 If necessary, make any edits to the fields in either the Year Before Last (YBL), 
Last Year (LY), First Year Year To Date (1st YR YTD) or Budget columns.

5 Click OK to save the information and return to the Edit Product dialog box.

Related Help Topic

• Viewing product transaction history

Product Illustration

This feature allows you to incorporate illustrations of products in the Products 
Maintenance dialog in order to easily identify items when needed. Now you can 
view an image of each product which can reduce mistakes when ordering or 
selling products that have similar descriptions and price.  With this powerful 
improvement your employees can visually identify a product when they are 
making changes to that product’s attributes. 
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To Set Up a Product Illustration

1 Select Products from the Edit menu and the Edit Products dialog appears. 

2 Click on LookUp to select the Product to edit or enter a new Product code to 
add a new one.

3 Click on the image placeholder and the bitmap selection dialog appears. 

Note The blank placeholder for the product image displays the message 
“Click here to select an image.” Sage DacEasy copies Bitmaps to the Images 
folder that it creates inside the company’s data folder. The Backup function in 
all modules includes this folder when doing a company backup. This folder is 
the default when the bitmap selection dialog box appears. You may locate the 
bitmap in other folders in your desktop or network and Click OK to copy it to 
the Images folder.

4 Enter the path of the folder where the bitmap is located. If necessary, click on 
the button to the right of the folder field to find the bitmap in your desktop 
or network. The bitmap appears in the dialog box image placeholder. 

5 Click OK to associate the bitmap to the Product. The bitmap appears as a 
thumbnail in the Edit Product dialog.

6 Click Remove Image to disassociate an exiting bitmap from the Product 
Information, or Cancel to stop this operation and exit the bitmap selection 
dialog.

7 Click OK to save the Product Information.
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Setting Up Promotional Price Information

The Promotional Price feature lets you enter special sales prices that are valid for 
a certain range of dates. If you are offering a sale on specific items for one week, 
enter the special sales price you want for that week on the promotional price 
transaction. In order for the promotional prices to appear on the sales 
transaction, the transaction date must be within the date range entered on the 
promotional price transaction.

Related Help Topic

• Deleting promotional prices

To Enter a Promotional Price Transaction

1 Choose Promotional Price from the Edit menu. The Edit Promotional 
Price dialog box appears. Click Help for more information on this dialog box.

2 Sage DacEasy Order Entry assigns the transaction number. Type the date the 
sale begins and ends in the appropriate fields.

3 Select how you want the products to be grouped when assigning the 
promotional prices using the Group By field. If you select Product, Vendor or 
Dept., type the range in the From Code and To Code fields.

4 Type a description of the promotional price transaction in the Description 
field. This is usually the name of the sale, for example, White sale.

5 Select a method of discounting the product’s normal sale price in the Discount 
field.

Use the Edit Promotional
Price dialog box to enter

your special sales price
during a specific range of

dates.
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6 Type the flat dollar amount you want discounted off the product’s normal 

sales price in the Amount/Percentage field if you selected Flat in the Discount 
field.

Type the percentage you want deducted from the product’s normal sale price 
in the Amount/Percentage field if you selected Percent in the Discount field.

7 Select the Default to Lowest Price check box if you want Sage DacEasy to 
check for price breaks. If a customer eligible for a price break can get a lower 
price due to the price break discount, the customer is charged the lower price 
rather than the promotional price amount.

8 When you access the body of the Edit Promotional Price dialog box, all 
selected products appear.

9 If you selected Price in the Discount field. Type the sales price you want 
during the promotional price period in the Promo Price column.

If you selected Flat or Percent in the Discount field, Sage DacEasy 
automatically calculates the new sales price and it appears in the Promo Price 
column. You can edit the Promo Price if necessary.

10 Click OK to save the promotional prices. Click Close to exit the dialog box.

Setting Up Service Information

The Service module lets you track the sale of your services to customers. You can 
let Sage DacEasy Order Entry track the sales of your services and compile 
historical information about the sales activity for each service.

You can add a new service in one of two ways: (1) add the service using the Edit 
Service dialog box before entering a transaction or (2) add the service using the 
on-the-fly feature while entering transactions. 

Related Help Topics

• Deleting services

• Changing service codes

• Using the sales assistant

• Attaching notes to service records

• Changing the note file name
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To Add or Edit a Service

1 Choose Services from the Edit menu. The Edit Service dialog box appears. 
Click Help for a detailed description of each field. 

2 Type a code to identify the service. If you are editing an existing service, type 
the service code or click LookUp to select the service from the list that 
appears.

3 Click the Sales tab, and then complete each applicable field.

The Fraction field is required.

4 Click the Custom tab and enter any custom information you want to track.

5 Click OK to save the service. The information clears ready for you to enter the 
next service.

6 lick Close to exit the dialog box.

To View a Service’s History

Sage DacEasy tracks up to three years of historical information for services. You 
can view this information and edit the fields if necessary.

1 Choose Services from the Edit menu. The Edit Service dialog box appears. 
Click Help for more information on each field.

2 Type the code of the service you want to view. If you do not know the code, 
click LookUp to select the service from a list. Information for the service 
appears.

3 Click Options, and then select Historical. The Service Historical 
Information dialog box appears. 

Use the Edit Service dialog
box to add and edit

services.
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4 If necessary, make any edits to the fields in either the Year Before Last (YBL), 

Last Year (LY), First Year Year To Date (1st YR YTD) or Budget columns.

5 Click OK to save the changes and exit the dialog box.

Setting Up Billing Code Information

Billing codes offer you a great deal of flexibility. They allow for full use of the 
Order Entry dialog box without using inventory and service items. You can 
either use these billing codes in combination with product and service codes or 
as your only means of invoicing customers. 

Many items you sell may not fall into a product or service category. A good 
example is insurance. Sage DacEasy Order Entry uses the billing codes as a 
solution to this problem. If you are running Sage DacEasy Order Entry 
interfaced with Sage DacEasy Accounting, each code updates a specific general 
ledger account. For example, you can set up a billing code for insurance to 
include this charge on an order. This billing code then updates the 
corresponding revenue account in your chart of accounts.

Related Help Topic

• Deleting billing codes

To Add or Edit a Billing Code

1 Choose Billing Codes from the Edit menu. The Edit Billing Code dialog box 
appears. Click Help for more info on each field.

2 Type a code to identify the billing code. If you are editing an existing billing 
code, type the code or click LookUp to select the billing code from the list 
that appears.

3 Type a description, account number, whether the billing code is taxable and 
whether it allows a discount. Also, select whether or not the billing code is 
commissionable and enter the price you are charging for the billing code. You 
can leave the amount blank and enter a price for the billing code when 
entering the code on an order.

Use the Edit Billing Code
dialog box to add and edit

billing codes.
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4 Click OK to save the billing code. The information clears ready for you to 

enter the next billing code.

5 Click Close to exit the dialog box.

Tracking Serial Numbers

Sage DacEasy has the ability to track serial numbers from the time of purchase 
to the time of sale. A line of history detail is added to the serial number record 
each time you enter a product or service on a transaction. You can view the 
history of a serial number from the Edit Serial Number dialog box, Serial 
Number Tracking report or custom reports using DacAccess. 

If you are running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, you can track the purchase of a serial number through the 
Purchasing module. Purchasing an item using this feature updates the Serial 
Number file. After you add the serial number, you can then view the activity of 
the serial number on the Edit Serial Number dialog box.

If you are running Sage DacEasy Order Entry stand alone, the only way to track 
the purchase of a serial number is by adding it manually using the Edit Serial 
Number dialog box. 

You can enter the serial number on an order or invoice to track the sale of a 
product or service with a serial number. After selling the item and entering the 
serial number, you can then view the sale or removal of the serial number from 
availability by using the Edit Serial Number dialog box or printing the Serial 
Number Tracking report.

Note: To track serial numbers, you must select the Serial Numbers check box 
on the Edit Product or Edit Service dialog box.

Related Help Topic

• Deleting serial numbers
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To Add a Serial Number

1 Choose Serial Numbers from the Edit menu. The Edit Serial Number 
dialog box appears. Click Help for more info on each field.

2 Type the serialized product or service code in the Code field.

3 Type the serial number in the Serial Number field and select whether or not 
the serial number is available in stock.

4 Select the type of serial number entry in the Transaction Type field.

5 Type the vendor invoice number or sales invoice number depending on the 
type of serial number entry in the Number field.

6 Type the customer who purchased the item, or the vendor you purchased the 
item from in the Customer/Vendor field.

7 Type the date of the transaction in the Date field.  

8 Select whether this entry is adding the serial number to the file or removing 
the serial number from the file.

9 Click OK to save the entry.

To Edit or View a Serial Number’s History

1 Choose Serial Numbers from the Edit menu. The Edit Serial Number 
dialog box appears.

2 Type the product or service code attached to the serial number you want to 
view or edit. If you are not sure of the code, click LookUp to select the code 
from a list.

3 View the history and make any changes to the serial number history if 
necessary.

Use the Edit Serial Number
dialog box to add, view
and edit serial numbers.
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4 Click OK to save the changes. Click Close to exit the dialog box.

Related Help Topic

• Deleting serial number history
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• Processing Orders •
This chapter covers the routines and steps you use daily in Sage DacEasy Order 
Entry. This chapter explains how to access and use the Order Entry dialog box, 
print orders, print shipping labels, ship orders, print invoices, print the Sales 
Journal and post your daily shipments.  

Using the Order Entry Dialog Box
In Sage DacEasy Order Entry, one screen accommodates all sales order 
transactions: the Order Entry dialog box. You can use this dialog box to enter 
quotes, orders, blanket orders as well as returns (RMAs, Returned Merchandise 
Authorizations).

The Order Entry dialog box consists of three tabs, the Customer, General and 
Detail tabs. The Customer tab includes the customer’s name, billing and 
shipping address and special shipping instructions. The General tab includes 
payment terms for the order. The Detail tab includes the products and/or 
services ordered by the customer.

Navigating Around the Order Entry dialog dox

Sage DacEasy has incorporated some quick navigation to help you easily move 
the cursor on the Order Entry dialog box:

• Press Enter to accept the information in the current field and move the 
cursor one field at a time. 

• Click a field with the mouse pointer to access a field on the screen.

• Click the Goto or OK button, or press F9 to advance the cursor to the 
next important field. This feature quickly moves the cursor from the 
top section of the dialog box to the Item Code field, and then to the 
Payment field.

Entering Orders, Blanket Orders and RMAs
The next section explains how to enter orders, blanket orders and returned 
merchandise authorizations (RMAs). Some other special features included in 
Sage DacEasy Order Entry are also explained in this section such as entering 
serial numbers on an order and printing quotes, orders, invoices and labels.

The most common type of transaction is an order. You create an order to 
identify products and services requested for purchase by a customer. An order 
has no affect on your stock quantities (unless you selected the Check Product 
Availability Online check box on the System Preferences dialog box) until you 
ship part or all of the merchandise on the order using the Ship Orders routine.
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A blanket order is very similar to a regular order; however, blanket orders 
usually involve large quantities that will be sent in several smaller shipments 
over a period of time. With blanket orders, Sage DacEasy does not treat items 
that are not available at the time of entry as backordered items. Additionally, the 
Backorder Status report does not include blanket orders since Sage DacEasy 
Order Entry does not check the availability of products on blanket orders until 
you ship a portion of the order.

An RMA (Returned Merchandise Authorization) or return is used when a 
customer returns products. Sage DacEasy Order Entry generates an RMA 
number for each return, which the customer should include with the returned 
merchandise. Enter the products and quantities returned the same way you 
entered the original order and use the Ship Orders routine to return the units 
back to stock. If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, type the original invoice number in the Customer 
Reference field to associate the return to the invoice. This way, the aging report 
and statements identify the sales return correctly.

Related Help Topics

• Assembling products on an order

• Using AutoReorder to sell items based on prior purchases 

• Using AutoReturn to record returns of prior customer purchases

• Viewing the total weight of items on a transaction 

• Entering products set up as assembled kits on an order

• Deleting an order, blanket order or return (RMA)

To Enter an Order, Blanket Order or Return (RMA)

Logging In to the Order Entry Dialog Box

1 Choose Order Entry from the Process menu. The Enter Orders dialog box 
appears.

2 Type the ID of the person adding orders in the Order Entry Person ID field. This 
value appears in the Order Entry Person field on the General tab of the Order 
Entry dialog box.

Use the Enter Orders
dialog box to enter the

Order Entry Person ID
and the order date.
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3 Type the current date or the date you want to assign as the order date. 

4 Click OK to view the Order Entry dialog box. Click Help for a detailed 
description of each field.

Entering Customer and General Order Information

5 Select the type of order you are entering in the Type field.

6 Type the order or RMA number if you are assigning your own numbers, 
otherwise, press Enter to let Sage DacEasy assign the number.

7 Type the customer in the Customer Code field. The customer’s address, tax, 
terms and default information appears in the corresponding fields.

8 Type the date the customer is requesting shipment of the order in the Request 
Date field.

9 Click the General tab. Compete each field as necessary.

Note: Type the original invoice number in the Customer Reference field if the 
customer is returning merchandise. When the sales return is created, the 
original invoice is credited with the amount of the return.

Entering Items on the Transaction

10 Click the Detail tab.

Use the header area (or
top portion) of the Order
Entry dialog box to enter

the customer’s
information and select

the order type.



Entering Orders, Blanket Orders and RMAs
Navigating Around the Order Entry dialog dox

99

5

11 Type the item number for the product, service, billing code or message in the 
Item Number field. The corresponding description and sales price appear.

12 Type the number of items requested from the customer in the Ordered field. If 
a customer is returning merchandise, type the number of items returned in 
the Ordered field.

13 Type the number of items that will be shipped in this shipment. 

Note: If you selected the Check Product Availability Online check box on 
the System Preferences dialog box, Sage DacEasy calculates the number of 
backordered items and displays the number in the Backorder field. If you are 
not using the Check Product Availability Online option, Sage DacEasy places 
the number of items ordered automatically in the Backorder field.

14 Change the sales price if necessary. 

15 Type the discount percentage amount in the Discount field if you are giving 
the customer a line item discount on this item.

16 Continue to enter each item on the order until all items are added.

Entering a Payment, Freight and Saving the Transaction

17 Click OK. The cursor advances to the bottom section of the Order Entry 
dialog box.

18 Select the method of payment if necessary.

19 Type the freight amount, and then type the dollar amount paid by the 
customer.

Use the Detail tab on the
Order Entry dialog box
to enter the items the

customer has requested.
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20 Click OK to save the order. If you selected the Print Orders After Entry 

check box on the System Preferences dialog box, you can print the order 
after you save the order.

Viewing Item Sheets

An Item Sheet is a detailed report listing all products entered on the Detail tab 
of the Order Entry dialog box. The Item Sheet also provides information about 
the product, including the product code, inventory type, the number of units 
ordered by the customer, the number of units currently available and valuable 
costing and profit amounts. Services and billing codes on the order are not 
included on the Item Sheet.

To View an Item Sheet on an Order

1 Enter an order as you would normally and click the Detail tab on the Order 
Entry dialog box.

2 Type each item requested by the customer on the order.

3 Click Options, and then select Item Sheet. The Item Sheet appears on the 
screen.

4 Click Print to print the Item Sheet. Click Close to return to the Order Entry 
dialog box.

Viewing Substitute Products 

If there are not enough units of the needed product in stock to fill an order and 
you do not ship partial orders, you cannot ship the order to the customer until 
you receive more units of the product. If you have set up substitute products for 
the item, you can suggest the substitute product in place of the requested 
product. Set up substitute products on the Edit Product dialog box by clicking 
Options, and then selecting Substitute Products. 

To View Substitute Products for an Item on an Order

1 Enter an order as you would normally and click the Detail tab on the Order 
Entry dialog box.

2 Type each item requested by the customer on the order. If the items appear on 
backorder, return to the Item Number field.

3 Click Options, and then select Substitute Products. A list of substitute 
products appears.



Entering Orders, Blanket Orders and RMAs
Entering Serial Numbers on Orders

101

5
If you can send a substitute product in place of the original item, select the 
substitute product from the list.

4 Continue to enter and save the order as you would normally.

Entering Serial Numbers on Orders

When you select the Serial Numbers check box for a product or service, you can 
record the serial number for the item when it is sold. The selections you made 
on the System Preferences dialog box determine when you record the serial 
numbers. If you selected Orders for the Enter Serial Numbers When option on 
the System Preferences dialog box, you record serial numbers when entering the 
item on an order. Otherwise, you record serial numbers for the items when 
shipping the order. 

Note: If you are entering a return and the customer needs to return products 
with serial numbers, follow the steps below, but select Return as the Type on the 
transaction.

To Enter Serial Numbers on an Order

1 Enter an order as you would normally and click the Detail tab on the Order 
Entry dialog box.

2 Type the code of a serialized product or service in the Item Number field.

3 Type the quantity ordered, number of units shipped and the sales price. The 
Enter Serial Numbers dialog box appears.

4 Type the serial number of the product or service. You can enter a serial 
number for each item being sold or for each component of a finished good. 
The product or service code that appears associated with the serial number 
defaults to the code entered in the Item Number field. You can change the 
code if necessary.

Tip: While in the Serial Number field, you can click LookUp to view a list of 
available serial numbers. A serial number is available if the corresponding 
product has been received into inventory and the serial number was entered 
at that time.

5 Click OK to save the serial numbers.

6 Continue to enter and save the order as you would normally.
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Changing the Status of Orders

Every order is assigned a status that falls into one of six categories. The status of 
an order appears in the upper right corner of the Order Entry dialog box. When 
you first enter an order, it has no status until the order is saved. Once the order 
is saved, the status is New. If you ship part of the order, the status of the order 
changes to Backorder. If you ship an entire order, the status changes to 
Complete. The other two status choices allow you to Hold or Cancel an order if 
necessary. By holding an order, you temporarily do not want any activity with 
the order. By canceling an order, you are indicating that you want to 
permanently disallow shipment of the remaining items on the order. After you 
cancel an order, you cannot ship it or reverse the status of the order.

An order on hold cannot be edited or shipped. Here are some common 
examples of why you will place an order on hold:

• When you perform a lengthy credit history check on a customer.

• When you want to halt shipment of an order until payment is received 
for the last shipment the customer received.

To Change the Status of an Order

1 Choose Order Entry from the Process menu. The Enter Orders dialog box 
appears. Log in to the Order Entry dialog box.

2 Type the number of the order you want to place on hold, cancel or backorder. 
If you are not sure of the number, click LookUp to select an order from a list. 

3 Click Options, and then select Order Status. The Status Selection dialog 
box appears.

Note: You cannot change the status of an order from the Detail tab on the 
Order Entry dialog box.

4 Select Hold to place an order on hold. If you want to cancel the order, select 
Cancel. If you want to place an order on backorder, select Backorder. If you 
want to exit the Status Selection dialog box without changing the status of 
the order, select Exit. 

Note: You cannot edit an order with the status of Cancel or Hold.
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To Release an Order on Hold

1 Choose Order Entry from the Process menu. The Enter Orders dialog box 
appears. Log in to the Order Entry dialog box.

2 Type the number of the order you want to release from hold. If you are not 
sure of the number, click LookUp to select the order from a list. 

3 Click Options, and then select Order Status. The Status on the Order Entry 
dialog box clears, indicating the order is no longer on hold.

Cancel Multiple Orders

Sage DacEasy provides you with the unique feature to close multiple orders in a 
single procedure, simplifying the order management process and saving you 
time.

1 From the Order Entry screen, select Options and Cancel Orders:

2 The default dates for the filter will be the Beginning and End Dates for the 
current period. Only the orders in the selected date range will be included in 
the lookup.  The Filter defines the range of Order dates that appears in the 
selection lookup:
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3 You can tag the Orders  you want to cancel and click on the OK icon when 
ready to process. Sage DacEasy Order Entry prompts you for confirmation and 
proceeds to cancel the tagged orders if such action is accepted.  NOTE: All 
Orders are untagged every time you execute the Cancel Orders option and 
the selection lookup comes up.

Entering Price Quotes

Sage DacEasy includes a Price Quote feature. This feature allows you to add and 
edit a price quote and later convert it to an order. Entering price quotes is exactly 
the same as entering regular orders, but price quotes are saved in a separate file. 
After entering a price quote, you can print the quote (either from the Order 
Entry dialog box or from the Print Quotes dialog box) and give a printed copy 
to your customer. Later, if the customer decides to place an order, you can use 
Sage DacEasy Order Entry to automatically convert the quote to an order. This 
feature is handy if you keep commonly requested quotes in your order entry 
system. You can use the same quote over and over to create orders when your 
customers decide to order the item or service.

To Add or Edit a Price Quote

1 Choose Order Entry from the Process menu. The Enter Orders dialog box 
appears. Log in to the Order Entry dialog box. 

2 Click Quotes. The Quote Selection dialog box appears.

3 Select Add/Edit Quotes. The Quote Entry dialog box appears.

4 Enter the quote as you would enter a regular order.

5 Click OK to save the quote
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If you selected the Print Orders After Entry check box on the System 
Preferences dialog box, you can select to print the quote after you click OK 
to save the quote.

To Convert a Price Quote to an Order

1 Choose Order Entry from the Process menu. The Enter Orders dialog box 
appears. Log in to the Order Entry dialog box. 

2 Click Quotes. The Quote Selection dialog box appears.

3 Select Convert to Order. Select the quote you want to convert from the list 
that appears. The Order Entry dialog box appears.

4 Complete the order as you normally would.

Note: The quote is deleted if you selected the Delete Converted Quotes 
check box on the System Preferences dialog box.

5 Click OK to save the order.

Save Quotes History

Gain greater control and better manage opportunities during the sales process 
using Quote History and Opportunity Management.  Quote History allows you 
to easily generate quotes based on a previous quote and to retain each version of 
the quote you supply to your customers. Using Quote History, you can quickly 
recall information previously conveyed to customers and to gain better insight 
into your sales opportunities.

With this new feature you can keep a history of all Quotes associated with the 
negotiating process for a specific sales opportunity with a Customer.  In 
addition, when this negotiation results in a successful sale, Sage DacEsy Order 
Entry uses the Opportunity Code to link the Quotes history to the Order, 
Invoice and Sales Returns associated with it. The Opportunity Code defines a 
specific Sales Opportunity with a specific customer. It can be a code created by 
you, according to your own coding convention, or one automatically generated 
by Sage DacEasy.

Using the Opportunity Code

1 Select Process, and then Order Entry from the Sage DacEasy Order Entry 
menu. The Sales Order Entry dialog box appears.

2 Click on the Quotes icon in the toolbar, and then choose Add/Edit Quotes. 
The Quotes Entry dialog box appears:
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3 Enter the header information as you deem appropriate.  Refer to the Add or 
editing price quotes topic in the help for more information on how to fill the 
Sales Quote header fields.

4 Enter an Opportunity Code in the Sales Quotes header when you create the 
first Quote associated with a Sales Negotiation; or enter an existing 
Opportunity Code to associate the Quote to an existing negotiation. Click on 
the LookUp icon to view a list of available Opportunities.  An Opportunity 
Code defines a specific negotiating process with a customer. Hence, this 
user's guide refers to an Opportunity or a Negotiating process indistinctly.

5 Use one of the following options to create an Opportunity Code:

a.Use your own logical coding convention, typing in your own user-defined 
codes in the Opportunity Code field. Sage DacEasy saves this code and it 
is listed in the Opportunity Codes LookUp, making it easy to associate 
subsequent quotes to existing Sales Opportunities.

b.Have Sage DacEasy generate the Opportunity Code. The Generate 
Opportunity Code function is available from the Options menu in the 
toolbar. Sage DacEasy uses the customer code plus a sequential number 
as its coding convention for automatic Opportunity Code generation.

6 Enter the Quote detail and footer information and Click OK or press F10 to 
save the information.  Refer to the Add or editing price quotes topic in the 
help for more information on how to fill the Sales Quote header and detail 
fields.
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Printing Orders and Picking Tickets

You can print orders two different ways: (1) print each order after you have 
entered it; or (2) selectively print orders in batches using the Print Orders dialog 
box. Follow the steps listed to batch print orders and picking tickets.

Note: If you are using the Freight field, add the field to the footer of your form 
template. If you are using a plain paper form template provided by Sage 
DacEasy, you can copy a form template with the Freight field from the Oebase 
folder (refer to the “Copying existing form templates” Help topic for more 
information). If you are using a preprinted or custom form, edit the template 
(refer to the “Editing templates” Help topic for more information).

To Batch Print Orders or Picking Tickets

1 Point to Print Orders on the Process menu, and then select Orders. The 
Print Orders dialog box appears. Click Help for a detailed description of each 
field.

2 Select the Print Picking Ticket check box if you want to print only the 
picking tickets.

3 Type the range of transactions you want to print in the From and To fields.

4 Select the Reprint check box if you are reprinting the transactions.

5 Type the number of copies you want of each transaction.

6 Click OK. The Report Layout dialog box appears.

Tip: To ensure your forms are loaded properly in your printer and your printer 
settings are correct, click Test Page.

7 Select your target and click OK to generate the forms.



Processing Orders
Sage DacEasy Order Entry User’s Guide

108

5
Orders

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Selecting form templates

• Aligning continuous-feed forms

Printing RMAs

If a customer returns merchandise, use the Order Entry dialog box to enter the 
return as a returned merchandise authorization (RMA) transaction. After 
entering the RMA transaction (and optionally providing the customer with an 
RMA number), you can print the RMA form to notify the warehouse or 
fulfillment center to accept the returned goods.

You can print RMAs two different ways: (1) print each RMA after you enter the 
return; or (2) selectively print RMAs in batches using the Print RMAs dialog 
box. Follow the steps listed to batch print returns.
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Note: If you are using the Freight field, add the field to the footer of your form 
template. If you are using a plain paper form template provided by Sage 
DacEasy, you can copy a form template with the Freight field from the Oebase 
folder (refer to the “Copying existing form templates” Help topic for more 
information). If you are using a preprinted or custom form, edit the template 
(refer to the “Editing templates” Help topic for more information).

To Batch Print RMAs

1 Point to Print Orders on the Process menu, and then select RMAs. The 
Print RMAs dialog box appears. Click Help for more info on each field.

2 Type the range of transactions you want to print in the From and To fields.

3 Select the Reprint check box if you are reprinting the transactions.

4 Type the number of copies you want of each transaction.

5 Click OK. The Report Layout dialog box appears.

Tip: To ensure your forms are loaded properly in your printer and your printer 
settings are correct, click Test Page.

6 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Selecting form templates

• Aligning continuous-feed forms

Printing Quotes
You can print quotes two different ways: (1) print each quote after you enter the 
quote; or (2) selectively print quotes in batches using the Print Quotes dialog 
box. Follow the steps listed to batch print quotes.

Note: If you are using the Freight field, add the field to the footer of your form 
template. If you are using a plain paper form template provided by Sage 
DacEasy, you can copy a form template with the Freight field from the Oebase 
folder (refer to the “Copying existing form templates” Help topic for more 
information). If you are using a preprinted or custom form, edit the template 
(refer to the “Editing templates” Help topic for more information).
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To Batch Print Quotes

1 Point to Print Orders on the Process menu, and then select Quotes. The 
Print Quotes dialog box appears. Click Help for more info on each field.

2 Type the range of transactions you want to print in the From and To fields.

3 Type the number of copies you want of each transaction.

4 Click OK. The Report Layout dialog box appears.

Tip: To ensure your forms are loaded properly in your printer and your printer 
settings are correct, click Test Page.

5 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Selecting form templates

• Aligning continuous-feed forms

Printing Shipping Labels for Orders
Sage DacEasy Order Entry includes an Order Labels feature that prints shipping 
labels for your orders. When you print order shipping labels, Sage DacEasy pulls 
the customer information and address from the order.

To Print Shipping Labels for Orders

1 Point to Print Orders on the Process menu, and then select Order Labels. 
The Order Shipping Labels dialog box appears. Click Help for more 
information on each field.

2 Select the scope and sort of the labels you want to print.

3 Type the range of transactions you want to print or select from in the From 
and To fields if you selected Range or Select as the Scope.

4 Complete the remaining fields if necessary.

5 Click OK. 
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If Select is the Scope, a list of orders appears. A Y in the Selected column 
indicates a label will print for the order. Click Select to alternate between Y 
and N in the Selected column. After you have selected all the records you 
want, click OK to continue. The Report Layout dialog box appears.

If you selected All or Range as the Scope, the Report Layout dialog box 
appears.

6 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Editing the label layout

• Selecting form templates

• Aligning continuous-feed forms

Shipping Orders
When you ship an order, you are indicating you want to create an invoice for the 
order because you are delivering the goods to the customer and are billing the 
customer for the shipment. When you post shipments, Sage DacEasy updates 
the historical information for your customers, products, services and 
salespeople. Use the Ship Orders routine to record shipment of orders to your 
customers. Choose Ship Orders from the Process menu to access this routine.

The Order Entry Shipping dialog box allows you to ship orders two different 
ways: (1) ship partial orders and leave the remaining items still on the order or 
(2) ship an entire order (subject to product availability).

Remember, the Ship Orders routine is an important part of the order entry 
process. Refer to Chapter 3, “Quick Tour” for more information on the entire 
process.

To Fill Backorders Before Shipping Orders

Follow these steps to fill backordered items during the Ship Orders routine. 

1 Choose Ship Orders from the Process menu. The Ship Orders dialog box 
appears. Log in to the Orders Shipment view. A list of orders appears.

2 Select an order and click Tag/Untag. A check mark appears in the Tag 
column. Repeat until all orders you want filled are tagged.
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3 Click Options, and then select Fill Orders. A message appears asking if you 

want to start filling the selected backorders. Choose Yes to continue. This 
process moves all units in the Backorder field to the This Shipment field.

Sage DacEasy Order Entry fills the backorders for each order tagged. If an 
order could not be filled because not enough units were available, a report 
prints listing the orders that were short units and the number of items 
needed.

4 Click OK to begin processing shipments. A message appears confirming you 
want to begin generating invoices. Choose Yes to continue.

Sage DacEasy Order Entry creates invoices for each of the tagged orders with 
items in the This Shipment field.

To Ship Complete Orders

Follow these steps to ship orders containing no backordered items. If you are 
making partial shipments, refer to the next set of steps titled “To Ship Partial 
Orders.”

1 Choose Ship Orders from the Process menu. The Ship Order dialog box 
appears.

2 Type the ID of the person authorizing the shipments. The shipping person’s ID 
is included with each shipment so you can easily track down and correct any 
errors made in fulfilling the shipment.

3 Type the date to use as the shipping date for each order shipped. This date 
also serves as the invoice date. You cannot change this date once you 
continue through the Ship Order dialog box. If you are interfaced with Sage 
DacEasy Accounting, Sage DacEasy Order Entry verifies the date you enter is 
in an open period in your periods structure.

4 Click OK. A list of orders appears.
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5 Select the order in the list and click Tag/Untag. A check mark appears in the 
Tag column. Continue until all the orders you want shipped are tagged.

Click Tag/Untag All to tag all orders in the list or clear the tags from all 
orders in the list.

6 Click OK to begin processing shipments. A message appears confirming you 
want to begin generating invoices. Choose Start to continue. The Report 
Layout dialog box appears. Select the target, and then click OK. 

Sage DacEasy Order Entry creates invoices for each of the tagged orders with 
items in the This Shipment field, if there are enough units available to fulfill 
the order.

If any items were unavailable, a Generate Invoices Audit Report prints. If all 
item shipped, click OK to return to the main menu.

Related Help Topic

• Entering serial numbers when shipping an order

To Ship Partial Orders

1 Choose Ship Orders from the Process menu. The Ship Order dialog box 
appears. Log in to the Orders Shipment view. A list of orders appears.

2 Select an order and click Tag/Untag. A check mark appears in the Tag 
column.

3 With the order still selected, press Enter to view the Order Entry dialog box.

4 Click the Detail tab. 

5 Type the number of units you want to include on this shipment in the This 
Shipment field. Sage DacEasy Order Entry creates an invoice for only the items 
with units in the This Shipment field. 

Use the list of orders to
tag the orders you want

shipped.
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Note  You can modify the order at this time.

6 Click OK to save the changes made to the order. A list of orders appears.

7 Continue to tag and enter units in the This Shipment field for all orders you 
want shipped.

8 Click OK to begin processing shipments. A message appears confirming you 
want to begin generating invoices. Choose Yes to continue.

Sage DacEasy Order Entry creates invoices for each of the tagged orders with 
items in the This Shipment field, if there are enough units available to fulfill 
the order.

Note: If you ship a partial order and assign your own invoice number, a 
prompt appears so you can enter the invoice number.

Behind the Scenes

The following list identifies each task the Ship Orders routine accomplishes.

• Creates invoices for orders and sales returns for RMAs (Returned 
Merchandise Authorizations). After the invoices are created for the 
orders, point to Print Invoices on the Process menu, and then select 
Invoices or Returns to print these forms as well as packing slips. The 
order number appears in the Our field on the invoice so you can track 
the invoice back to the original order if necessary. Also, if you placed 
the original invoice number in the Customer Reference field on the 
RMA, the original invoice number appears in the Your field on the sales 
return.

• Commits the units in the Edit Product dialog box for each unit of the 
product shipped. This only occurs if you did not select the Check 
Product Availability Online check box on the System Preferences 
dialog box. If you did select this option, the committed units were 
updated for the product when you entered the order and placed the 
units in the This Shipment field.

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, the Ship Orders routine creates an invoice in the 
Invoice Header and Detail files and updates the Accounts Receivable 
Open Invoice Header and Detail files. You can now track the order in 
Sage DacEasy with customer statements and aging reports. You can 
print and post the invoice using the billing module in Sage DacEasy 
Accounting; however, it is advisable to perform the Posting routine in 
Sage DacEasy Order Entry.

• If you choose to assign your own invoice numbers, Sage DacEasy 
automatically displays a pop-up dialog box when an invoice number is 
needed.
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• Updates the Customer Transaction History files if you selected the 

Track Customer Transaction History check box on the System 
Preferences dialog box.

• Updates the Salesperson History file if you selected the Track 
Salesperson Information check box on the System Preferences dialog 
box.

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting and the Update Check Register Online feature is 
selected in Sage DacEasy Accounting, then the Ship Orders routine 
creates a Check Register entry in Sage DacEasy Accounting for each 
advance payment. A Check Register entry is created when: (1) the 
Shipping option is selected for the Process Payments When field on the 
System Preferences dialog box in Sage DacEasy Order Entry, or (2) an 
order with an advanced payment is shipped or when running the 
Posting routine and the Entering option is selected for the Process 
Payments When field in the System Preferences dialog box. 

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting and the Update General Ledger Online feature is 
selected in Sage DacEasy Accounting, then the Ship Orders routine 
creates a detailed General Ledger transaction for each invoice created.

Printing Invoices and Packing Lists
Use the Order Entry dialog box to enter customer orders. Then,  print the order 
and picking ticket to send to the warehouse or fulfillment center to prepare the 
order. Use the Ship Orders routine to ship the order and create an invoice. Then, 
print the packing list to include in the shipment and print the invoice to send to 
the customer. 

Note: If you are using the Freight field, add the field to the footer of your form 
template. If you are using a plain paper form template provided by Sage 
DacEasy, you can copy a form template with the Freight field from the Oebase 
folder (refer to the “Copying existing form templates” Help topic for more 
information). If you are using a preprinted or custom form, edit the template 
(refer to the “Editing templates” Help topic for more information).

To Batch Print Invoices or Packing Lists

1 Point to Print Invoices on the Process menu, and then select Invoices. The 
Print Invoices dialog box appears. Click Help for more info on each field.

2 Select the Print Packing List check box if you want to only print the packing 
lists.
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3 Select the sort and rank order for the transactions you want to print and type 

the ranges in the From and To fields.

4 Select the Reprint check box if you are reprinting the transactions.

5 Type the number of copies you want of each transaction.

6 Click OK. The Report Layout dialog box appears.

Tip: To ensure your forms are loaded properly in your printer and your printer 
settings are correct, click Test Page.

7 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Selecting form templates

• Aligning continuous-feed forms

Invoice
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Printing Sales Returns

Use the Order Entry dialog box to enter customer returns as RMA (Returned 
Merchandise Authorization) transactions. After entering the RMA (and 
optionally providing the customer with an RMA number), print an RMA form 
to notify the warehouse or fulfillment center to accept the returned goods. 
When the customer returns goods, use the Ship Orders routine to indicate the 
goods have been received and create a sales return from the RMA.

Note: If you are using the Freight field, add the field to the footer of your form 
template. If you are using a plain paper form template provided by Sage 
DacEasy, you can copy a form template with the Freight field from the Oebase 
folder (refer to the “Copying existing form templates” Help topic for more 
information). If you are using a preprinted or custom form, edit the template 
(refer to the “Editing templates” Help topic for more information).

To Batch Print Sales Returns

1 Point to Print Invoices on the Process menu, and then select Returns. The 
Print Sales Returns dialog box appears. Click Help for more information on 
each field.

2 Select the Print Packing List check box to only print packing lists.

3 Type the range of transactions you want to print in the From and To fields.

4 Select the Reprint check box if you are reprinting the transactions.

5 Type the number of copies you want of each transaction.

6 Click OK. The Report Layout dialog box appears.

Tip: To ensure your forms are loaded properly in your printer and your printer 
settings are correct, click Test Page.

7 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Selecting form templates

• Aligning continuous-feed forms
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Printing Shipping Labels for Invoices

Sage DacEasy Order Entry includes a routine that prints shipping labels for your 
shipments. When you print shipping labels, Sage DacEasy pulls the customer 
information and address from the invoice.

To Print Shipping Labels for Invoices

1 Point to Print Invoices on the Process menu, and then select Shipping 
Labels. The Customer Shipping Labels dialog box appears. Click Help for 
more information on each field.

2 Select the Scope to determine whether you want to print shipping labels for 
all invoices in the file, a range of invoices or select certain invoices from 
throughout the file.

3 Select whether you want to print the shipping labels sorted by Invoice 
Number or Customer Code in the Print By field.

4 Type the range of transactions you want to print or select from in the From 
and To fields if you selected Range or Select as the Scope.

5 Type the number of shipping labels you want per invoice.

6 Select whether or not you want to include posted transactions.

7 Select whether or not you want to suppress the blank address lines.

8 Select the Label Type. Be sure you are using the correct label type for the 
shipping label template you are using.

9 Select the print mode you want to use to print the labels.

10 Click OK. 

If you chose Select as the Scope, a list of invoices appears. All records within 
the range specified display a Y in the Selected column. This indicates a label 
will print for the invoice. If you do not want to print a label for a record, select 
the record and click Select. If an N appears in the Selected column, a label 
will not print for the invoice. After you have selected all the records you want, 
click OK to continue. The Report Layout dialog box appears.

If you selected All or Range as the Scope, the Report Layout dialog box 
appears.

Tip: For more information on editing the label layout, refer to the Help topic 
titled “Editing the label layout.”

To ensure your labels are loaded properly in your printer and your printer 
settings are correct, click Test Page.
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11 Select your target and click OK to begin printing.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Editing the label layout

• Selecting form templates

• Aligning continuous-feed forms

Printing the Credit Card Transactions Report
As a control measure when using the online credit verification feature, Sage 
DacEasy Order Entry prints a report listing details about the invoices or orders 
paid by credit card. The information on the report includes the order number, 
credit card account number and expiration date, the approval code and amount 
of purchase. This report is also referred to as the Payment Processing 
Transactions Report.

Important: This report contains sensitive credit card information. Protect this 
feature with user access rights so only trusted employees have access to this 
information. 

To Print the Credit Card Transactions Report

1 Choose Credit Cards from the Process menu. The Card Transaction Report 
dialog box appears.

2 Type the date range in the From and To fields.

3 Click OK to view the Report Layout dialog box.

4 Select your target and click OK to generate the report.

Related Help Topics

• Using the Report Layout dialog box
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Printing the Sales Journal or Sales Listing

Sales Journal

The Sales Journal prints only unposted invoices, sales returns and payments. 
After you have shipped all orders for the day, you can print the Sales Journal for 
final verification of all shipped transactions. Use the Sales Journal to verify 
transactions are correct before you post. You can also use the Sales Journal as 
your audit trail for invoices, sales returns and payments. It is important to 
archive the report to help track invoices after you have posted shipments. 

Since journal printing is an extremely important process, you should make sure 
it is mandatory. Select the Require Journal Printing check box on the System 
Preferences dialog box and Sage DacEasy does not allow you to post until you 
have printed the Sales Journal. If you do not select this check box, Sage DacEasy 
does not require you to print the Journal. 

Sales Listing

Use the Sales Listing to print both posted and unposted billing transactions. You 
can print all or a specific range of transactions. There are more listing options to 
include on a Sales Listing than on a Sale Journal. You can select to sort and rank 
the report on almost any field found in the top portion of the invoice.

To Print a Sales Journal or Sales Listing

1 Choose Sales Journal from the Process menu. The Sales Journal dialog box 
appears.

2 Select whether you are printing a Journal or a Listing in the Report Type 
field.

If you selected Journal as the Report Type, type a date that falls in the period 
for which you are printing the journal.

Use the Sales Journal
dialog box to print a

Sales Journal or a Sales
Listing.
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If you selected Listing as the Report Type, select how you want to filter the 
information that prints on the Sales Listing and type the range in the From 
and To fields. If you want to filter out more information, select a second field 
and type the range in the From and To fields. Select whether you want to 
include only invoices, only returns or all transactions on the report.

3 Click OK to view the Report Layout dialog box.

4 Select your target and click OK to begin printing.

Related Help Topic

• Using the Report Layout dialog box

Entering Inventory Adjustments
Use the Inventory Adjustments feature to transfer items from one warehouse to 
another or to adjust inventory quantities or values in Sage DacEasy without 
affecting customer or vendor balances.

If you are not running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, you can use this feature to record inventory purchases in Sage 
DacEasy Order Entry. 

To Enter an Inventory Adjustment

1 Select Inventory Adjustments from the Process menu. The Inventory 
Adjustments dialog box appears. Click Help for a detailed description of 
each field.

2 Press Enter in the Number field and the next available number is assigned.

3 Edit the date, if necessary.

4 Select the type of action to perform.

Transfer inventory or
adjust quantity counts

from the Inventory
Adjustments dialog

box.
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Increase Quantity—Select this option to add to the amount of this product 
currently in stock.

Transfer Quantity—Select this option to move the units from one product to 
a different product. This is most commonly used to transfer items from one 
warehouse to another.

Decrease Quantity—Select this option to reduce the amount of this product 
currently in stock.

Increase Value—Select this option to increase the total value of this item in 
your inventory. 

Decrease Value— Select this option to decrease the total value of this item 
in your inventory.

5 Complete the remaining fields based on your selection in the Type field.

Increase Quantity—If you selected Increase Quantity in the Type field, select 
the product you are adjusting in the Item field. Type the number of units 
being added and the cost to use in calculating the product’s new on hand 
dollars. Then, select the account to update when the transaction is saved. 

Transfer Quantity—If you selected Transfer Quantity in the Type field, select 
the product you are transferring in the From Item field, and then select the 
receiving product in the To Item field. Type the number of units being 
transferred. Sage DacEasy uses the product’s average cost to determine the 
new on hand dollars and uses the Inventory account as the offsetting 
account. 

Decrease Quantity—If you selected Decrease Quantity in the Type field, 
select the product you are adjusting in the Item field. Type the number of 
units being reduced, and then select the account to update when the 
transaction is saved. Sage DacEasy uses the product’s average cost to calculate 
the new on hand dollars.

Increase Value—If you selected Increase Value in the Type field, select the 
product you are adjusting in the Item field. Type the amount of the 
adjustment as a positive number in the Adjust by field. Then, select the 
account to update when the transaction is saved. 

Decrease Value—If you selected Decrease Value in the Type field, select the 
product you are adjusting in the Item field. Type the amount of the 
adjustment as a positive number in the Adjust by field, and then select the 
account to update when the transaction is saved. 

6 Click OK to save the transaction. Sage DacEasy posts the transaction online.

Behind the Scenes

When you save an inventory adjustment transaction, Sage DacEasy does the 
following accounting behind the scenes:
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Note: A transfer does not affect account balances.

• If running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, this routine updates the Inventory account on the Account 
Interface dialog box in Sage DacEasy Accounting. The account is 
debited when an Increase-type transaction is saved. The account is 
credited when a Decrease-type transaction is saved. If you are not 
interfaced, this routine updates the default Inventory account held in 
the program internally.

• Sage DacEasy updates the account specified on the transaction. The 
account is credited when an Increase-type transaction is saved. The 
account is debited when a Decrease-type transaction is saved.

When you save an inventory adjustment transaction, Sage DacEasy updates the 
following files:

• Sage DacEasy updates the Product Activity Detail file with the 
transaction. Print the Inventory Adjustments Listing to view the 
transactions.

• The Accounts file includes new account balances. Sage DacEasy 
updates period and current balances for the accounts as well as the 
parent account to which the accounts flow. Print all financial reports to 
view the changes in account balances.

• Sage DacEasy updates the General Ledger Header and Detail files with 
the transaction. The journal code for the transaction that posts to the 
General Ledger is IA. Print the General Ledger Listing to view the 
transaction.

• Sage DacEasy updates the Product file accordingly. The Average cost 
for the products involved is recalculated. 

For transfers, the units are increased for the To Item and decreased for 
the From Item. The on hand dollars are adjusted based on the average 
cost of the item being transferred.  

For Quantity adjustments, the on hand units and dollars (based on the 
average cost of the product) are increased or decreased accordingly.

For Value adjustments, the on hand dollars are updated. 

Related Help Topic

• Editing inventory adjustments
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Cancelling Shipments

After shipping an order, and before posting the shipment, you can reverse the 
Ship Orders routine. This feature is helpful if you tagged and shipped the wrong 
order or a customer wants to cancel an order before you delivered the goods. 
Canceling shipments works in exactly the opposite manner as shipping orders. 

The Cancel Shipments routine is only available for shipments you have not 
posted yet. After posting a shipment, the only way to correct an error for an 
entire shipment or reverse a shipment is to restore the backup you made 
immediately prior to posting. To manually reverse posted shipments, you can 
use the Returned Merchandise Authorization (RMA) feature. When you ship an 
RMA it creates a sales return, which you can use to reverse the posted invoices.

To Cancel Shipments

1 Choose Cancel Shipments from the Process menu. The Cancel 
Transactions dialog box appears.

2 Type the date range of shipments you want to appear in the Cancel Invoices 
view. If you want to cancel only one shipment or several shipments made on 
one day, type the shipment date in both the From Date and To Date fields.

3 Click OK. A list of shipments appears for the date range specified.

4 Select the transaction you want reversed from the list and click Tag/Untag. A 
check mark appears in the Tag column. Continue to tag the transactions you 
want reversed.

Click Tag/Untag All to tag all items in the list or clear the tag from all items in 
the list.

5 Click OK to begin the Cancel Shipment routine.
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Sage DacEasy deletes each tagged transaction and returns the items back to 
the original order or RMA. The number of items in the Shipped field on the 
transactions are placed in the Backorder field on the order. The Committed 
units are removed from the Product file. The status of the order is set to 
Backorder.

Behind the Scenes

The following list identifies each task the Cancel Shipment routine 
accomplishes.

• Converts invoiced shipments (invoices) back to orders and sales 
returns back to RMAs. If you cancel a partial shipment, Sage DacEasy 
inserts the units back on the original order.

• Changes the status of the order to Backorder.

• Removes the committed units on the Edit Product dialog box.

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, the Cancel Shipment routine deletes the invoice 
or return from your Invoice Header and Detail files and the updates the 
Accounts Receivable Open Invoice Header and Detail files.

• Updates the Customer Transaction History files by removing the 
invoices or sales returns if you selected the Track Customer Transaction 
History check box on the System Preferences dialog box.

• Updates the Salesperson History file if you selected the Track 
Salesperson Information check box on the System Preferences dialog 
box.

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting and the Update Check Register Online feature is 
selected in Sage DacEasy Accounting, then the Cancel Shipments 
routine deletes each Check Register Entry for each voided invoice with 
an advance payment.

• If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting and the Update General Ledger Online feature is 
selected in Sage DacEasy Accounting, then the Cancel Shipments 
routine deletes the detailed General Ledger transaction for each invoice 
or sales return canceled. The Cancel Shipments routine creates a 
General Ledger entry if the order had an advance payment processed 
prior to shipping.
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Posting Shipments

The last step in the order entry routine is posting shipments. The Post 
Shipments routine performs many functions, all of which are outlined in the 
next section titled “Behind the Scenes.” The Post Shipments routine is how Sage 
DacEasy updates your customer, product, service, tax table, sales analysis and 
chart of accounts files to reflect the transactions that have taken place.

It is important to back up your files before posting shipments since it updates 
several files in your system. To make backing up your files convenient, you can 
click Backup from the Post Order Entry dialog box. If you are running Sage 
DacEasy Order Entry interfaced with Sage DacEasy Accounting, be sure to also 
make a separate backup of your accounting data.

To Post Shipments

1 Choose Post Shipments from the Process menu. The Post Order Entry 
dialog box appears.

2 Type the date for the period you want to post in the Date to Post field. You 
must post each period in order to preserve the cost information.

3 Type a short description in the Reference field. This reference appears on the 
general ledger transaction.

4 Select whether or not you want to purge transactions after posting.

5 Select whether or not you want to automatically apply advances.

6 Click OK to begin the Posting routine. 

Behind the Scenes

When you post shipments, Sage DacEasy performs the following accounting 
behind the scenes:

The opposite entry is made for RMAs (sales returns).

Use the Post Order Entry
dialog box to update

your chart of accounts,
customers, products,

services, tax tables and
sales analysis files.
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• Sage DacEasy debits Accounts Receivable for the net to pay amount.

• Sage DacEasy debits Cost of Goods Sold for the cost of the products 
sold.

• Sage DacEasy debits Checking for any advance payments on both 
orders and shipped orders.

• Sage DacEasy credits Inventory for the cost of the products sold. 

• Sage DacEasy credits Sales for the inventory and service items on the 
transaction.

• Sage DacEasy credits the accounts associated with any billing codes on 
the transactions.

• Sage DacEasy credits Sales Tax Liability for the sales tax amount.

• Sage DacEasy credits Freight for the amount in the footer.

Note: If you are interfaced with Sage DacEasy Accounting, the cost of goods sold 
and sales accounts that are affected depend on your departmentalization 
method.

The following list identifies each task the Post Shipment routine accomplishes.

• Shipped invoices or sales returns for the period being posted are 
marked as Posted. 

• A posted transaction with an OE journal code is added to the General 
Ledger Transaction files. The previous list explains how each account is 
affected. The opposite entry is made for sales returns. If you are 
running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting and the Update General Ledger Online feature is selected, 
the detail transaction created in the General Ledger Header and Detail 
files when the billing transaction was created is marked as posted. 

• The current balance and historical information for each affected 
customer are updated.

• The Product file is updated if products are on the transactions. On 
hand units for shipped products are reduced by the number of 
committed units and the Committed field returns to zero. The on hand 
dollars decrease by the cost of the units sold. Sage DacEasy updates the 
product historical information.

• The historical information in the Service file is updated.

• The Accounts Receivable Open Invoice Header Detail files are updated 
with a Posted status for each transaction that was posted.
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• If you are interfaced with Sage DacEasy Accounting and the Track Sales 

Analysis check box is selected on the System Preferences dialog box, 
the Sales Analysis file is updated so you can generate custom reports in 
DacAccess. 

• The Tax Table file includes the sales tax amounts from transactions. 

• The Product Transaction Detail file is updated if the Track Product 
Transaction History check box is selected on the System Preferences 
dialog box. If you are interfaced with Sage DacEasy Accounting, this 
preference is set up in Sage DacEasy Accounting.
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• Customer Service Tools •

Overview
This chapter explains how to use the Customer Service tools found on the 
Customer Service menu. There are four Customer Service tools available, the 
Customer Inquiry, Product Inquiry, Order Status Inquiry and Serial Numbers. 
Use the Customer Service tools to quickly find out information about 
customers, products, order’s status and serial numbers. 

Viewing the Customer Inquiry

As you use Sage DacEasy Order Entry and add customers and transactions, you 
are building a customer information file containing specific information about 
your customers. This information includes the items found on the Edit 
Customer dialog box such as the customer’s address, current balance and yearly 
historical balances. In addition to the information on the Edit Customer dialog 
box, Sage DacEasy Order Entry builds Accounts Receivable Open Invoice 
Header and Detail files and a Customer Purchase History file as you record 
transactions for your customers. Use the Open Invoices option to perform sales 
and payment history inquiries and the Purchase History option to view the 
customer’s purchases.

Every time you ship an order for a customer, Sage DacEasy updates the 
Accounts Receivable Open Invoice files for that customer. At any time, you can 
access the Customer Inquiry dialog box and view the invoice and payment 
history for the customer. If you are interfacing Sage DacEasy Order Entry with 
Sage DacEasy Accounting, you can view the customer’s invoice and payment 
history until full payment is received for that invoice and you perform the 
Receivables Period End routine in Sage DacEasy Accounting. The Receivables 
Period End routine purges all posted fully paid invoices from these files. 
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To View a Customer Inquiry

1 Choose Customer Inquiry from the Customer Service menu. The 
Customer Inquiry dialog box appears. Click Help for more info on each 
field.

2 Type the code of the customer you want to view or click LookUp to select the 
customer from a list. The customer’s company name, credit information and 
the date and amount of the customer’s last sale and payment appear.

Viewing the Customer’s Open Invoices

3 Click Open Invoices. A list of receivable open invoices for the customer 
appears.

Use the arrow keys or mouse to scroll horizontally or vertically through the 
open invoice window. Use the Transaction Type column to determine the type 
of transaction each row represents: 

I = Invoice (shipped order)

P = Payment (advance payment on order or payment in Sage DacEasy 
Accounting)

4 Click Close to exit the list.

Printing the Customer’s Purchase History

5 Click Purchase History. The Purchase History dialog box appears. 

6 Type the date range of the purchase history information you want.

Use the Customer Inquiry
dialog box to view the

customer’s balance
information, open invoices

and purchase history.

The LookUp Receivables
Open Invoices displays a list
of receivable open invoices

for the customer.
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7 Click OK. The Report Layout dialog box appears. 

8 Select your target and click OK to print the history.

The Customer Purchase History report lists the items purchased by this 
customer between the date range you specified, the item type (for example, if 
it was a product or service), the date the items were sold, the number of units 
sold, the sales fraction, the price per unit and the total price.

9 Click Close to exit the Customer Inquiry dialog box.

Related Help Topic

• Using the Report Layout dialog box

Viewing the Product Inquiry

As you use Sage DacEasy Order Entry and add products and transactions, you 
are building a product information file that contains specific information about 
your products, such as sales price, costing information and yearly historical 
balances. Use the Product Inquiry feature to quickly view this information; you 
can also use this feature to view which orders include the product.

The Product Inquiry allows you to quickly view and calculate information about 
your products. Use this Customer Service tool if a customer calls to inquire on 
the availability of a product. You can even calculate quantity price breaks so you 
can provide accurate verbal price quotes to your customers.

To View a Product Inquiry

1 Choose Product Inquiry from the Customer Service menu. The Product 
Inquiry dialog box appears. Click Help for more information on each field.

Use the Product Inquiry
dialog box to quickly view
and calculate information

about a product.
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2 Type the code of the product you want to view or click LookUp to select the 

product from a list. The information on the current availability of the product 
appears along with other information important to the customer when 
ordering the product.

The Available Units field displays the number of units currently available for 
sale. This number is equal to the current on hand units less the number of 
units currently committed on orders and unposted invoices.

If you have set up price breaks for a product, use the lower portion of the 
Product Inquiry as a worksheet for determining quantity pricing. Select the 
price break group the customer belongs to (A through F) and the associated 
price break table appears. Use the table to determine the sales price the 
customer should receive based on the number of units the customer is 
interested in purchasing.

Viewing the Orders

3 Click Orders. A list of orders that currently include the product appears.

This feature is helpful if the availability of a product is low and you want to 
view which orders are committing the units. 

4 Click Close to return to the Product Inquiry dialog box. 

5 Click Close to exit the dialog box.

Viewing the Order Status Inquiry

You can quickly query the status of orders using the Order Status Inquiry. This 
feature displays the same information as the Order Status report, but you can 
query order information on a customer-by-customer basis. You do not need to 
know the order number to use this tool, enter the customer code and all orders 
you have stored for that customer are available.

The LookUp Order Detail
displays a list of orders
including the selected

product.
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To View an Order Status Inquiry

1 Choose Order Status Inquiry from the Customer Service menu. The Order 
Status Inquiry dialog box appears.

2 Type the code of the customer inquiring about an order or click LookUp to 
select the customer from a list. After entering the customer code, a list of 
orders entered for the customer appears. All orders for the customer since the 
last time you purged the Orders file appear.

Use the arrow keys or mouse to scroll horizontally or vertically through the list.

Viewing Detail Information on an Order

3 Select an order from the list and click Order Detail. The detail information for 
the order appears.

Use the arrow keys or mouse to scroll horizontally or vertically through the list 
of items. 

4 Continue to click Close until you have exited all dialog boxes.

Printing the Serial Number Tracking Report

If you set up serial number tracking for your products, you may need to query 
information about a past sale by serial number. For example, assume a customer 
brings in a purchase for maintenance and they do not have their invoice. You 
want to make sure that the customer’s warranty has not expired before you 
begin working on the product. With the Serial Number Tracking report, you 
can easily find the serial number and specific information about a sale.

The Serial Number Tracking report only includes information for orders 
including products and services with serial numbers. The report prints the order 
number, invoice number, sales date, customer code, customer name, product 
code, product description and serial number.

Use the order detail to view
if an item has shipped.

Use the Order Status Inquiry
dialog box to select the
customer for the order

inquiry.
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When printing the Serial Number Tracking report, you have several options for 
sorting and ranking the records. You can print the report sorted by invoice 
number, customer code, sale date, item number or serial number. Using the 
powerful report sorting capabilities, you can quickly find the information you 
need.

To Print the Serial Number Tracking Report

1 Choose Serial Numbers from the Customer Service menu. The Serial 
Number Tracking Report dialog box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

4 Click OK. The Report Layout dialog box appears.

5 Select your target and click OK to begin printing.

Related Help Topic

• Using the Report Layout dialog box

Serial Number Tracking Report



Customer Service Tools
Sage DacEasy Order Entry User’s Guide

136

6



7Management 
Reporting

Sales Orders Report 138

Receipts Report 140

Production Schedule Report 141

Order Status Report 142
Filter Order Status report by Order Status 144

Backorder Status Report 144

Sales Analysis Reports 145

Product Listing 150

Product Activity Report 151

Product Activity Detail Report 152

Inventory Adjustments Listing 154

Master Item Activity Report 155

Merging Customer Info with Microsoft Word 156

Customer Labels 158

Product Labels 159

Media Code Tracking Report 160

General Ledger Listing Report 162

Printing Bar Codes 163

Promotional Price Report 164



Management Reporting
Sage DacEasy Order Entry User’s Guide

138

7

• Management Reporting •
This chapter contains information on printing Sage DacEasy Order Entry’s 
powerful management reports. The reports available in Sage DacEasy Order 
Entry provide you with the information you need to make decisions affecting 
your company. The predefined reports included in Sage DacEasy Order Entry 
are Sales Orders, Receipts, Production Schedule, Order Status, Backorder 
Status, Sales Analysis, Product Listing, Product Activity, Product Activity Detail, 
Inventory Adjustments Listing, Master Items Activity, Media Code Tracker, 
General Ledger Listing and Promotional Price. 

If you need information about your orders, use the Sales Order, Receipts, 
Production Schedule, Order Status or Backorder Status report. These reports 
pull information from your orders to give you the information you need to 
determine what is on backorder, when to purchase or assemble more products 
and how much you are receiving in payment from the orders.

If you need information about your inventory or items shipped, use the Sales 
Analysis by customer or by product report, Product Listing, Product Activity, 
Product Activity Detail, Inventory Adjustments Listing or Master Item Activity 
report.

Three other important features of Sage DacEasy Order Entry explained in this 
chapter include integrating with Microsoft Word, printing labels for your 
customers or products and printing bar codes. You can use the customer labels 
as mailing labels when sending the invoice to the customer. The product labels 
can be used at the warehouse to label the product bins. 

Sales Orders Report
The Sales Orders report provides a listing of the orders currently on file, whether 
they are open, completed, backordered or on hold. Included on the report are 
each order’s type, number, customer name, department, date, requested ship 
date, subtotal amount, freight, sales tax, total order amount and salesperson. 
This report is also sometimes referred to as the Daily Order Report.

Orders remain in the Order file until you perform the Purge routine. Since you 
may want to print orders for only one day or one week, the Sales Order Report 
dialog box allows you specify a range of orders to include on the report.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to , “Working 
With Sage DacEasy Business Center Pages” in the Sage DacEasy Business Center 
Guide.
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To Print the Sales Orders Report

1 Choose Sales Orders on the Reports menu. The Sales Orders dialog box 
appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

4 Click OK. The Report Layout dialog box appears.

5 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Sales Orders Report
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Receipts Report

The Receipts report prints detail information on the methods of payment your 
customers use to make payments. You can print the Receipts report in either 
detail or summary format. The detail Receipts report subtotals by method of 
payment, with all receipts for each method of payment listed individually. 
Included on this report are the methods of payment, customer code, order 
number, order date, total order amount, amount received, net amount left to 
pay and the salesperson from the original order, as well as the grand totals.

The summary Receipts report includes a summary entry for each method of 
payment, with a subtotal amount for each and a grand total for all methods of 
payments.

Note: The Receipts report only shows payments made in Sage DacEasy Order 
Entry. If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, and you make payments to invoices in Sage DacEasy 
Accounting, these payments do not appear on the Receipts report. To view the 
payments made in Sage DacEasy Accounting, print the Receipts report in Sage 
DacEasy Accounting.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to “Working 
With Sage DacEasy Business Center Pages” in the Sage DacEasy Business Center 
Guide.

To Print the Receipts Report

1 Choose Receipts on the Reports menu. The Receipts Report dialog box 
appears.

2 Type the date range for the information you want on the report.

3 Select whether you want to print a Detail or Summary report.

4 Click OK. The Report Layout dialog box appears.

5 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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Receipts Report

Production Schedule Report
The benefit of this report is you can effectively manage your product lines using 
request dates. This creates a more efficient manufacturing process because you 
can deliver your products to the consumer on time and minimize the 
interruption of your production runs.

The Production Schedule report gives you the flexibility to tailor your report 
based on the specific request dates of your customers. The report searches the 
orders for the request dates and lists the items necessary to fill the order.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to Chapter 6, 
“Working With Sage DacEasy Business Center Pages” in the Sage DacEasy 
Business Center Guide.

To Print the Production Schedule Report

1 Choose Production Schedule on the Reports menu. The Production 
Schedule Report dialog box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

4 Select the Include RMAs check box if you want to include these transactions 
on the report.
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5 Click OK. The Report Layout dialog box appears. 

6 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Production Schedule Report

Order Status Report
The Order Status report provides detailed information on the orders entered 
into the current company. Use this report to get a hard copy of the same 
information found using the Order Status Inquiry feature. You can print the 
Order Status report in either detail or summary format. The detail Order Status 
report prints all products and services entered on each order, whereas the 
summary Order Status report prints the order number and type, customer code 
and name, order date, request date, ship date and the order status.

When printing the Order Status report, the program pulls the information from 
the Order files. For each order printed, this report prints the associated status of 
the order. The order status that prints is the same as the status that appears on 
the Order Entry dialog box.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to Chapter 6, 
“Working With Sage DacEasy Business Center Pages” in the Sage DacEasy 
Business Center Guide.
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To Print the Order Status Report

1 Choose Order Status on the Reports menu. The Order Status Report 
dialog box appears.

2 Select whether you want a Detail or Summary Order Status report.

3 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

4 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

5 Click OK. The Report Layout dialog box appears.

6 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Order Status Report
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Filter Order Status report by Order Status

You can selectively include or exclude orders in Order Entry’s Order Status 
Report based on the current status of each order. You can select the check boxes 
in the Report’s front-end to tell Sage DacEasy Order Entry which statues you 
want to include in the report. 

Note: There are four possible order statuses in Sage DacEasy Order Entry. These 
are: New, Complete, Backorder, and Void.

1 Select Order Status from the Reports menu and the Order Status Report front-
end dialog appears:

2 Select the New check box if you want New orders to be included in the 
report;

3 Select the Backorder check box if you want orders with the Backorder status 
to be included in the report;

4 Select the Completed check box if you want completed orders included in 
the report;

5 Select the Void check box if you want Void orders included in the report. 

6 Click OK or press F10 to print the report.

Backorder Status Report
The Backorder Status report prints all backordered items from orders with a 
status of Backorder. Use this report to find orders that are excessively overdue 
for shipping. This report prints the order number, item number, item type, 
order date, requested ship date, days past requested shipping date, customer 
code, units ordered, units shipped, units backordered and quantity available.

You can sort the information on this report either by product or customer. If 
you want a listing of all products that currently reside on backorder in the Order 
files, sort the report by product. If you want a list of all backordered items, listed 
by customer code, sort the report by customer.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to Chapter 6, 
“Working With Sage DacEasy Business Center Pages” in the Sage DacEasy 
Business Center Guide.
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To Print the Backorder Status Report

1 Choose Backorder Status on the Reports menu. The Backorder Status 
Report dialog box appears.

2 Select whether you want to sort the report by Product or Customer.

3 Type the range for the sort in the From and To fields.

4 Click OK. The Report Layout dialog box appears. 

5 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Backorder Status Report

Sales Analysis Reports
One of the most important responsibilities of managing any business is 
analyzing sales reports and making decisions based on the data. The more 
concise the information is on a report, the easier these decisions are for you. 
There are many reports available throughout Sage DacEasy Order Entry, but the 
ones you are sure to use the most are the Sales Analysis reports.

Sage DacEasy acquires the data printed on these reports directly from the order 
and invoice transaction files, which contain complete information about all 
your orders and shipments. Using this information, you can obtain almost any 
sales analysis report you want. You can print three different types of sales 
analysis reports, by Customer, Item or Salesperson.
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To Print the Sales Analysis Report By Customer

The detail Sales Analysis by Customer report is subtotaled by customer, with 
each ordered item listed individually. The summary Sales Analysis by Customer 
report lists total sales information for each customer, including the date of the 
last sale, total sales amount for the year and cost and profit amounts for the year.

1 Point to Sales Analysis on the Reports menu, and then select Customer. 
The Sales Analysis by Customer dialog box appears.

2 Select to print a Detail or Summary report.

3 Type the range of dates you want included on the report if you selected 
Detail as the Report Type.

4 Select how you want to sort the report if you selected Summary as the 
Report Type. If you selected Detail as the Report Type, the sort defaults to 
Customer Code. You can change the sort if necessary.

5 Type the range for the sort in the From and To fields.

6 Select how you want to rank the report and type the range for the rank in the 
From and To fields if you selected Summary as the Report Type.

7 Click OK. The Report Layout dialog box appears.

8 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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Sales Analysis Report By Customer

To Print the Sales Analysis Report By Item

The Sales Analysis by Item report provides sales analysis for all items (products, 
services and billing codes) included on your invoices. The detail Sales Analysis 
by Item report is subtotaled by item, with each customer who ordered the item 
listed individually with other order information. The summary Sales Analysis by 
Item report lists total sales information for each item ordered, including the 
item number, GL department, item description, date of the last sale, the 
quantity sold for the year, the average sales price, total sales amount for the year 
and cost and profit amounts for the year.

1 Point to Sales Analysis on the Reports menu, and then select Items. The 
Sales Analysis by Item dialog box appears.

2 Select to print a Detail or Summary report.

3 Type the range of dates you want included on the report if you selected 
Detail as the Report Type.

4 Select how you want to sort the report if you selected Summary as the 
Report Type. If you selected Detail as the Report Type, this field defaults to 
Product Code. You can change the sort if necessary. Type the range for the 
sort in the From and To fields.
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5 Select how you want to rank the report and type the range for the rank in the 

From and To fields if you selected Summary as the Report Type.

6 Click OK. The Report Layout dialog box appears.

7 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Sales Analysis Report By Item

To Print the Sales Analysis Report By Salesperson

The Sales Analysis by Salesperson report provides sales analysis of your sales 
staff. The detail Sales Analysis by Salesperson report is subtotaled by item, with 
each customer who ordered the item listed individually with other order 
information. The summary Sales Analysis by Salesperson report lists sales and 
commission by period to date and year to date. You can select to run the detail 
Sales Analysis by Salesperson report by orders or shipments. The summary Sales 
Analysis by Salesperson report only uses shipment (invoice and sales return) 
information.

1 Point to Sales Analysis on the Reports menu, and then select Salesperson. 
The Sales Analysis by Salesperson dialog box appears.

2 Select to print a Detail or Summary report.
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3 Select if you want a report on Orders or Shipments in the Report On field, if 

you selected Detail in the Report Type field. If you selected Summary in the 
Report Type field, the report is limited to Shipments.

4 Type the range of dates you want included on the report.

5 Select how you want to sort the report if you selected Detail as the Report 
Type. If you selected Summary as the Report Type, the sort is limited to 
Salesperson.

6 Type the range for the sort in the From and To fields.

7 Select how you want to rank the report and type the range for the rank in the 
From and To fields if you selected Detail as the Report Type

8 Click OK. The Report Layout dialog box appears.

9 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Sales Analysis Report By Salesperson
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Product Listing

The Product Listing report gives you a detailed catalog of your products. The 
following information prints on the Product Listing report: product code, 
description, primary vendor and part number, department, bin, warehouse 
code, purchase fraction and measure, sales fraction and measure, minimum and 
reorder amounts, sales price, last sale date, last purchase price, last purchase 
date, standard cost and average cost.

To Print a Product Listing Report

1 Choose Product Listing on the Reports menu. The Product Listing dialog 
box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

4 Click OK. The Report Layout dialog box appears. 

5 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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Product Listing

Product Activity Report
Sage DacEasy Order Entry includes a Product Activity report that is similar to 
the one you can print in Sage DacEasy Accounting. This report prints data based 
on the information stored in the Edit Product dialog box, including sales and 
purchase fractions, on hand units and dollars and the year-to-date cost and 
profit dollar amounts. This report is sometimes also referred to as the Product 
History report.

The report serves a number of purposes, including the following:

• Obtains a snapshot view of your current inventory status with units, 
dollars and historical figures

• Analyzes the profitability of certain product lines

• Compares the turnover rate of your products

To Print a Product Activity Report

1 Choose Product Activity from the Reports menu. The Product Activity 
Report dialog box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.
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3 Select how you want to rank the report and type the range for the rank in the 

From and To fields.

4 Select the Exclude Non-Inventory Products check box if you do not want 
to include these items on the report.

5 Click OK. The Report Layout dialog box appears. 

6 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Product Activity Report

Product Activity Detail Report
Sage DacEasy Order Entry includes a Product Activity Detail report that is 
similar to the one you can print in Sage DacEasy Accounting. This report prints 
data based on the information stored in the Edit Product dialog box, including 
item number, invoice number, warehouse, item description, quantity sold or 
returned, cost, extended amount, balance quantity and balance dollars. You 
must post shipments before printing this report in order to get the most up-to-
date detail on your product activity.
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Note: You must select the Track Product Transaction History check box on the 
Transactions tab of the System Preferences dialog box to view all product 
activity on this report.

To Print a Product Activity Detail Report

1 Choose Product Activity Detail on the Reports menu. The Product 
Activity Detail Report dialog box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Type the range for the rank, which defaults to Transaction Date, in the From 
and To fields.

4 Select how you want the product units to appear on the report, by Decimal or 
by Fraction.

5 Select the Exclude Non-Inventory Products check box if you do not want 
to include these items on the report.

6 Click OK. The Report Layout dialog box appears. 

7 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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Product Activity Detail Report

Inventory Adjustments Listing
Use the Inventory Adjustments Listing to print the Inventory Adjustment 
transactions. This report pulls information from the Product Activity Detail file.

To Print an Inventory Adjustments Listing

1 Choose Inventory Adjustments from the Reports menu. The Inventory 
Adjustments dialog box appears.

2 Select how you want to filter the information that prints on the Inventory 
Adjustments Listing and type the range in the From and To fields. If you want 
to filter out more information, select a second field and type the range in the 
From and To fields.

3 Click OK to view the Report Layout dialog box.

4 Select your target and click OK to begin printing.

Related Help Topic

• Using the Report Layout dialog box
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Inventory Adjustments Listing

Master Item Activity Report
Sage DacEasy Order Entry includes a Master Item Activity report that is similar 
to the one you can print in Sage DacEasy Accounting. This report prints data 
based on the master item. This information includes the on hand units and 
dollars, number of committed units, number of available units and the cost for 
the item. The information on this report pulls from the Master Item and 
Product files.

To Print a Master Item Activity Report

1 Choose Master Item Activity on the Reports menu. The Master Item 
Activity Report dialog box appears.

2 Select whether you want to print a Detail or Summary report.

3 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

4 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

5 Click OK. The Report Layout dialog box appears. 

6 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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Master Item Activity Report

Merging Customer Info with Microsoft Word
Sage DacEasy’s seamless integration with Microsoft Word allows you to merge 
your customer data with Microsoft Word documents. Use this feature to create 
professional letters that include your customer information. You can e-mail or 
print these documents directly from Sage DacEasy or access the document in 
Word to take advantage of the powerful features that Word offers. You can 
merge a single record or a range of records. For more information on merging 
a single customer record with a Word document, refer to the Help topic titled 
“Integrating with Microsoft Word.” Follow the steps provided here to merge a 
range of customer records with a Word document.
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To Merge a Range of Customer Records With a Word Document

1 Select Mail Merge from the Reports menu. The Customer Mail Merge 
Jobs dialog box appears.

2 Type the name of the job in the Job Name field or click LookUp to select an 
existing job.

3 Use the Main Document field to select the Word document that contains the 
information that stays the same for each version of the merged document. 
You can select an existing Word document, add a new Word document, or 
edit an existing document.

Note: If you selected an existing job, the last associated main document file 
name appears automatically.

To select an existing Word document—Type the path and file name to an 
existing Word document or click the Browse button to locate the document. 
If the document is not located in the folder that contains your company’s data 
files, the Word document is copied to the company folder.

To add a Word document—Type a path and file name, and then click Edit. 
Sage DacEasy creates a new Word document in the company folder. The new 
document appears in Word. Edit the document as necessary, save the 
document, and then return to Sage DacEasy to continue with the mail merge.

To edit an existing Word document—Type the path and file name to  the 
existing Word document or click the Browse button and locate the 
document. Click Edit; the document appears in Word. Edit the document as 
necessary, save the document, and then return to Sage DacEasy to continue 
with the mail merge.

Access the Customer Mail
Merge Jobs dialog box to

merge a range of customers
with a Word document.
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4 Complete each field in the Filter/Sort Options area.

The Closing Date field is used when date sensitive merge fields are included in 
the document or as the Sort By or Rank By fields. For example, if you select 
Past Due >60 Balance as a merge field, Sage DacEasy uses the closing date to 
determine if the balance is more than 60 days past due.

Select the Exclude Records Without an Address check box if you do not 
want to include the record in the mail merge if it does not contain an address.

Select the Exclude Records Without an E-mail Address check box if you 
do not want to include the record in the mail merge if it does not contain an 
e-mail address.

Select the Suppress Blank Lines check box if you want to skip blank lines 
resulting from empty merge fields.

5 Merge the selected data with the Word document using any of the following 
methods.

Click Send E-mail to e-mail the Word document to a range of customers.

Click Print to send the output to your printer.

Click View Job to view the output in Microsoft Word.

Customer Labels
Sage DacEasy Order Entry allows you to print mailing labels for your customers. 
Customer code, name, contact, address, city, state and zip code are included on 
the printed labels. You can also customize the label to include the customer 
code, telephone number and other fields.

To Print Customer Labels

1 Choose Customer Labels on the Reports menu. The Customer Labels 
dialog box appears. Click Help for more information on each field.

2 Type the closing date to indicate the last day to include activity for the labels.

3 Select whether you want to print the customer labels for a range of customers 
or select certain customers in the file.

4 Select how you want to sort the customer labels and type the range for the 
sort in the From and To fields.

5 Select how you want to rank the customer labels and type the range for the 
rank in the From and To fields.

6 Complete the remaining fields if necessary.
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7 Click OK. 

If you chose Select as the Scope, a list of customers appears. All records 
within the range specified display a Y in the Selected column. This indicates a 
label will print for the customer. If you do not want to print a label for the 
selected record, select the record and click Select. If an N appears in the 
Selected column, a label will not print for the customer. After you have 
selected all the records you want, click OK to continue. The Report Layout 
dialog box appears.

If you selected Range as the Scope, the Report Layout dialog box appears.

Tip: For more information on editing the label layout, refer to the Help topic 
titled “Editing the label layout.”

To check to ensure your labels are loaded properly in your printer and your 
printer settings are correct, click Test Page.

8 Select your target and click OK to generate the report.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Editing the label layout

• Selecting form templates

• Aligning continuous-feed forms

Product Labels
Sage DacEasy Order Entry allows you to print labels for your products. Product 
code, description, bin, sales measure, department and sales price are included 
on the printed labels. You can also customize the label to include your vendor’s 
code, vendor’s product code and other fields.

To Print Product Labels

1 Choose Product Labels on the Reports menu. The Product Labels dialog 
box appears. Click Help for more information on each field.

2 Select whether you want to print product labels for all products, a range of 
products or select certain products using the Scope field.

3 Type the range of products you want to print or select from in the From and 
To fields if you selected Range or Select as the Scope.

4 Complete the remaining fields if necessary.
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5 Click OK. 

If you chose Select as the Scope, a list of products appears. All records within 
the range specified display a Y in the Selected column. This indicates a label 
will print for the product. If you do not want to print a label for the selected 
record, select the record and click Select. If an N appears in the Selected 
column, a label will not print for the product. After you have selected all the 
records you want, click OK to continue. The Report Layout dialog box 
appears.

If you selected Range as the Scope, the Report Layout dialog box appears.

Tip: For more information on editing the label layout, refer to the Help topic 
titled “Editing the label layout.”

To check to ensure your labels are loaded properly in your printer and your 
printer settings are correct, click Test Page.

6 Select your target and click OK to generate the report.

Related Help Topics

• Using the Report Layout dialog box

• Editing templates

• Editing the label layout

• Selecting form templates

• Aligning continuous-feed forms

Media Code Tracking Report
The Media Code report provides a breakdown of your sales by media code, 
which allows you to analyze the effectiveness of your marketing efforts. The 
Order Entry dialog box includes a field labeled Media Code. Use this field to 
enter a media identifier for each order. If you have started a media campaign, 
such as an advertisement in an industry magazine, use this field to track the sales 
generated from the advertisement.

It is imperative that you standardize the use of media codes in Sage DacEasy 
Order Entry. Media codes are not verified as you enter orders. Prepare a list of 
media code values and use the Sales Order report to verify that your order entry 
personnel are entering the correct media code values. For example, if you place 
an advertisement in PC Magazine, you might establish PCMAG as the media 
code value to use for tracking sales generated from the ad. Enter PCMAG in the 
Media Code field for all orders that are a result of the ad. If you enter different 
values on different orders, such as PC or PCM, the media code tracking report 
separates each of these into a separate media category.
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To Print the Media Code Report

1 Choose Media Code Tracker on the Reports menu. The Media Code 
Report dialog box appears. Click Help for more information on each field.

2 Type the range of dates you want included on the report in the From Date and 
To Date fields.

3 Type the range of media codes you want included on the report in the Sort By 
From and To fields.

4 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

5 Click OK. The Report Layout dialog box appears.

6 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Media Code Report
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General Ledger Listing Report

Every time you post shipments, a general ledger transaction is automatically 
created. This transaction includes the debit and credit entries associated with the 
invoices you are posting. 

Besides building its own General Ledger file, Sage DacEasy Order Entry also 
creates and posts the general ledger transaction to Sage DacEasy Accounting if 
you are interfaced. If you are interfacing with Sage DacEasy Accounting, Sage 
DacEasy Order Entry uses the account numbers set up on Sage DacEasy 
Accounting’s Account Interface dialog box to make the general ledger entry in 
Sage DacEasy Accounting.

If you are not running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, Sage DacEasy Order Entry uses internal account numbers for these 
general ledger entries. These account numbers are for reference only. 

The General Ledger Listing report lists each transaction’s debit and credit 
entries, along with totals for each transaction. Use this report if you are not 
running Sage DacEasy Order Entry interfaced with Sage DacEasy Accounting, 
but still need a list of the general ledger transactions so you can record these 
entries into your own bookkeeping system.

Note: The General Ledger Listing report in Sage DacEasy Order Entry only 
prints general ledger transactions with a journal code of OE, AS or IA. If you are 
running Sage DacEasy Order Entry interfaced with Sage DacEasy Accounting, 
you can run a General Ledger Listing report in Sage DacEasy Accounting to get 
a list of all general ledger transactions. 

To Print the General Ledger Listing Report

1 Choose General Ledger from the Reports menu. The General Ledger 
Transactions dialog box appears.

2 Type the date range for the report in the From Date and To Date fields.

3 Click OK. The Report Layout dialog box appears.

4 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box
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General Ledger Transactions Report

Printing Bar Codes
By using Sage DacEasy Order Entry to print bar codes on labels or stickers, you 
can place them on your products and scan the code into orders automatically 
using a bar code scanner.

Sage DacEasy Order Entry supports several bar code types, including: UPC-A, 
UPC-E, EAN/JAN-13, EAN/JAN-18, Code 3 of 9 and Code 128. In order to 
print bar codes, you must have a laser printer or a dot matrix printer capable of 
printing in graphics mode. To set up your printer for bar code printing, use the 
Edit Default Printer dialog box.

When printing bar codes, Sage DacEasy Order Entry gives you great flexibility 
for size, spacing and format of the codes. Additionally, you can include two of 
the following fields to print below the bar code, product/service code, item 
description, bin, sales price, sales measure, vendor code and vendor item 
number.

To Print Bar Codes

1 Choose Bar Codes on the Reports menu. The Select Bar Codes dialog box 
appears.

2 Select either Products or Services. The Print Bar Codes dialog box appears.

3 Select how you want to sort the bar codes and type the range for the sort in 
the From and To fields.
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4 Select the Bar Code Source option if printing product bar codes. If printing 

service bar codes, Service Code is automatically selected.

5 Select the first description field you want printed under the bar code in the 
Print Field 1 field. Select the second description field you want printed under 
the bar code in the Print Field 2 field.

6 Designate how many bar code labels you want to print using the Copies 
from Quantity Available check box or the Number of Labels per Item field.

7 Select the appropriate options in the Bar Code Setup area as needed. This 
area holds information such as printing the checksum, the bar code height 
and the label and bar code type.

Tip: For more information on editing the label layout, refer to the Help topic 
titled “Editing the label layout.”

8 Click OK. The Report Layout dialog box appears.

9 Select your bar code printer on the Printer tab, and then click the Fonts tab.

10 Select the font you want to use for the bar codes.

Note: When printing bar codes to a thermal bar code printer you must set up 
the custom paper size. To do this, click the Page tab on the Report Layout 
dialog box. Select Custom Size as the Paper Size and enter the Width and 
Height accordingly for one single label.

11 Select your target and click OK to generate the bar codes.

Related Help Topics

• Using the Report Layout dialog box

• Types of bar codes supported

• Editing the label layout

Promotional Price Report
The Promotional Price Listing report prints the transactions entered using the 
Edit Promotional Price dialog box. All items entered with a promotional price 
remain in the file until purged using the Purge routine.
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To Print the Promotional Price Listing Report

1 Choose Promotional Price from the Reports menu. The Promotional Price 
Report dialog box appears.

2 Select how you want to sort the report and type the range for the sort in the 
From and To fields.

3 Select how you want to rank the report and type the range for the rank in the 
From and To fields.

4 Click OK. The Report Layout dialog box appears.

5 Select your target and click OK to generate the report.

Related Help Topic

• Using the Report Layout dialog box

Promotional Price Report
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• Custom Reporting •

Overview
Reporting is one of the most important aspects of any business because reports 
inform you of the stability and profitability of your business. Sage DacEasy 
includes a custom reporting feature, called DacAccess, that gives you the ability 
to create informative reports to fit your specific needs. There are two steps to 
creating a custom report: selecting the records included in the report using the 
Query and defining the layout of the report using the Publisher.

The Query lets you choose up to ninety-six fields from multiple files to include 
on a report. The Publisher lets you create the report format, using fields selected 
in your Query. With the Query and Publisher, you can create listing reports with 
unprecedented detail. In addition, the Query and Publisher include many 
default reports ready for you to use.

Data is organized in a hierarchy from general to specific. Each level is defined in 
the list provided.

Follow these steps to create
a custom listing report

using DacAccess.
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Terms Used in This Chapter

• Catalog - A catalog is the largest grouping of data. It contains an 
associated group of files that contain related fields. For example, the 
Employee Listings catalog contains files such as Employees, 
Transactions, Time Card Entries, Detail Pay History, Departments and 
Codes.

• File - A file is a group of associated records. For example, information 
about individual employees is in the Employee file.

• Record - A record is a group of related fields. For example, all the 
information found on the Edit Employee Information and Edit 
Employee Accumulations dialog boxes for one employee is considered 
a record.

• Field - A field is the lowest level of data. A field is each piece of 
information that makes up a record. For example, the Title field on the 
Edit Employee Information dialog box is part of the employee record.

Fields are referred to in the Query and Publisher because you select 
fields to include on your report.

• Variable - A variable is a placeholder or merge field which pulls 
information from a specified file.

This figure illustrates the
terms used to define data

when creating a query.
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Using the Query

The first step in generating a custom report is to choose the information you 
want to include on the report using the Query in DacAccess. Go to the Query by 
choosing Query on the DacAccess menu. Use this feature to create a query with 
information from a variety of fields in several different files. You can even create 
user defined fields with calculated totals using information pulled from multiple 
files. 

A query is a way of questioning or filtering a database. For example, you have a 
collection of records in your Employee file. You may want to print a report that 
filters out deductions made from gross earnings in the last pay period. The 
remaining list of deductions—those deductions not used in the last pay 
period—is the data set you want to use in a report. In addition to limiting the 
records you want to print on a report, you also use queries to select the specific 
fields you want on a report, to sort the records and to create user defined 
calculations.

The Query Design dialog box is divided into three main areas, the Header area, 
Column Selection area and the Sort Columns area. The Header area includes the 
fields for the Query name and catalog. The Column Selection area is where you 
select the fields and the criteria determining which records to pull for the query. 
The Sort Columns area is where you set the sorting order of the report. 



Using the Query
Using the Query Checklist

171

8

Using the Query Checklist

 Step 1—Complete the Header area with the query name and catalog.

 Step 2—Select the fields for the query in the Column Selection area. Enter 
user defined fields and set criteria for the fields if necessary.

 Step 3—Set the sorting order in the Sort Columns area.

 Step 4—Run the query to create a report listing the selected records.

Completing the Header Area

When you access the Query Design dialog box, you must enter a unique name 
for the query. When you give the query a name, a list of all available catalogs 
appears. A catalog holds associated files that contain related fields. For example, 
the Banking catalog includes the Employee, Check Register, Detail, Payroll 
History, Departments and Department Detail files.
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Selecting Fields in the Column Selection Area

After you select a catalog, advance to the Column Selection area and choose 
fields from the files in the catalog. You do not have to include all fields in the 
query in the report layout. However, to use a field in a user defined column or 
for sorting purposes, you must select the field in a column. For example, you 
may select review date in your query so you can sort your records on the report 
by the employee’s review date. However, you do not care to see the review date 
on the report. Therefore, even though you include the field on the query, you do 
not use that field when you create the report layout in the Publisher.

Each column on the Query Design dialog box can hold a field from a file in the 
catalog. You can fill up to ninety-six columns with field information. The 
columns scroll as you move to the right. Press Home to quickly return to the 
first column. The first row of the Column Selection area displays the names of 
the fields you select for the query. 

Selecting the Sort Order for the Query

Once you select your fields and set the criteria, you can specify the sorting order 
for the records included in the query. The sort fields define the order in which 
the records appear on the report. You have up to four sorting levels. If you do 
not specify a sorting order, Sage DacEasy sorts by the field in the first column.

Use the Header area of the
Query Design dialog box to
enter the query name and

select a catalog.

Select the fields and records
to include on the query in

the Column Selection area.
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To Create a Query

1 Select Query from the DacAccess menu. The Query Design dialog box 
appears.

2 Assign the query a unique name (up to 14 characters). If you are editing an 
existing query, type the name of the query or click LookUp and select the 
query from the list.

3 Select the catalog that contains the files you need for the report. The cursor 
advances to the first row of the Column Selection area. Use this row to select 
the fields to include in the query.

The columns scroll as you move to the right. You can press Home to return to 
the first column.

4 Click LookUp to view the Table LookUp. Select the table that contains the 
field to include in the current column and the Column LookUp appears. Select 
the field to include in the current column.

Tip: In addition to selecting fields from the data files, you can create formulas 
to include on the report. For more information, refer to “Creating User 
Defined Fields” on page 174. Each field included in the user defined field 
must be included in the query, in addition to any fields selected as sort fields. 
You can exclude the field from the printed report using the Publisher. 

Note: When you click LookUp from the Column Selection area, the Column 
LookUp appears for the last Table that was selected. To select a field from a 
different table, click the Close button to return to the Table LookUp.

5 To edit the Column Heading on the printed report, click Options, and then 
select Edit Column. You can edit the Title field; however, the new column 
title only appears when you run the query and does not appear on the Query 
Design dialog box.

Use the Sort Columns area
to indicate the order you
want the information to

appear in the query.
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6 If necessary, limit the records to include on the query. The second and third 

rows in the Column Selection area determine which records to include on the 
report. If you leave these rows blank, Sage DacEasy includes all records in the 
query. For more information, refer to “Limiting Records on a Query” on page 
175.

7 If you want to set the sorting order, click Options, and then select Sort 
Columns. The cursor advances to the first field in the Sort Columns area. 
Click LookUp and select the primary sort field for the report. To add a 
secondary sort, enter a different field in the second field in the Sort Columns 
area. You can enter up to four sort fields. 

Note: If you do not specify a sorting order, Sage DacEasy sorts by the field in 
the first column.

Tip: Click Switch Sort to toggle between ascending and descending order 
for the selected sort field.

8 Click Run Query to view the query to the screen. Click the Close button to 
return to the Query Design dialog box.

Tip: To redirect the report to the printer, click Print while viewing the query 
on the screen.

9 Click OK to save the query.

Note: Use the Publisher to define the report layout and view subtotal and 
grand total amounts. For more information on the Publisher, refer to “Using 
the Publisher” on page 181.

Creating User Defined Fields

Besides selecting predefined fields from a file for your query, you can also define 
your own fields. By creating user defined fields, you can calculate mathematical 
operations using one or more fields. 

For example, if you wanted to calculate Social Security liabilities for tax 
purposes, you could define a field called SS_WH_and_Liab and enter a formula 
of SOCSECWHQTD (Social Security withholding, quarter to date) + 
SocSecLiabQTD (Social Security liability, quarter to date). Before you can use a 
field in a formula for a user defined field, you must first select the field as a 
column in the Column Selection area on the query. 

To create a user defined field, place the cursor in a column in the Column 
Selection area. Click Options, and then select Edit Expressions. The User 
Defined Field dialog box appears.
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To Create a User Defined Field

1 Click Options and select Edit Expression from the Column Selection area on 
the Query Design dialog box. The User Defined Field dialog box appears. 

2 Type a name and description for the user defined field.

3 Type the expression. To select a field, enter the field name or click LookUp 
and select the field from a list. For example, to divide the current balance by 
12, enter Current Balance/12.

Note: To use a field in a formula, you must first select the field as a column. In 
addition, the field must be a decimal or numeric field. 

4 Click OK to save the user defined field.

Note: Once the user defined field has been created it is added to the User 
Defined Fields table and can be added to the query.

Limiting Records on a Query
The second and third rows in the Column Selection area on the Query Design 
dialog box determine which records to include on the report. If you leave these 
rows blank, Sage DacEasy includes each record in the query. You can limit 
records in a query by entering criteria and by editing the join.

To limit records by entering criteria, enter a particular field value or conditions 
that must be met in order for a record to be included in the query.

Use the User Defined Field
dialog box to calculate

values needed for a custom
report.
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When you create a query that pulls from two files, the query includes only those 
records that include the join field. The join field is used to tie multiple files 
together. For example, the department number exists in both the Employee file 
and the Department file, allowing you to create a query that pulls information 
from both of these files. The program defaults to an equi-join; however, you can 
edit the query to include all of the records from one file plus the records from 
the second file that include the join field.

Establishing Criteria

When you select fields for your query, you are limiting the information to 
include in the query. You can further limit the records included on the report by 
placing criteria on the fields. You can enter a value as the criterion, indicating 
only fields that contain this value are included in the query. You can also enter 
an expression using logical operators to indicate the fields to include in the 
query. 

For example, to include employees with a review date of 05/15/2003 or prior, 
select Review Date (ReviewDate) as a field and enter <=05/15/2003 (less than or 
equal to 05/15/2003) as the criterion. The logical operator table provided lists 
the available operators and an example of how to use each.

You can enter multiple criteria on a single query. The relationship of your 
criteria depends on the rows in which you enter the criteria. There is an OR 
relationship between rows and an AND relationship between columns. Sage 
DacEasy satisfies all AND criteria before satisfying the OR criteria.
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Understanding AND/OR Logic

The placement of your criteria in the columns and rows is very important. There 
is an OR relationship between rows and an AND relationship between columns. 
Sage DacEasy satisfies all AND criteria before satisfying the OR criteria.

Use the rows and columns
in the Column Selection

area to establish criteria for
the query.

Using the example above,
AND logic means that

records have to meet both
the criteria for city and

review date in order to be
included in the query.
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For example, if you use the Employee Listings catalog and want to include 
employees that live in Dallas OR that have a review date before May 15, 1999, 
you would enter the column selections and criteria as shown in Figure 8-12. This 
would give you a query including both all the employees in Dallas in addition to 
all the employees with a review date before May 15, 1999 (records that meet 
both criteria are not duplicated). 

On the other hand, if you use the Employee Listings catalog and want to include 
employees that live in Dallas AND that have a review date before May 15, 1999, 
you would enter the column selections and criteria as shown in Figure 8-13. This 
would give you a query of all the employees in Dallas with a review date before 
May 15, 1999. 

Using the example above,
OR logic means that records

have to meet either the
criteria for city or the

criteria for review date to
be included in the query.

Query selections for
employees that live in Dallas

or have a review date
before May 15, 1999.
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Understanding Joins

A join is a link between two files. For example, assume you want to print a report 
pulling the employee code, employee name and 401k deductions for the pay 
period. The employee name is stored in the Employee file and the employee’s 
401k deductions for the pay period are found in the Transaction file. The 
employee code is found in both files. Therefore, employee code is the link 
between the two files or the join.

There are three different types of joins: equi, left outer and right outer.

• Sage DacEasy uses the equi-join by default, which includes only records 
found in both files. Using the example above, Sage DacEasy only 
includes employees with an entry found in both the Employee file and 
the Transaction file.

• If you select a left outer join, the query includes all records from the 
first file and only those records in the second file where the joined fields 
are equal. Using the same example, the query would include all records 
in the Transaction file and only the records from the Employee file that 
have an entry in the Transaction file.

• If you select a right outer join, the query includes all records from the 
second file and only those records in the first file where the joined fields 
are equal. Following the same example, the query would include all 
records in the Employee file and only records from Transactions file 
that have an employee code.

Query selections for
employees that live in Dallas

and have a review date
before May 15, 1999.

Query selections for
employees that live in Dallas

and have a review date
before May 15, 1999.
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To Limit Records on a Query

1 Position your cursor in the appropriate box below the field used to limit the 
query. There is an OR relationship between rows and an AND relationship 
between columns. Sage DacEasy satisfies all AND criteria before satisfying the 
OR criteria.

2 Enter the criterion for the field. 

Enter a value in the field to include only those records that have the specified 
value in this field. 

To specify a range of records based on a particular expression, enter the 
expression. You can click LookUp to select an operand. For example, to 
include all records greater than or equal to 1000, click LookUp, select >=, 
and then type 1000.

Tip: You can enter up to 18 characters in the column. If you need to enter a 
longer expression, click Options and select Zoom. The cursor advances to the 
Zoom field where you can enter up to 68 characters.

Note: The format used to enter data in an expression depends on the field 
type. Click Options and select Edit Column to view a field’s Data Type.

3 If you selected fields from two different files and want to edit the join, click 
Options and select Edit Join. The Join Editing dialog box appears. Select 
the type of join and click OK to return to the Query Design dialog box.

Printing the Query

When you run the query, the results appear on the screen. To direct your output 
to the printer, click Print. Printing your query may be helpful as you build your 
query. You can print the information to make sure you are pulling the correct 
data before you create the report layout using the Publisher.

Use the Join Editing dialog
box to select the type of

join you want for the
report.
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To Print the Query

1 Choose Query on the DacAccess menu. Enter a query name or click LookUp 
to select a query from a list.

2 Click Run Query. The query appears on the screen.

3 Click Print. The Report Layout dialog box appears.

4 Select your target and click OK to begin printing.

Note: The columns on the Query report vary in width depending on whether 
you have renamed a column title or have accepted the default name. From 
the Query Design dialog box, click Options, and then select Print Format 
to print the Query format. This information is helpful when trying to 
determine the size of a column.

Related Help Topic

• Copying queries

Query List

Using the Publisher
The Publisher is the tool you use to create your report layout and print a custom 
report using a query. When you first access the Publisher, you see the Report 
Editor dialog box. The top portion of the dialog box is for the report name and 
data source. The data source is the query you use to select the fields from for the 
report. Once you have selected a query as the data source for a report, you 
cannot change the data source. 

Note: If you need to use a different query as the data source for the report, you 
must create a new report layout using the Publisher.
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The body of the Report Editor has four sections, the Page Header area, Detail 
area, Group Footer area, and Report Footer area. Use the Page Header area to 
enter the information that prints on the top of each page. Use the Detail area to 
make your field selections for the report. The Group Footer area lets you create 
subtotals for your sort breaks and the Report Footer area lets you create grand 
totals for the report.

You can enter text into each of the four sections of the report or select from 
available variables such as query fields, company information fields and control 
options. You can use different variables in different areas of the Report Editor. 
The fields you chose in the query are available in all sections of the Report 
Editor. If a field you want to include on the report is not included in the query 
selected as the data source, you must save the report layout, exit the Publisher, 
access the query and add the necessary field to the query. Save the query and go 
back to the Publisher to complete the report layout.

Use the Report Editor to lay
out the fields on the report.
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Using the Publisher Checklist

 Step 1—Complete the Header area with the report name and the name of 
the query you want to use as the data source. Enter your report heading 
and column headings in the Page Header area.

 Step 2 —Complete the Detail area with the query fields you want to 
include on the report.

 Step 3 —Complete the Group Footer area if you want subtotals on the 
sorts. 

 Step 4 —Complete the Report Footer area if you want to report grand 
totals.

 Step 5 —Preview and print the final report.

Completing the Header and Page Header Area

The Header area contains a field for a report name and a query name. The fields 
available for the report depend on the query you select. Once you choose a 
query, you cannot change the query name in the Publisher. However, you can 
edit the query if you need to use different fields on the report. The Page Header 
area holds the report heading. The report heading prints at the top of each page 
of the custom report.

Use the Page Header area
of the Report Editor dialog
box to lay out report titles

and column headings.
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Completing the Detail Area

The Detail area is the body of the report. This is where you select fields from 
your query. You can enter either text or place fields in this section. You may 
want to enter text as a note, instructions or to describe the fields.

Completing the Group Footer Area

The Group Footer is for sort subtotals. If you set a sorting order in the query, 
you may want each sort group to have a total for the group. For example, when 
printing a commission report, you may want a total per salesperson. You can 
enter text to describe the total, and then place the field you want totaled in this 
section. If you do not want sort totals, leave this section blank.

Completing the Report Footer Area

The Report Footer area is for grand totals. You can also enter text into this area. 
This area is similar to the Group Footer. Select the fields from your query you 
want to include as grand totals for the report. 

Use the Detail area of the
Report Editor dialog box to
select fields from the query.

Use the Group Footer area
to print subtotals for each

sort on the report.
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To Create a Custom Report With the Publisher

1 Select Publisher on the DacAccess menu. The Report Editor dialog box 
appears.

2 Enter a unique name for the report, and then press Enter. The Report 
Defaults dialog box appears. 

3 Complete each field on the Report Defaults dialog box.

4 In the Data Source field, enter the query name from which you want to create 
the report or click LookUp and select the query from a list.

Note: The query details the information to include on the report and must be 
created before the report can be laid out in the Publisher. 

5 Type a heading for the report in the Page Header area. You can enter text or 
click LookUp and select a variable from a list.

Note: You can select the following types of variables: Company Text, Control 
Fields and Query Fields. Company Text allows you to select variables 
corresponding to the information you entered about your company. Control 
Variables include the current program date, time and page number. Query 
Fields selected in the Page Header area are inserted as text fields to be used as 
column headings.

Tip: Click Options and select Center to center the lines of text or variables 
on the report.

6 Insert the query fields to include on the report in the Detail area. You can type 
text or place fields in this section. 

To insert a query field, click LookUp and select the field from a list. If you 
need to include a field that is not in the list, you must edit the query. The field 
is inserted at the cursor position. You can use the mouse to drag a query field 
to a different location. 

Continue placing fields into this section until all necessary fields are on the 
layout. It may take some trial and error to line up the fields with your column 
headings. 

Use the Report Footer area
to print grand totals on the

report.
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7 If you set a sorting order in the query, you may want each sort group to have 

a total. To include a subtotal on sorted fields, type text to describe the total, 
and then place the field you want totaled in the Group Footer area. If you do 
not want sort totals, leave this section blank.

Note: If no fields are selected in the Sort Columns area on your query, Sage 
DacEasy uses the field in the first column of the query as the sort field.

8 To include grand totals on the report, select each field to total in the Report 
Footer area. You can also type text in this section. 

Tip: Press Enter from any field to edit the formatting. The Field Edit dialog 
box appears. Click Help from this dialog box for a detailed description of each 
formatting option.

Previewing and Printing the Final Report

When you print the report, the information specified by the query appears using 
the layout created in the Publisher’s Report Editor. You can print to the screen 
to preview the report and verify the format. If it is not correct, edit the layout 
and print the report again.

To Print the Report

1 Choose Publisher on the DacAccess menu. The Report Editor dialog box 
appears. Create a new report or click LookUp to select one from a list.

2 Click Print to view the Report Layout dialog box.

3 Select your target and click OK to begin printing.

Related Help Topic

• Copying report layouts in the publisher
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• Periodic Operations •
This chapter explains operations and routines located on the Periodic menu. 
You should perform these routines on your data at periodic intervals. These 
operations include purging data files, closing the year, changing the serial 
number tracking, changing the customer code and global changes. 

Purging Data Files
Sage DacEasy Order Entry maintains information in various data files for the 
entire year. Even after you perform the Post Shipments routine, Sage DacEasy 
Order Entry retains the order information so you can print sales analysis reports 
and sales listings that include data for the entire year.

However, as the years progress, some files the can become very large as a result 
of holding old data. Sage DacEasy Order Entry provides an easy way to purge 
information from your data files. The Purge routine purges information from 
the files according to the date range specified. 

For example, assume you just closed the year and started processing orders for 
the next year. To remove all posted orders prior to the new year, use the Purge 
routine. To ensure that you remove all orders from the previous year, you 
should perform the Purge routine for all data files using the dates from the 
previous year.

File Descriptions

A brief explanation of the data contained in each file is provided. Review the list 
to determine which files you want to purge and which files include information 
you want to maintain for reporting purposes.

• General Ledger - This file contains all general ledger transactions 
created when Sage DacEasy Order Entry is not interfaced with Sage 
DacEasy Accounting. Sage DacEasy Order Entry assigns its own 
account numbers to the transactions in the General Ledger files. To 
print a listing of general ledger transactions, select General Ledger 
from the Reports menu.

If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, Sage DacEasy Order Entry uses the General 
Ledger files in Sage DacEasy Accounting. To purge the information 
from these files, we recommend you purge the general ledger 
transactions in Sage DacEasy Accounting.
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• Sales Orders - This file contains detail information for all orders 

entered in the program. Sage DacEasy Order Entry maintains the order 
detail in this file, even after you ship orders and post shipments. To 
obtain a printed copy of the contents of this file, choose Sales Orders 
from the Reports menu. Purging Sales Orders also purges the Credit 
Card file.

• Quotes - This file contains the detail of all sales quotes in the company. 
Use the Purge routine to delete old quotes you do not need anymore. 
To print the contents of this file, point to Print Orders on the Process 
menu, and then choose Quotes. 

• Invoices - This file contains all of the invoices created by the orders you 
have shipped. Do not confuse invoices with orders in the program. 
When you ship an order or RMA (Returned Merchandise 
Authorization), Sage DacEasy Order Entry creates a new transaction 
called an invoice or sales return. 

If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, Sage DacEasy Order Entry creates invoices and 
sales returns in your invoice transaction files in Sage DacEasy 
Accounting. You can purge invoices and sales returns using the Purge 
routine in either Sage DacEasy Accounting or Sage DacEasy Order 
Entry. To print the contents of this file before purging, print the Sales 
Listing report in Sage DacEasy Order Entry or the Billing Listing in 
Sage DacEasy Accounting.

• Serial Numbers - Sage DacEasy Order Entry tracks serial numbers for 
your products and services after a sale. Sage DacEasy stores serial 
number information in a separate file from the orders so you can purge 
orders but still track serial numbers. You should only purge this file if 
you do not want to track serial numbers for older sales. If you want to 
track the sale of a serial number at a later time, do not purge this file. 
To print the contents of this file, choose Serial Numbers from the 
Customer Service menu.

• Accounts Receivable Open Invoices - Sage DacEasy Order Entry stores 
the open invoices even after they are paid. You will want to purge the 
older, paid open invoices after they no longer apply to your reports. 
When purging the AR open invoices, a list of open invoices appears so 
you can select the invoices you want to delete. 

If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, you cannot use the Purge routine on AR open 
invoices. You must run the Receivables Period End routine in Sage 
DacEasy Accounting to clear the open invoices from the Aging report 
and statements.
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• Promotional Prices - This file contains the transactions entered using 

the Edit Promotional Price dialog box. Use the Purge routine to delete 
old promotions you do not need anymore. To print the contents of this 
file, choose Promotional Price from the Reports menu.

• Customer Transaction History - If you select the Track Customer 
Transaction History check box on the System Preferences dialog box, 
an entry is recorded in this file each time you enter transactions for 
open invoice customers. Purging this file removes all customer 
historical transaction detail within the date range specified. 

• Assembly Transactions - Purging this file removes all posted or deleted 
assembly transactions within the date range entered. This option 
purges transactions entered using the Assembly Transaction dialog box 
in Sage DacEasy Accounting (if interfaced) and the Order Entry dialog 
box using the Assembly routine.

• Product History Detail - Purging this file removes all product history 
detail through the date range specified.

• Customers - You can purge a range of customers based on the Last 
Sales Date field on the Edit Customer dialog box. All customers 
meeting the requirements are deleted from the system.

• Products - You can purge a range of products based on the Last Sales 
Date field on the Edit Product dialog box. All products meeting the 
requirements are deleted from the system.

• Services - You can purge a range of services based on the Last Sales 
Date field on the Edit Service dialog box. All services meeting the 
requirements are deleted from the system.

• Audit Trail Log- You can purge Audit Trail records- insertions, 
deletions, and modifications of the most relevant master and 
transaction tables in Sage DacEasy. 

• Auto Complete- Today if a user accidentally types something 
incorrectly in an AutoComplete field there is way to correct that 
mistake. 

• Empty Notes- You can now remove note icons from the Lookups 
where the Notes file is empty.
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To Purge files

1 Make a backup of your order entry data files. Archive this backup and keep 
as a record of the information you are purging. If you are running Sage 
DacEasy Order Entry interfaced with Sage DacEasy Accounting, make a 
separate backup of your accounting data files.

2 Choose Purge from the Periodic menu. The Purge Files dialog box 
appears.

3 Select the file you want to purge. 

4 Type the last sales date or range of dates for the information you want 
purged from the data files. 

5 Click OK. The Purge routine begins. 

If you selected to purge the AR Open Invoice file and you are not running 
Sage DacEasy Order Entry interfaced with Sage DacEasy Accounting, a list 
of open invoices appears. Select the open invoices you want to purge and 
click OK. The Purge routine continues. 

Note: Run the Recover routine on your data files after you run the Purge 
routine. The Recover routine compresses your files and frees up hard disk 
space. Choose Utilities from the File menu to access the Recover routine.

Running Year End
The Year End routine updates the historical information in your Customer, 
Product, Service, Salespeople and Tax modules. Sage DacEasy transfers the year-
to-date (YTD) values to the last year (LY) field and last year values to year before 
last (YBL). Values in the Year Before Last fields are removed during the Year 
End routine. The routine also changes the period dates to the new year.

Use the Purge Files dialog
box to select the file you
want to purge and enter

the date range for the
information you want

removed from the file.
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The Year End routine for Sage DacEasy Order Entry is similar to the Year End 
routine in Sage DacEasy Accounting. If you are running Sage DacEasy Order 
Entry interfaced with Sage DacEasy Accounting, you should perform year end 
in Sage DacEasy Order Entry first, and then run the Year End routine for 
Receivables, Payables, Inventory and the General Ledger in Sage DacEasy 
Accounting, however it is not a requirement to run Year End in Sage DacEasy 
Order Entry as it reads the Period’s Table from Sage DacEasy Accounting when 
interfaced.  Therefore, you may run Year End from Sage DacEasy Accounting 
only, when interfaced. 

As mentioned earlier, the information for the year before last is removed during 
year end. If you want to retain this historical information for your customers, 
products and services, make a back up your data files before performing the Year 
End routine. Store the backup for archival purposes.

To Run the Year End Routine 

If you are not running Sage DacEasy Order Entry interfaced with Sage DacEasy 
Accounting, the Year End routine updates the historical information for 
Customer, Product, Service and Tax files. It updates the salesperson history by 
moving the first year Sales and Commission amounts to the second year. Follow 
these steps to run the Year End routine if you are not interfaced with Sage 
DacEasy Accounting. If you are interfaced with Sage DacEasy Accounting, refer 
to the next section titled “To Run the Year End Routine if Interfaced With Sage 
DacEasy Accounting” later in this chapter.

1 Make a backup of your order entry data files. Be sure to clearly label each 
backup disk.

2 Choose Year End on the Periodic menu. The current year appears. Verify 
the year that appears is the one you want to close. 

If the year you want to close does not correspond with the year that 
appears, exit the dialog box and change the program date, and then return 
to the Year End routine.

If the year that appears is correct, click Yes to continue. Sage DacEasy 
Order Entry closes the year.

To Run the Year End Routine if Interfaced with Sage DacEasy 
Accounting

Follow these steps to run the Year End routine if you are interfaced with Sage 
DacEasy Accounting. If you are not interfaced with Sage DacEasy Accounting, 
refer to the previous section titled “To Run the Year End Routine.”
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1 Download all WebStore orders with a date in the year you are closing. Post 

all invoices for the year you are closing. For steps on posting, refer to 
Chapter 5, “Processing Orders."

Note: The easiest way to verify all invoices are posted is to run a Billing 
Listing report based on the Transaction Date for the year you are closing. 
To do this, choose Billing on the Journal menu in Sage DacEasy 
Accounting. Select to print a Listing, and then select TranDate as the 
primary sort. Type the date range of the year you are closing and click OK. 
While viewing the report, if no asterisks appear next to the invoice or 
return number, all invoices or returns are posted.

2 Make a backup of your accounting data files, and then make a backup of 
your order entry data files. Be sure to clearly label each backup disk.

3 Choose Year End on the Periodic menu in Sage DacEasy Order Entry. The 
current year appears. Verify the year that appears is the one you want to 
close. 

If the year you want to close does not correspond with the date that 
appears, exit the dialog box and change the program date. Then return to 
the Year End dialog box.

If the year that appears is correct, click Yes to continue. Sage DacEasy 
Order Entry closes the year.

4 Exit Sage DacEasy Order Entry and access Sage DacEasy Accounting. Refer 
to the Sage DacEasy Accounting User Guide or the Sage DacEasy 
Accounting Help system for steps on running the Year End routine in Sage 
DacEasy Accounting.

Changing Serial Number Tracking
The Change Serial Number Tracking routine lets you change the serial number 
tracking option for your products. If you select the Serial Numbers check box 
on the Edit Product dialog box you can track serial numbers for the item. You 
can record the serial number for the item when you enter an order for the item 
or when you ship an order with the item.

Rather than accessing each product record one-at-a-time to change the serial 
number tracking option, use this routine to quickly change the serial number 
tracking.
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To Change the Serial Number Tracking

1 Choose Change Serial No. Tracking on the Periodic menu. A message 
appears asking whether you want to change the specified items to track 
serial numbers or not to track serial numbers. 

2 Choose the appropriate option. The Change Serial Number Status dialog 
box appears.

3 Select how you want to sort the items and type the range in the From and 
To fields. This determines the list of items selected for the Change Serial 
Number Tracking routine.

4 Select how you want to rank the items and type the range in the From and 
To fields. 

5 Click OK. The Change Serial Number routine begins. The time it takes to 
change the serial number tracking status depends on the number of 
products you are changing. 

Changing Customer Codes
Sage DacEasy Order Entry includes a Change Customer Code feature. This 
feature allows you to change a customer’s code, even if transactions exist for the 
customer. Some businesses use the customer’s phone number as the customer 
code. Therefore, if the customer’s phone number changes, the company needs 
to change their customer’s code.

When you change a customer code, Sage DacEasy Order Entry changes the code 
globally, updating all files that contain activity for the customer. Also, if you are 
running Sage DacEasy Order Entry interfaced with Sage DacEasy Accounting, 
this routine updates all files in Sage DacEasy Accounting that contain records 
using the old code. But, if you have Sage DacEasy Accounting interfaced with 
Sage DacEasy Order Entry and any other add-on module, for example, Sage 
DacEasy Point of Sale, contact Customer Support Services for assistance before 
running the Change Customer Code routine.

Use the Change Serial
Number Status dialog

box to select the range
of items you want

serialized or not
serialized.
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Note: If you are running Sage DacEasy Order Entry interfaced with Sage 
DacEasy Accounting, run the Change Customer Code routine in Sage DacEasy 
Order Entry to ensure all the necessary order transactions and files are updated 
correctly with the new code. If you run this routine in Sage DacEasy Accounting, 
the files specific to Sage DacEasy Order Entry, such as the order transactions are 
not included in the Change Customer Code routine.

To Change a Customer Code

1 Choose Change Customer Code from the Periodic menu. The Change 
Customer Code dialog box appears.

2 Type the current customer code in the Old Customer Code field. If you are not 
sure of the code, click LookUp to select the customer from a list. After 
entering the customer code, the customer’s name appears for verification.

3 Click OK. The Search and Replace Code dialog box appears.

4 Type the new customer code you want assigned to the customer. 

5 Click OK. A message appears confirming you want to continue. Choose Yes 
to continue. Sage DacEasy replaces the old customer code with the new one. 
A message appears when the routine is successfully complete.

6 Click Continue to return to the Change Customer Code dialog box.

7 Click Close to exit the dialog box.

Use the Change Customer
Code dialog box to select

the old customer code you
want replaced with the new

code.
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Making Global Changes

With the Global Changes feature, you can quickly change the information 
stored in certain fields for customers, products and salespeople.

To Make a Global Change

1 Choose Global Changes on the Periodic menu. The Global Changes dialog 
box appears.

2 Select the file containing the records you want to change in the File field.

3 Select the field within the file you want to change in the Change Field list.

4 Type or select the value you want to use to replace the old value in the New 
Value field.

5 Select how you want to specify the range of records for the Global Change 
routine.

6 Type the range of records used for the Global Change routine.

7 Click OK. The Global Change routine begins. A message appears when the 
routine is successfully complete. Click Yes to continue.

Use the Global Changes
dialog box to select the

file you want to change.
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• Alignment - The relative position and orientation of a 
scanner to a bar code or the positioning of the forms or 
paper on a dot matrix printer. 

• ASCII - The character set described in the American 
Standard Code for Information Interchange. ASCII is 
used for information interchange between data 
processing systems, communications systems and 
associated equipment. 

• Audit Report - After the Import Transaction routine in 
Order Link is complete an Audit report prints out. The 
Audit report for a successful import shows you the total 
number of orders imported, the remote order number 
and the new order number on the host machine. If the 
import was unsuccessful, the Audit report shows you 
the problems that occurred during the Import 
Transaction routine such as not enough products on 
hand or Sage DacEasy Order Entry could not find the 
product code for the order being imported.

• AutoReorder - A feature that allows you to view a list of 
prior customer purchases while entering an order, and 
then select items from the list to automatically update 
the transaction.

• AutoReturn - A feature that allows you to view a list of 
prior customer purchases while entering an RMA, and 
then select items from the list to automatically update 
the transaction.

• Bar Code Reader - A device (light pen, laser gun, fixed 
scanner, etc.) used to read a bar code field. 

• Bar Codes - A bar code is a machine-readable pattern 
of alternating parallel bars and spaces representing 
numbers and letters. You can use Sage DacEasy Order 
Entry to print bar codes on labels or stickers and then 
place them on your products.



Glossary of Terms
Sage DacEasy Order Entry User’s Guide

198

10
• Bar Code Scanners - An electronic device that interprets bar code 

symbols into actual numbers and characters based on its bar code type.

• Bar Code Types - Sage DacEasy Order Entry supports two types of bar 
codes, standardized and nonstandardized. Standardized bar codes 
include UPC-A and UPC-E. Nonstandardized bar codes include Code 
3 of 9 and Code 128.

UPC bar codes are the only bar codes whose commercial use is 
controlled by a national council, The Uniform Code Council (UCC), 
which is responsible for assigning unique numbers to vendors/
manufacturers for identification. The UPC symbol is numeric and can 
be one of five different types (UPC-A, through UPC-E.) 

Sage DacEasy Order Entry supports UPC-A, UPC-E, Code 3 of 9, and 
Code 128. These bar codes are the most commonly used bar codes 
throughout the retail industry. 

• Batch - In production this term is defined as a quantity scheduled to be 
produced together. In systems this term is defined as an approach that 
accumulates data and processes it as a group - the opposite of real time.

• Batch Picking - Warehousing process in which goods are selected by 
pickers in quantities to satisfy the demand for more than one order. 
Goods are first picked by SKU, and later sorted by order or delivery 
address. 

• Batch Processing - Opposite of online or real time. Often refers to 
programs that run at a later time. 

• Blanket Order - A blanket order is very similar to a regular order. 
Blanket orders usually involve large quantities that will be sent in 
several smaller shipments over a long period of time. 

• BOM (Bill of Material) - A listing of the raw materials and quantities 
needed to produce an order. It is used for production scheduling, 
purchasing and inventory management.

• Sage DacEasy Business Center - The Sage DacEasy Business Center 
provides a single entry point for all Sage DacEasy programs and 
includes a number of features designed to increase productivity. This 
includes the ability to view multiple windows concurrently, update 
company information for all Sage DacEasy modules, and back up or 
restore data without exiting the Sage DacEasy Business Center. In 
addition, you get quick access to Sage DacEasy, the Internet and user 
assistance.

• Cancel Shipments - Converts invoiced shipments back to orders.

• Card Swiper - See Credit Card Reader.
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• Card Transaction Report - A report of the credit card transactions 

activity for a specific date range.

• Check Readers - Electronic devices that read MICR-encoded checks 
and transmit that information to a PC or terminal for further 
processing. 

• Checksum Character - A checksum character is a verification code 
appended to the end of your product or service bar code.

• Cherry Keyboard - Cherry is a brand of programmable keyboard that 
is compatible with Sage DacEasy. The most recent models of this 
keyboard require additional software to be installed. For more 
information on this, visit their Web site at www.cherrycorp.com.

• Code 128 Bar Code - The code 128 bar code is alphanumeric, variable 
length and modular in design. There are three subsets for Code 128. 
Subset A offers upper case alpha and numeric; Subset B gives lower case 
alpha and numeric; and Subset C offers double density numeric as well 
as a self-checking character.

• Code 3 of 9 Bar Code - The 3 of 9 bar codes (also called Code 3 of 9) 
are most commonly used if you are developing your own codes because 
it is an alphanumeric code. Each bar code character consists of five bars 
and four spaces for a total of 9 elements. Three of these elements are 
wide, hence the 3 of 9 designation. 

Code 3 of 9 is a structurally simple, variable length, alphanumeric 
code. The variable length allows a great deal of flexibility so scanners 
do not have to be programmed to read a certain number of characters. 
The use of a check digit with this code is optional. 

• Credit Card Authorization - The process in which a credit card is 
accepted, read and approved for a sales transaction. Credit card 
authorization is normally accomplished by reading a credit card 
through a credit card reader that is integrated into a register or stand 
alone reading device. Generally, pertinent credit information is 
transmitted via a modem and telephone line to a credit card 
“clearinghouse.” The clearinghouse (authorization source) 
communicates with the credit card’s bank for approval and the 
appropriate debit amount of the sale.

• Credit Card Processing Center - Companies that validate credit card 
and charge balances. One of the requirements for processing credit 
cards online is to set up membership with a Credit Card Processing 
Center. 
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• Credit Card Reader (Magnetic Strip Reader) - A device that reads the 

magnetic strip on a credit card to automatically process account 
information for a transaction. A credit card reader is either integrated 
into a register, attached onto a register as a separate component or is 
part of a stand-alone terminal dedicated for the sole function of 
processing credit card transactions.

• Cutter - Also called a knife. An integrated mechanism used to cut 
individual tickets from a roll of tag supply. 

• Debit Card - A magnetic strip card (commonly referred to as an ATM 
card) used for customer purchases. It avoids providing credit by 
instantly withdrawing the purchase payment from the card owner’s 
bank account. Also known as a check card.

• Dot Matrix - A system of impact printing where individual dots are 
printed by tiny wires striking the supply through an inked ribbon.

• EAN/JAN-13 Bar Code - The European Article Number is used for 
products that require a country origin. The country origin is an 
integral part of the EAN/JAN specifications. 

EAN/JAN-13, which is used throughout Europe, uses the UPC 
symbology. This code is used to encode items with 13 characters. The 
first two digits designate the country where the request for EAN 
originated, the next ten characters are data characters, and the last 
character is the checksum character. 

• EAN/JAN-18 Bar Code - This code is the same as the EAN/JAN-13 
except it has 18 digits. 

• FOB - FOB in an acronym for Free on Board. This indicates the point 
at which the manufacturer’s shipping responsibility ends.

• High Speed Bar Code Scanners - Scanners that can read bar coded 
documents at up to 600 documents per minute. 

• HTML - Hypertext Markup Language. The language often used on the 
World Wide Web. 

• HTTP - Hypertext Transport Protocol. The data communications 
protocol often used on the World Wide Web. 

• Hypertext - Links from one file (usually text or a Web page) to other 
documents or Web pages. 

• Invoice - An invoice is used to sell your products and services to 
customers indicating an amount is due or the balance is paid. 

• Journal (Sales) - The Sales Journal contains the detail for all sales order 
activities that are unposted for a specific period. The journal is your 
audit trail report before posting and provides exact amounts posted.
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• Lead Time - The amount of time it takes for a customer to receive 

items after they have been ordered.

• Light Pen - Also known as a wand. A scanning device that is used as a 
hand held bar code reader. This devise requires direct contact with the 
printed bar code field.

• Listing (Sales) - A Sales Listing prints all transactions, posted and 
unposted currently in the transaction file. You can print either all 
transactions or a specific range. The listing does not act as an audit trail 
prior to posting.

• Media Code - This is used to track sales generated by special 
promotions and advertisements.

• Method of Payment - Each form of payment you collect. 

• Merchant Number - The Merchant ID assigned to you by the credit 
card issuer or processor. Normally, the Credit Card Verification Service 
you are using assigns this number to you, and it should be printed on 
the credit card slip.

• MICR Reader - MICR is an acronym for Magnetic Ink Character 
Recognition. MICR Readers are normally used to read the encoded 
information within the ink on a check. 

• Modem - An internal or external component of a computer system 
attached to a telephone outlet. 

• OCR - Optical Character Recognition. Technology for machine 
reading of human readable text.

• Online Balance - The current customer balance that can be viewed 
from the Customer Inquiry.

• Order - An order is a transaction that identifies products and/or 
services requested for purchase by a customer. An order has no 
accounting value.

• Order Link - A unique feature in Sage DacEasy Order Entry that allows 
you to import orders entered in a remote location into the host 
machine.

• Order Link Transfer File - Allows you to create a link file by exporting 
existing orders from a remote location and import into the host 
machine.

• Packing Slip - A packing slip is identical to an invoice/purchase order, 
except that no dollar amounts print. Packing slips are simply used for 
verification that the item numbers (product codes or service codes) 
and quantities are correct. A packing slip is usually included with the 
items being shipped.
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• Picking Ticket - Use picking tickets to help fill the order in your 

warehouse or fulfillment center. Picking tickets print in the same 
format as orders but include special picking information such as bin 
number or special instructions for your warehouse personnel.

• Printer, Thermal - A thermal printer uses chemically coated stock that 
changes color when heated by a set of pins that contact the stock. 

• Printer, Thermal Transfer - A thermal transfer printer uses elective 
heating of pins to produce images. The pins strike a thin film or paper-
based ribbon with a waxy coating. The heat melts the coating, causing 
pigment to flow onto paper. 

• Price Breaks - Sales price discounts based on quantity, percentage, 
dollar amount or flat price.

• Production Schedule - The report that shows you the products on 
order and the date the customer requests the order delivered.

• Promotional Price - Special sales price discounts for a specific date 
range based on price, flat amount or percentage.

• Purchase Measure - The unit in which you purchase the product.

• Quote - A quote is similar to an order but has no impact on your 
inventory. It is used to give your customer a written estimate of the 
items with prices or discounts offered that he wishes to purchase now 
or at a later date. Saved quotes can be converted to an order.

• Recall By - Use this field on the Edit Product dialog box to be able to 
quickly refer to a product by either the code you assign to the product, 
the vendor’s item code or by both.

• Request Date - The date the customer requests shipment of the order 
or a specific product on an order.

• RMA - Stands for Returned Merchandise Authorization. RMAs are 
used when a customer is returning a product they purchased.

• Sales Analysis - This is a detail or summary report by Customer, Item 
or Salesperson of orders shipped and invoiced.

• Sales Measure - The unit in which you sell your product.

• Sales Return - When you ship your RMAs (Returned Merchandise 
Authorizations) they are converted into sales returns. 

• Scanner - An electro/optical device that converts the bars and spaces of 
a bar code field into human readable format.
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• Ship Orders - The Ship Orders routine converts orders into invoices 

and RMAs (Returned Merchandise Authorizations) into sales returns. 
This routine also commits units for products sold if the Check Product 
Availability Online check box is selected on the System Preferences 
dialog box.

• Shipping Labels - Shipping labels print the shipping address from the 
Ship To section of an invoice. Shipping labels only print for customers 
who are currently on an invoice.

• SKU - See Stock Keeping Unit

• Stand alone - This term refers to running Sage DacEasy Order Entry 
without the interface to Sage DacEasy Accounting.

• Starship - A complete automatic shipping program that calculates 
zones, rates and accesses charges automatically. Can be used with Sage 
DacEasy Order Entry or Sage DacEasy Accounting. The program 
captures information directly from the orders or invoices and 
calculates charges. It also prints shipping labels or COD tag and 
automatically adds freight to the invoice or order. 

• Status of an Order - The status of an order depends on the routines 
that have been run on the order such as the Ship Order routine or the 
Cancel Shipment routine.

Complete—All merchandise on the order was shipped. An order with 
the status of Complete cannot be edited.

Backorder—Some of the merchandise on the order was not shipped. 
An order with the status of Backorder can be edited.

Hold—The Hold status disables your order temporary. You cannot edit 
any part of an order that has been put on Hold.

New—An order that has just been entered will have the status of New 
in the Order LookUp. An order with the status of new can be edited. 

Cancel—The Cancel status actually cancels the order. You cannot edit 
an order that has been canceled. 

Void—If you delete an order it has the status of Void in the Order 
LookUp. You cannot edit a voided order.

• Stock Keeping Unit (SKU) - The identification of a product by name 
and number. A single unit that is completely assembled. 

• Terms - The means or method of payment of an obligation. Terms are 
established by the seller and are included on the order and invoice.

• Thermal direct - A printing method where dots are selectively heated 
and cooled and dragged upon heat-sensitive paper. The paper turns 
dark in the heated areas.
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• Thermal transfer - A printing method like thermal direct except a one 

time ribbon is used and common paper is used as a supply. This 
eliminates the problems of fading or changing color inherent in 
thermal direct printing.

• UPC - Universal Product Code. The standard bar code type for retail 
products in the United States.

• UPC-A bar code - The UPC-A bar code (for numeric data only) is used 
to encode a 12-digit number. The first digit is the number system 
character, the next ten digits are the data characters, and the last digit is 
the checksum character. UPC-A is the most common Universal 
Product Code bar code. 

The number system character (the first digit) is normally in human 
readable form to the left of the printed symbol. This character serves as 
a key to the category and meaning of the other numbers. There are 
currently seven categories of number system characters. The number 
systems are as follows: 

The first digit specifies use of the item (what type of item is the bar 
code used for). The first digit can be any one number in the list 
provided.

• 0—Regular UPC code. Assigned to all items except as follows.

• 2—Assigned to all items sold by unit-of-measure.

• 3—Assigned to items that have delegated their National Drug 
Code number as their UPC manufacturing ID number.

• 4—Assigned to items without a code format restriction for retail 
use only (non food item).

• 5—For use on coupon

• 6,7—Currently assigned to all retail products.

The next five digits are used for the manufacturer identification 
number, which is assigned by the UCC, the Uniform Code Council. 

The next five digits after the manufacturer identification are used for 
the item code number. This is a unique number assigned to each SKU 
or product by the manufacturer. 

The last digit is a check digit, which enables the scanner system to 
verify the accurate data translation of the UPC as the symbol is 
scanned. 
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• UPC-E bar code - The UPC-E bar code is a zero suppressed version of 

the UPC-A bar code. Like the UPC-A bar code it is used for numeric 
data only. This bar code compresses the data characters and the 
checksum characters into 6 digits. It is used for marking small grocery 
item packages and for use in the medical field. 

Only items tagged with a number system character of 0 can be encoded 
into UPC-E. The original 10 data characters must have at least four 
zeros. The first five characters of the 10 are the manufacturer number. 
The last five characters are the product number. 

• UPS - An acronym for uninterruptible power source. A UPS is 
primarily used as a back up power source for computers and computer 
networks to insure on-going operation in the event of a power failure. 
Sophisticated units also have power conditioning and power 
monitoring features. 

• Zone - This field indicates the area of the country where the package is 
to be sent. Many shipping and parcel services require you to supply 
them with a zone code. The usage of zone codes is not standardized in 
the shipping industry, so the zone value may differ from shipping 
company to shipping company.
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